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1.1 Document Structure

The SiteManager User Reference Manual is a reference document for users of the AASHTO SiteManager
application. The user should refer to this manual only when a question cannot be answered by referring to the
SiteManager on-line help system. This manual describes all of the SiteManager components, including their
purpose, functions, and how to use them.

The SiteManager application is organized into the following eight major functional areas, which are
represented by icons on the main panel:

e Contract Administration
e Daily Work Reports

e Pipeline

e Contractor Payments

e Change Orders

e Civil Rights

e Materials Management

This manual is organized into the same eight functional areas plus introductory and supplemental information.
The topics Key Dates, Checklist Scheduled Events, and Checklist Event Dates are covered in a separate
section of the manual due to their importance throughout the life of the Contract. The manual’s main sections
are described below:

Section 1 Introduction

The Introduction describes the structure and objective of this manual. Refer to this section for an overview of
the manual’s topics, or to find out how this manual is intended to be used.

Section 2 Getting Started

The Getting Started section includes information to help the user get started using SiteManager. This
includes information about starting and exiting SiteManager, changing your password, and In-Box message
functions. This section also includes descriptions of SiteManager’s graphical components and how to use
them to navigate within the application and to accomplish tasks.

Section 3 General Concepts

The General Concepts function describes the menus, toolbars, and the components that are common
throughout the application. It includes common procedures for using on-line help, security, and reporting.

Section 4,5, & 6 Contract Administration

The Contract Administration section describes the reference tables that store standard Contract data, such as
default date types, Contract Item descriptions, and Vendor information. It provides an overview of how to
add Contracts to the system, and describes each panel that is used to view, modify, or delete Contract data. It
also describes the panels that are used to maintain data related to Contracts, such as Contractor (Vendor)
information, conference records, force accounts, dispute records, evaluations, correspondence records,
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required documents, and Contract reports. This section also describes how the system validates Contract
status and how the Project Manager finalizes a Contract.

Section 7 Key Dates, Checklist Scheduled Events, Checklist Event Dates

This section describes how the user views and maintains Key Date and Checklist Scheduled Event data. This
data is used to administer the Contract and to monitor compliance with Civil Rights provisions.

Section 8 Daily Work Reports

The Daily Work Reports section explains the concept of reporting, transferring, and storing daily Contract
activity data. This section defines the data that is collected by the Daily Work Report function, and describes
how to record the data on SiteManager panels. It also describes how Daily Work Reports are approved,
combined to make Diaries, and maintained in the database.

Section 9 Pipeline

The Pipeline section describes the SiteManager components that are used to upload and download data to and
from the Server database, and to transfer data from one workstation to another in the field. These components
are provided specifically for the Project Manager and Inspector who must transfer Contract data, Materials
data, and Sample and Test data. This section explains how Pipeline is used in conjunction with the Daily
Work Report function and Materials Management.

Section 10 Contractor Payments

The Contractor Payments section describes the estimate generation process and the reference tables that store
data related to Contractor Payments. This section defines the estimate types and generation parameters, and
gives an overview of calculations performed by the system. It explains how the system identifies Contract
discrepancies and how the user can adjust Contracts and Contract Items. It also explains the estimate
approval cycle and the Contractor Payment reporting options. The reference tables described in this section
define the price adjustment indices, Autopay Items, discrepancy options, and Contractor payment approval
levels.

Section 11 Change Orders

The Change Orders section describes the Change Order reference tables, types of Change Orders, the
approval process, and Change Order reporting options. It explains how the user creates and tracks Change
Orders.

Section 12 Civil Rights

The Civil Rights section describes the reference tables and panels used to add and monitor data related to
Civil Rights. These components let the user define programs, maintain trainee records, monitor compliance
with DBE commitments, record wage decisions, and run reports on these records.

Section 13 Materials Management

The Materials Management section stores Materials information, including inventory, specifications, testing
requirements, mix designs, and lists of approved suppliers, personnel, labs, equipment, and fees. It explains
how to build and maintain a Contract Materials List, how to enter sample data and track test results, and how
to run reports. It also provides on-line access to sampling and testing procedures.
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Appendix A  Glossary
The Glossary defines terms used in the SiteManager application.
Appendix B SiteManager Navigation

This appendix includes an overview map of the SiteManager application and detailed maps for each
functional area of the application.

Appendix C  Estimate Generation Calculation

This appendix describes the components of the estimate generation process and explains how the system
calculates the values reported on an estimate.

Appendix D  Retainage Calculation

This appendix describes one component of estimate generation, retainage calculation, which involves
relatively complex calculations. Examples show the calculation results.

Appendix E  SiteManager Database

This appendix gives an overview of the database structure.

1.2 Objectives

This document serves as a supplement to the SiteManager on-line help system. The user can refer to this
manual for information that is not covered in depth in the on-line help. This includes field descriptions,
expanded topic discussions, calculations performed by the system, error message definitions, and system
administration functions. Some of this information is presented as separate appendices in this manual.

This manual assumes that the user is authorized to use every function provided by the application. In actual
usage, some SiteManager functions can only be used by the System Administrator, Project Manager, or
central office personnel with global Contract authority. Some users will have view only rights to certain
panels. In most cases, this manual does not identify the transportation agency personnel who will have the
authority to use each function; this is done by the transportation agency.

The transportation agency should keep at least one copy of this manual in every office for occasional
reference. The local technical support personnel should have a copy of this manual as part of a basic
reference set.

1.3 Procedures

SiteManager Procedures, the steps the user follows to access a component of SiteManager, vary depending on
whether the user has just entered the system or has been in some other component and has already selected a
common variable.

For instance, if the user enters the application and navigates directly to the Contractor Payments component,
the Estimate Summary window requires the selection of the desired Contract and Estimate.
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However, if the user has been working in the Contract Records component, already has a Contact selected,
and then navigates to the Contractor Payments component, the Estimate Summary window displays for
selection the Estimates for the Contract previously selected in Contract Records.

The procedures in this manual describe how to access components of SiteManager as if the user just entered
the application.
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2.1 Starting and Exiting SiteManager

2.1.1 Starting SiteManager

Windows application, which will run on several different windows graphical user

interfaces — Microsoft Windows 95, Microsoft Windows 98, Microsoft Windows

NT, and Microsoft Windows 2000. For your operating system, you will start The SiteManager Icon
SiteManager the same way you would any program on your computer.

The AASHTO Trnseport SiteManager Construction Management System is a E

Figure 2-1

In Microsoft Windows, the main SiteManager program will be located with its own icon displayed on the
main desktop, as illustrated in Figure 2-1.

FOR MICROSOFT WINDOWS 95/98/2000, & WINDOWS NT

To start on the AASHTO SiteManager system:
1. Double-click the SiteManager desktop icon.
2. Type your logon identification name.
3. Press the Tab key.
4. Type your password.

5. If appropriate in the Connect to drop-down list, click the expand arrow to the right of the current
selection and click the desired database choice.

6. Press Enter.
7. If appropriate in the Available Group for ... dialog box, click the group ID.

8. Press Enter.
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SiteManager Logon

Figure 2-2 The SiteManager Logon Dialog

Available Groups for SY51

Audit Section

Figure 2-3 The Group Dialog Box
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2.1.2 End-User Security — Changing Your Password

In addition to your network logon identity, SiteManager also has password protection. Your SiteManager ID
determines what information you have access to and whether you can update the data or not. If you have any
questions regarding your SiteManager security access, contact your SiteManager system administrator.

Change Password for SYS1 |

0ld Password: ||

Mew Pazsword: I

Confirm Paszsword: |

1] 4

Cancel

|E niter the Old Uszer Password.

Figure 2-4 The Change Password Dialog Box

When a user fails to logon to SiteManager successfully after 3 attempts, a message appears advising the user
to contact the System Administrator. The System Administrator resets the users password. The password is
always reset to PASSWORD and is case sensitive. When any User logs on using the default password

'PASSWORD/, the only option visible (besides 'cancel') is the 'Change Password' option. Users are forced to

change their password before they can access the application.

There is an exception to the rule that 3 failed logon attempts lock the users out of the system. An Inspector
using SiteManager in standalone mode may have an infinite number of failed logon attempts without being

locked out of the system.

2-4
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To change your password:
1. Start SiteManager.
2. On the logon screen, type your old password.
3. Click the Change Password button.
4. Type your old password.
5. Press the Tab key.
6. Type your new password.
7. Press the Tab key.
8. Type your new password, again.

9. Click Ok.

2.1.3 Exiting SiteManager

As with all Windows applications, the File menu’s Exit choice allows you to end m;‘.
your SiteManager work session and exit the application. Additionally,
SiteManager has an Exit button on the Toolbar that is even more convenient. If The Exit Button

you have been performing work and have changed your data (or even if
SiteManager is not sure) a warning message will allow the data to be save before
the application is closed or to cancel the exit process.

Figure 2-5

To exit SiteManager:
1. Click the Exit button.
Or
2. Click the File menu and click the Exit choice.

3. Ifappropriate, click the Yes or No button.

Dy H|

—_

f"\:!) Save changes?

Figure 2-6 The Exit Warning Message
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2.2 Main SiteManager Panel

After starting the SiteManager application, the Main SiteManager Panel will display the components of the
system as icons. The central functionality of SiteManager is divided into ten icons: Contract Administration,
Daily Work Report, Pipeline, Contractor Payments, Change Order, Civil Rights, Materials Management,
Accessories, System Administration, and Manuals.

E SiteManager Panel

Main Panel T d anaals(+] ]
I Ly
Contract Draily W ork, Fipeline(+] Contractor Change Civil Rightz(+] b aterialz
Administration[+]  Reports(+] Fayments(+] Orderz(+] t anagement{+]
[
m B ©
Accezzones(+) Syztem tanualz(+]

Administration]+]

Figure 2-7 The Main SiteManager Panel

2.2.1 Security and the SiteManager Components

The panels and icons to which an end-user has access is defined by the transportation agency. The panel
above and all following documentation will describe and illustrated the content of the all components of
SiteManager. A given end-user’s panels may not conform to the illustrations (figures) unless they have
security access to all components of SiteManager.

2.2.2 The SiteManager Status Bar

The SiteManager Status Bar at the bottom of the SiteManager window indicates your mode, connection,
database region, logon group and individual ID.

|F|eady [Server [5Test [Inzm [kraimd
Mode Connection Region Group ID Logon ID

Figure 2-8 The Status Bar

2-6 August 2005



Main SiteManager Panel

Trnseport SiteManager®
Getting Started

2.2.3 Main Panel Icons - SiteManager Functional Areas

Description

Contract Administration

Automates recording of important Contract data, including
Contractor contacts, Contractor documents, and plan
discrepancies.

Automates verification of Contractor payrolls.

Provides a mechanism to modify a Contract and document that
change.

Tracks critical dates for recurring contract items and special
events.

Calculates liquidated damages and contract retainage.

Supports Contract Management with reference table viewing
and maintenance for funding sources, item masters, vendors,
and administrative offices.

Allows SiteManager users to enter and maintain SiteManager
Contract data, including project items and funding.

Controls Contract access through Contract specific and
administrative office authority.

Maintains Contractor and Subcontractor details.
Assists project management by tracking Contract status.

Furnishes capability to monitor Contract disputes/claims.

Daily Work Report

Collects Inspector Daily Work Reports data, field samples, field
tests, and stockpiled materials used.

Automatically transfers (download) base Contract data for
reference (Contract items, quantities, etc.).

Collects and maintains Contractor data including Contractors
working, work performed, and equipment used

Collects and maintains installed item quantities, weather
conditions, staff/consultant hours, and Force Account
information (labor, equipment, and materials).

Links to “reference” documents stored in third party packages
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Icon Description

such as word processors, spreadsheets, sketching tools, etc.

Allows on-line review of the Daily Work Report and
authorization for incorporation into the Estimate process.

Allows collected data on a laptop or “pen-enabled” laptop
computer in the field or a workstation in a project office to be
transferred (uploaded) to the SiteManager database.

4 Allows the Project Manager and Inspector to upload and
e download data.
Pipeline
& 2 Automatic generation and approval of payment estimates, based
L . .
on the Contract and any Liquidated Damages, Contract

Adjustments, and stockpiled data.

Contractor Payments

Automatic calculation of DOT-defined adjustments for
liquidated damages, incentives, disincentives, and Contract
item price adjustments

Automatic calculation of retainage amounts, encumbered
amounts for securities, and escrow accounts, based on
Contract parameters

Discrepancy reporting and resolution during the estimate
process for certified payrolls, DBE commitments, item
overruns, and material testing deficiencies

Tracking the estimate from the generation process through the
approval process

Creation of voucher data from the payment process which can
be used as input to a DOT-specific financial management
system

Automatic management of stockpiled material as the material
is being used

Provide Stand Alone capability (i.e., Installed Work Summary
Report)

Ensures Contractor acceptance of changes by including
Contractors in change order review and approval process
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Icon Description
Change Order Ensures consistency in the change order process

Establishes, maintains, and approves Force Accounts which
includes details on labor, equipment, and material cost

Tracks review and approval process to ensure accountability

Assists in future planning by providing a means to track and
identify reasons for change

; Automates recording and tracking of Disadvantaged Business
m Enterprise goals/commitments, including the ability to track DBE
work performed on “non-goal” contracts

Civil Rights . . L .
Automates generation of Federal Highway Administration

DBE report detailing the level of DBE earnings on federal
contracts

Allows for planning and tracking of contract On-the-Job
Training goals, including number of trainees, number of hours,
and wage rate adjustments

Automates reporting of potential wage rate violations based on
pre-defined Department/DOL wage decisions

Automates generation of annual Equal Employment
Opportunity reports based on contractor payrolls

Automates accrual of department trainee experience (even
across contracts) based on contractor payrolls and alerts
department personnel to potential violations

Automates tracking of training experience on non-department
contracts

Maintains Material Information
X Documents Sampling and Testing for a Contract or Client
Material Management Incorporates Sampling and Testing requirements
Maintains Approved lists

Creates and maintains five types of Mix Designs

Provides thirty Test windows

Provides Stand-alone capability (Sampling & Testing and
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Icon Description
Approved list)
= Allows access to the In-Box, SiteManager’s e-mail facility and to
P = the Process Status Monitor

Accessories

Groups SiteManager system functions into one area and provide
a single point of access for System Administrators

Provides comprehensive security features with flexible
System Administration administration

Facilitates adding of custom templates

| Allows access to on-line versions of the User Reference Manual
L&_ﬁ,‘ and Sampling and Testing Procedures

Manuals

Table 2-1 The Main Panel Icons Table

2.2.4 Navigating in SiteManager Using the Main Panel

The SiteManager Panel is used to navigate to the components of the SiteManager application. The highest
level is the SiteManager folder tab that contains the different functional groups, with each group individually
represented by an icon. Double-clicking the icon of a functional group brings up another folder tab consisting
of the sub-groups or the actual windows contained within that functional group. As icons are selected, the
next level’s folder tab appears next to the previous level.

To select a main panel component of SiteManager:
1. Double-click the component’s icon.
To select up or down a level in SiteManager:

1. Click the level’s folder tab.
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Click the folder tab to go Double-click the component’s Click the folder tab to go
up a level icon to open it down a level

Figure 2-9 Navigating in SiteManager
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2.3 Accessories

The Accessories panel provides access to the SiteManager communications and process monitoring
components. These components include:

e In-Box,

e Distribution List,

e System Attachments,

e Process Status Monitor, and

e Custom List Record Usage.
To access Accessories:

e  On the Main Panel, double-click the Accessories icon.

e Double-click the icon of the desired Accessories component.

Esicianaper et 11T

MAIL

tain Panel T Accessories[+) ]

a v oo @
ER & REPORTS

Distribution List UsgerJob Monitor  Custom List ~ ADHOC Query  Yiew Saved System
Record Usage Tool Reports [PSR)  Attachments

Process List

Figure 2-10 The Accessories Panel

2.3.1 In-Box Concepts

The SiteManager ‘In-Box’ provides three types of electronic messaging:

e User generated messages using the SiteManager In-Box,
e Access to compatible electronic mail systems, and The In-Box Icon

e System Generated Messages received in the SiteManager In-Box.
Figure 2-11
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2.3.1.1 In-Box E-mail Capability

The SiteManager ‘In-Box’ provides electronic mail capability for users, allowing them to send and receive
electronic mail messages to each other through ‘SiteManager’ mail. SiteManager users can send, receive, reply,
forward and print SiteManager mail, but cannot send attachments. Users also have the option to delete a single
message or, if desired, several messages at a time. When a user deletes mail messages, SiteManager marks them
for deletion so they will no longer appear in the user’s In-Box. The marked messages are retained until the next
archival process, when SiteManager will permanently delete the messages.

ﬂ In-Box [_ [ x|
Uszer Hame D ate-Time Subject =
Systern Administrator 1 04,2399 15:54:02 |Change Order Approval Cycle i

041399 17:13:29 |Estimate Mbr 0002 of Contract ID 011999 Awaiting

L oL

Figure 2-12 The In-Box Window

Additionally, SiteManager’s In-Box provides menu level access to DOT’S native mail system. The native
mail system must conform to one of two messaging standards:

e Messaging Application Programming Interface (MAPI) or
e Vendor Independent Messaging (VIM).

Mail systems, such as Microsoft Mail or Exchange are MAPI compliant while packages such as Lotus Notes
and CC:Mail are VIM compliant.

Although SiteManager provides a menu option to access the external mail, it does not display the external
mail message headers in SiteManager.

2.3.1.2 In-Box as a Workflow Manager

In addition to SiteManager mail and external mail, the In-Box acts as a workflow manager by routing System
Generated Messages to the appropriate users. These messages are automatically generated by SiteManager
and provide any number of users with access-specific SiteManager functions. System Generated Messages
are primarily used to automatically jump to specific windows when further action is required by a user.
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For example, when the user generates an estimate, SiteManager delivers a System Generated Message to the

user’s In-Box.

After the user opens the In-Box message,

If the estimate generation was successful and the request was for a progress or final estimate, SiteManager

will display the Estimate Summary window.

If the estimate generation was successful and the request was for a supplemental estimate, SiteManager will

display the Contract Adjustments window.

If the estimate generation was unsuccessful, then SiteManager will display the Estimate Activity Log report.

2.3.1.3 Using the In-Box
The In-Box is accessed using the Accessories panel.
To start the In-Box:
1. Double-click the Accessories icon.
2. Double-click the In-Box icon.
To open a mail message:
1. Click the message.
2. Click the Services menu and click the Read Mail choice.
To close a mail message:
1. Click the Close button.
To check for new mail messages:
1. In the In-Box, click the File menu and click the Refresh choice.
To delete a mail message:
1. Click the message to be deleted.
2. Click the Delete button.
To delete two or more mail messages:

1. Press and hold down the SHIFT key.

2. Click the first and last mail message in the range of messages to be deleted.

3. Click the Delete button.
To delete two or more mail messages that are not in a range:

1. Select the first mail message to be deleted.

2-14
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2. Press and hold down the CTRL key.

3. Click each one of the remaining mail messages to be deleted.

4. Click the Delete button.
To print a message:

1. Open the message.

2. Click the Print button.
To close the In-Box:

1. Click the File menu and click the Close choice.

Eﬂeply From Project Manager 1

Trnseport SiteManager®
Getting Started

- [Ofx]

From: |Proiect Manager 1

TO: [Project Manager 1

cc: |

Subject: |F!ep|y - Fonward Submitted Documents

Message

The Document # 1 For Contract #SITEMGR_30 iz available for review

i

Reply

I

[From : Project Manager 1
To: Project Manager 1

CC:

Subject : Fonward Submitted Docurments

Kl

Figure 2-13 The Reply Window

2.3.1.4 Replying to or Forwarding a Message

When a message is opened, the Reply and Forward menu choices allows the user to reply to or forward a
SiteManager message to other SiteManager users. When replying to a SiteManager message, the original
mail message is not attached with the reply message. When forwarding a SiteManager message, the original

message is included.
To reply to a message:
1. Open the message.

2. Click the Services menu and click the Reply choice.

3. Click to place your insertion point below the subject in the text area.

4. Type your reply.

August 2005
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5. Click the Services menu and click the Send choice.
To forward a message:
1. Open the message.
2. Click the Services menu and click the Forward choice.
3. Address the message

4. Click the Services menu and click the Send choice.

Eﬂead / Forward 7 Compose Mail [_ (O] x|

From: IPmiec:t Manager 1
TO: [System Administrator T
CC: [System Administiatar 2
Subject: I Contract #SITEMGR_30

Please update your contract information by close of business on 5/31/39. -

Figure 2-14 The Compose Window

2.3.1.5 Creating a Message

A SiteManager mail message may be send to other SiteManager users using the Compose menu choice of the
In-Box.

To create a message:
1. Click the Services menu and click the Compose choice.
2. Address the message
3. Press the Tab key to advance to the Subject heading.
4. Type a subject for your message
5. Press the Tab key.
6. Type your message.

7. Click the Services menu and click the Send choice.
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Select a user
District Construction Engineer 1
District Construction Engineer 2

|bistrict Testing Engineer 1

|bistrict Testing Engineer 2

Field Materials Enginesr 1

Field Materialz Engineer 2

ameTst1

JameTst1 0

Ok

Cancel
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Figure 2-15 Addressing - Control+Clicking Allows Multiple IDs to be Selected

2.3.1.6 Addressing a Message

When creating a new message or forwarding an existing message, it can be sent to an individual SiteManager
user or to multiple SiteManager users. However, it can NOT use SiteManager distribution lists which can
only be accessed by system generated messages.

To address a message:

1.
2.
3.
4.

Click to place the insertion point in the To: or CC: field.

Click the Services menu and click the Select Users choice.

Select the recipient’s name.

Click Ok.

To select multiple names next to each other:

1.

2.

Click the first name.

Hold down the Shift key and click the last name.

To select multiple names NOT next to each other:

L.

Hold down the Ctrl key and click the each name.

August 2005
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¥ Distribution List

Accessories

=] B3

Distribution List | -
erf Test List
hd
Ll_.lsel Name -~ User Name
32 bit 4 dams Construction Corporation
[Cenio Samlin _ Add -> | Cential Dffice 1
Central Dffice Materials Engineer 2 Contial Oifios 2
E_oluradu Test <- Remove | Central Dffice Materials Engineer 1
Diane Menz
Ficg T2 D ay in Life - Central Office
NameT 2t Add All ->> | D2y in Life - Field Inspector
NameT 10 D ay in Life - Project kManager
NameTst3 <<- Rem All | Day in Life - System Admin
NarneT std = District Construction Engineer 1
. _*l_I KN

Figure 2-16 The Distribution List Window

2.3.2 Distribution List

To facilitate easier handling of multiple users, SiteManager provides a Distribution list. These lists are
typically created by users only for system generated messages. The user can assign these lists to specific
processes that generate system messages through specific SiteManager functions. For example, the
Distribution List field on the Contract Key Dates window allows the user to select a user group to which a
message is automatically sent, when a key event does not occur.

To add a new distribution list:

1. On the Accessories panel, double-click the Distribution List icon.

2. Click the New button.

3. Type the descriptive name for the distribution list.

4. In the User Name list box on the left side of the window, scroll to and click the user’s name.

5. Click the Save button.

6. Continue steps 4-5 until all recipients are included.

7. Click Ok.

8. Click the Save button.

A maximum of 20 characters are allowed including the use of spaces and special characters.

2-18
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To modify an existing distribution list:
1. In the Distribution List box, scroll to and click the list to be modified.
To remove a user
2. In the User Name list box on the right side of the window, scroll to and click the user’s name.
3. Click the Remove button.
To add a new user
1. In the User Name list box on the left side of the window, scroll to and click the user’s name.
2. Click the Save button.
To delete a distribution list:
1. In the Distribution List box, scroll to and click the list to be deleted.
2. Click the Delete button.
3. Click Ok.

4. Click the Save button.

2.3.3 Process Status Window

The Process Status window is accessed through the SiteManager Accessories functional area. This window is
available almost system wide by selecting Process Status from the Services menu. The window consists of
two tab pages: Regular and Scheduled.

2.3.3.1 Regular Tab

The Regular tab page lists DPS submitted processes; that is, RTF custom report processes, SiteManager
PowerBuilder reports, and background or batch processes. Here, authorized users can see the current status of
submitted processes, delete submitted or complete jobs, or drill down to view or print the output producted by
completed or failed processes.
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E Process Status _ O] x|
" Regular  Scheduled
Process Name Status End +
CPCSLM1A REXX Error 10:12 am
RCPCSUM1B REXX Emrar 6/23/01 10:14 am 10:14 am 1014an
RCPCSUM1B RE Error £/28/01 10:17 am  |10:17 am 10:17 an
RCACONSTA Daily RE» Error B/26/01 05:11 pm 10:00 am 10:46 an
RCAITOTYA Weekly RE>X Error 6/26/01 05:14 pm 10:46 am 10:46 an
Monthly Contract Status REX Eror E/26/01 05:18 pm 10:50 am 10:50 an
SOMNYATSTA Application Error 6/28/01 10:58 am 10:58 am 10:59 an
RCAITATYA Weekly REXX Error B/26/01 05:14 pm 11:03 am 11:09 an
RCPCSUM1A Completed B/23/01 11:13 am 11:13 am 11:13 an
test] Completed E/28/01 12:09 pm 12:03 pm 12:03 pn
SONYATSTA Completed E/28/01 12:40 pm 12:40 pm 12:40 pn
TESTH01A Application Error B/28/01 01:27 pm 01:43 pm 01:43 pn
Monthly Contract Status FHEX Error 6/26/01 05:18 pm 01:43 prm 01:43 pn
RCAITOTYA Weekly REXX Error 6/26/01 05:14 pm 01:43 pm 01:43 pn
RCAITOTYA RE Error 6/28/01 (02:36 pm 02:36 pm 02:36 pn
FlI'I"AITﬂTYR RF%X Frnr R/28/M N2-3R nm I N2-3F nm nmn_n.'ﬂ
A »
Figure 2-17 The Process Status Window Regular Tab

Field Description

Process Name The name of the process.

Status Textual description of the process status; for example, Process

Running, Application Error, Complete.

Date Submitted Date the job was submitted.

Queue Time Time the job was submitted.

Start Time Time the job started processing.

End Time Time the job finished processing.

Server IP address of the server to which the job was submitted and run.

Table 2-2 The Process Status Regular Tab Field Names Table

2.3.3.2 Scheduled Tab

The Scheduled tab page lists DPS submitted processes; that is, RTF custom report processes, SiteManager
PowerBuilder reports, and background or batch processes. Here, authorized users can see the current status of
submitted processes, delete submitted or complete jobs, or drill down to view or print the output produced by
completed or failed processes. The processes listed on the Scheduled tab are those processes which have be
set to run on a specific schedule by an authorized user.
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Standard SiteManager window and tab-level security applies to the Scheduled tab page window. Only those
processes to which the user has been assigned security access will be presented on the displayed list.

[ Proces strus 1111111 TS S =T
" Regular Scheduled
Process Profile Schedule
SONYATST SONYATSTA WeAt 5:22 PM on Tue, e e 7 Tpm |[07A10/01  [05:22 pm
SMEAPP RCOCORPTA Meat 5:24 PM on day 3 of the month 05:18 pm  |03/03/01  |05:24 pm
SMBAPP RCAITATYA Dailat 5:19 PM every day 07/03/M 05:16 pm  |07/06/01 |05:19 pm
SONYATST SONYATSTA  |At5:35 PM every day 07/03/01 05:30 pm  |07/06/01  |05:35 pm
| | »

Figure 2-18 The Process Status Window Scheduled Tab

Field Description

Process The name of the process.

Schedule Textual description of the process schedule; for example, Time, Day of
Week and Frequency

Date Submitted Date the job was submitted.

Queue Time Time the job was submitted.

Next Run Date Date the job will next run.

Next Run Time Time the job will next run.

Last Run Time Time the job was last run.

Server IP address of the server on which the job is scheduled to run.

Table 2-3 The Process Status Scheduled Tab Field Names Table
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2.3.4 System Attachments

System Attachments are a stand-alone version of the URL, Plug-In and OLE
functionality of SiteManager. The stand-alone feature allows URL links, Plug-In
applications, and OLE objects to be accessible to the User by clicking the System
Attachments icon through the Accessories panel.:

URL attachments are links to html documents

Plug-In attachments allow access to other programs similar to the OLE function.

Accessories

12

The System

Attachments Icon

. . L . Figure 2-19
The Plug-In functionality also allows a limited amount of data to be automatically
passed to a Plug-In application upon execution.
OLE object attachments are links to external documents.
2.3.4.1 URL and Plug-In Attachment Icons
Activates the Attachments window.
Appears on the Accessories panel, and activates the stand-alone
@ Attachment window.

Attachments attachment associated with it.

Appears on the toolbar of any window that may have an

window.

-

Run Attachments

Allows User to activate Plug-In applications or URLs associated with the

modified or entered.

U]

New URL

Opens a dialog box allowing the properties of a URL attachment to be

modified or entered.

P

New Plug-In

Opens a dialog box allowing the properties of a Plug-In attachment to be
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nh

New OLE

Opens a dialog box allowing the properties of an OLE attachment to be
modified or entered.

2.3.4.2

Figure 2-20 The Attachment Icon Table

Attachment Usage

I3 System Attachments O] x]

Name Type Description

M5 word Flag d Processing
[Fushkar'sPlugin Flug Fis s a test

‘ahoo! URL ‘shoo Search Engine.

character map ERT

d caleulator EXT

FRRRRRAR [URL ctmaiighagh

IE calculator EXT
i websits [ORC riotech fle

test Plug gafaff

iy again Flug esdath

haos URL e yahoo

Figure 2-21 The System Attachments Window

To use Plug-In, URL, and OLE attachments:

L.

The previously-created URL, Plug-In, and OLE attachments appear on a table grid on the
Attachments window. Sort and Filter features may be used on this window by right-clicking and
choosing a feature from the Object menu.

Double-click the desired attachment to activate, or highlight the desired attachment and click the Run
Attachments icon.

Activating a Plug-In opens the specified application in a separate window. Activating a URL or
HTML File item launches the system’s default browser. Activating an OLE opens the specified
document.

Once the User has completed work with the URL, Plug-In application, or OLE document the browser
or application may be closed as normal.
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3.1 Menus

M AASHTO SiteManager [_[5]X]

File Edit Services Window Help
(08 2] Do @ ]|

e . ——————————

C— Description Location Payment Data  Critical D ates
— ! Personnel Contractor
- Contract ID: |SITEMGF|_3EI Fed St/Pr Prj Nbr: [NONE/00:
H Primary PCN: IEIEID258?BI
Division: |El2 District: | Area: | 7
Py Sched: Vari. P l:l 0o
- rogress Sche | ariance Pcl ¢
—] Desc: |E><TEND ACCELLERATION LANE & CLOSE CROSS-OVER ¢

Time Charges: Il:alendar Days Bid Da_vs:l 30 Bid Am[;l
Contract Type: IEDNSTHUETIDN SAAP [~ Fed Oversight

LI_ Work Type: |25 [T Local Dversight Proposal Fund Type:

Spec Yl:l 1991 Unit System: IEninsh Suppl S5pec Bk Yl:l AltID _
_]’ o

Figure 3-1 An Example of SiteManager Menus

3.1.1 General Guidelines
The following guidelines apply to the use and structure of SiteManager menus.

e SiteManager menus may have up to 3 levels with the main menu as the first level.
e Menu choices that invoke dialog boxes have an ellipsis (...) at the end of the choice.

e Menu choices that invoke a cascading submenu will have an arrow (>) at the end of the choice.

Some menu choices will be applicable in some instances and not applicable in others. For example, a menu
choice may be applicable for one folder tab and may not be applicable for the second folder tab. When the
menu choice is applicable for the active folder tab, it will display normally. When the menu choice is NOT
applicable for the active folder tab, it will not appear on the menu.

Other menu choices may be applicable but only if a preliminary step is performed. For example, a menu
choice may be applicable if you are in a new record, but not applicable when you have an existing record
open. When the menu choice is applicable, it will be enabled and will display normally. When the menu
choice is NOT applicable, it will be disabled and will display in gray. The menu choice will be enabled or
disabled depending on the circumstances.

Menu choices will often have a corresponding toolbar button.
Keystroke shortcuts are assigned to all lowest level menu choices — menu choices that do NOT invoke a

dialog box or a cascading submenu. Keystroke shortcuts will appear in the menu to the right of the menu
choice.
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Keystroke shortcuts will not clash with those commonly used by the Windows standard. For instance, even
when there is no Edit menu, the CTRL+C keystroke shortcut will copy the current selected column value to
the Clipboard.

All menu choices will have keystroke accelerators assigned. The menu itself will be invoked using the
underlined letter in the menu name in combination with the ALT key. The menu choice will be invoked by
typing the underlined letter in the menu choice’s name.

When appropriate, an object menu can be invoked by right clicking the column.

3.1.2 Menu Layout

The SiteManager application has two menus to display — One at the frame level and the other at the sheet
level. The sheet level menu could be any one of the several functional level sheet menus which in turn were
inherited from the frame, with additional menu choices added for relevant functionality. The Frame level
menu contains only a few menu choices that provide access to the application level functions such as bringing
up the SiteManager Main Panel and exiting the application. At the sheet level, each window will display only
one menu bar and one tool bar, with some of the frame level menu choices incorporated on the sheet menu
itself.

3.1.3 Frame Menus

At the frame level, there are three menus: File, Window And Help.

window

Print Setup  Chrl+U Tile S hift+F4
Main Panel Crl+t Layer 3 h!ft+F3
Cazcade Shift+F5

E xit Alt+F4

Figure 3-3 The Window Menu
Figure 3-2 The File Menu

Contents F1
Search for Help on...  Chil+y*
Glozzary Crrl+G

Current Window Ctrl+F1

Ahout Sitebdanager  Chil+Shift+d,

Figure 3-4 The Help Menu

The File menu has the standard choices — Print Setup, Main Panel and Exit. The Print Setup choice invokes
the standard Windows Print Setup dialog. The Main Panel choice displays the SiteManager Panel window,
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which is useful in cases where the panel was closed at the frame level through the Close choice of the control
menu. The Exit choice exits the SiteManager application.

The other two menu options, the Window and Help are the standard Windows menus with choices that
function according to Windows standards.

3.1.4 'Window Menus

The window level has five menus: File, Edit, Services, Window and Help. These

options are applicable at the tab level.

3.1.4.1 File Menu

Dpen Ctrl+0
Cloze Chrl+F4
Hew Ctrl+M
Delete Clrl+Dy
Save Clrl+5

Refresh Chrl+F

The File menu at the sheet level includes the frame level choices — Print Setup,
Main Panel and Exit with the same functionality. It also contains several sheet

specific choices — New, Open, Close, Delete, Save, Refresh, Print Preview and

Print.

Print Setup  Chrl+U
Print Preview  Chil+ha
Print Chrl+P

Main Panel  Clrl+bd

Exit

Alt+F4

The Sheet’s File Menu

Menu Choice Description

Open Allows another record to be selected. Typically, it is applicable to
the current tab.

Close Closes the current sheet. It will prompt for saving any changes,
before closing the sheet.

New Is used in context to clear all the columns for data entry. However,
if the sheet contains more than one control capable of creating new
rows, the New option will create a new row, on whichever control
is currently active.

3-4

Figure 3-5
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Menu Choice Description

Delete Like the New Choice, the Delete choice is contextual and is
applicable for the current control. It will prompt for a confirmation
from the user through a message.

Save Saves the current unit of work.

Refresh Clears the current changes to the record and retrieves the record
again.

Print Setup As with the Frame option, Print Setup displays the standard

Windows Print Setup.

Print Preview

Displays a preview of the current print selection.

Print Prints the current data.

Main Panel The Main Panel choice opens another window or another instance
of the same window. It invokes the navigation panel from which
the appropriate choice of the window can be selected.

Exit Exits the application. It will ask for saving of changes, if the there

are unsaved changes.

3.1.4.2 Edit Menu

Table 3-1 The File Menu Choices Table

Undo Cl+£
The Edit menu has standard Windows choices: Undo,
. ) Cut  Chl+
Cut, Copy and Paste. These will function as they
would in any Windows program. The Undo choice Copy  Ctrl+L
has a limited functionality. If you delete a field and Paste L+

immediately choose Undo, the field value will

probably be brought back. However, if you have

deleted a record, the Undo function will NOT undo

the deletion.

August 2005
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3.1.4.3 Services Menu

Menu Choice | Description

Undo Undoes the last change.

Cut Cuts the selected area from the
item.

Copy Copies the selected area from
the item.

Paste Pastes the contents of the

clipboard.

Table 3-2 The Edit Menu Choices Table

Menus

The Services menu has several menu options grouped together. Some of the options like Address and
Remarks extend the functionality. The other choices provide extended services.

The Services menu is also the most variable SiteManager menu. It will also contain choices other than the
ones listed in the following table. When there is a Service menu, it is a good habit in SiteManager to check its
contents for the additional choices that may be applicable only to that window.

Window Help

Hemark.z
Address

Genernc Fields

Chrl+a&]t+H
Chrl+a b+,

Chrl+alt+5

Custom Recard  Chrl+5 hift+L

Figure 3-7 The Services Menu

Menu Choice

Description

3-6
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Choose Keys Becomes available when the New choice is invoked. It brings up
the pick list from which the appropriate value(s) can be chosen.
Address Invokes the address (context sensitive).
Remarks Invokes the remarks dialog.
Generic Fields Displays a standard set of customizable, generic fields. Depending
on the customization, these fields can be strings, codes, flags, or
numbers.
Other menu Other functional area specific menu choices (such as Approve) are
choices incorporated under Services.

Table 3-3 The Service Menu Choices Table
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3.1.4.4 Window Menu

Menus

The Window menu contains the MS Windows standard menu choice. All active SiteManager windows will be

displayed under at the bottom of the Window menu.

3-8

W indions
Tile Shift+F 4
Layer Shift+F3
LCazcade Shift+F5

Figure 3-8 The Window Menu

Menu Choice Description

Tile Tiles the open sheets
Layer Layers the open sheets
Cascade Cascades the open sheets

Table 3-4 The Window Menu Choices Table
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3.1.4.5 Help Menu

The Help menu contains the standard Windows options. The non-standard exception, Current Window
choice, will display the help on the current window including the help on the fields under that window. All
other options will work in the standard format.

Menu Choice Description

Contents Brings up the SiteManager Help
Contents Window.

Search for Help Brings up the SiteManager Help

Help on Search Window.
Cantents F1
Search for Help on... Chil+y Glossary An alphabetized list of the items
Gloz=zary Chrl+G on the Help Contents Window.

Current %indomw Chrl+F1

Current Window | Brings up help window and
About Sitetanager  Chil+Shift+& displays the help on the current
active window.

Figure 3-9 The Help Menu
About Information about SiteManager
SiteManager Version.

The Help Menu Choices Table

Table 3-5

3.1.5 The Object Menu

The Object menu can be opened by right clicking a column. When the standard Windows selection pointer is
positioned on a column that can be searched, it will be replaced by the Search Lens. The Search Lens

indicates that an Object menu can be invoked to perform a search by clicking the right mouse button. B

Figure 3-10 The Search Lens

B If the mouse button that opens an item (double-click) has been reassigned to the right button using the
Mouse control panel, the Object menu will be invoked using the left mouse button.
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3.1.5.1 Object Menu Choices

As with other Windows applications, the available choices in the Object menu are context sensitive
depending on what column the selection pointer is positioned on and whether it is selected or not. When
choices in the object menu are inactive — grayed out — their inactive status usually indicates the column is
not selected. The Object menu includes five choices described in the following.

Search

Eilter
Find
Sort

Show Filkers Sort

Figure 3-11 The Object Menu

3.2

3-10

Object Menu

Choices
Description

Search Searches for the specified field
value.

Filter Eliminates all records other than
the Filter criteria.

Find Finds the specified field value.

Sort Sort the records in ASCII order
in either ascending or
descending order.

Show Displays the applied Filter/Sort

Filter/Sort criteria.

Table 3-6 The Object Menu Choices Table
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3.3 Using SiteManager Menus

SiteManager menus can be accessed using the mouse or using the keyboard. Many SiteManager menu
choices can also be accomplished using a keystroke shortcut.®=

To use a SiteManager menu using the mouse:

1. Click the desired menu and click the desired choice.

3.3.1 Using SiteManager Menus Using the Keyboard

As an alternative to using the mouse, all SiteManager menus can be selected using the keyboard. Some
SiteManager menu choices can also be performed using keystroke shortcuts.

To use a SiteManager menu using the keyboard:
1. Hold down the ALT key and press the underlined letter in the menu name.
2. Type the underlined letter in the menu choice’s name.
To perform a SiteManager menu choice using a keystroke shortcut:
1. Hold down the CTRL key and press the letter that performs the shortcut (e.g., CTRL+C copies the
selected data).
3.3.2 Standard File Menu Choices

The following SiteManager File menu choices are standard throughout the application and will always be
performed in the same way. Sheet specific menu functions will be covered with the applicable SiteManager
functionality.

3.3.2.1 Changing the Print Setup
The File menu’s Print Setup choice is used to change the standard Window print setup dialog.
To change the print setup:

1. Click the File menu and click the Print Setup choice.

2. Make the desired changes to the dialog.

3. Click Ok.

Keystroke shortcuts will appear in the menu to the right of the menu choice.
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3.3.2.2 Printing

The File menu’s Print choice is used to print. In a report, the Print choice will print the entire report. In a
window, it will print the current focus of the window. Most SiteManager windows are divided into two or
more zones. The results of the Print choice will vary depending on which zone is active.

B9 Contract Adjustments [_ [T x]

Descriptions Proj Distribution

Adjustment
Amount

05/28/9

A SiteManager 7 Other Adjus
r

Window with
Three Zones

N Entered Date: [15/23/97 User ID: |train1 Est. Nbr: 0001

Adjustment Description: |EI ther Adjustment (See Remarks)
Adjustment Amount: |$20,000.00
Reference Doc:

Remarks: [pondra -]

Figure 3-12 The Zones of a SiteManager Window
To print:
1. Ina window, click the area of the window that you wish to print.
2. Click the File menu and click the Print choice.
3. Make the desired changes to the dialog.
4. Click Ok.

3.3.2.3 Using Print Preview

In a window, the File menu’s Print Preview choice is used to preview what will print. Since most windows
will print the current focus of the window, the Print Preview choice will help you determine that the focus is
correct before you print.

To preview what will print:
1. In a window, click the area of the window that you wish to preview.
2. Click the File menu and click the Print Preview choice.
3. View the selection that will be printed.

4. Click Ok.
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Components Description
Next button Displays the next page of a multi-page selection.
Prior button Displays the prior page of a multi-page selection.

Print button

Invokes the Print dialog.

Setup button Invokes the Print Setup dialog.

Zoom button Invokes the Zoom dialog to magnify or reduce the display of the
print preview.

Close button Closes the print preview

Rulers check box

Displays or hides the rulers

Save As button

Invokes the Save As dialog allowing the results of the print
preview to be saved in other file exportable file formats.

Table 3-7 The Print Preview Components Table

EEslimale History =] B

Contract ID: |D21 899 Descriptionl: |blidge wiork.

E stimate
Number

0onz2

PM
User ID

Last Appr.
User ID Date

$18.000.000 /07739 552 0 3 5Y52 03¢ 3 |APR
$£.940.00 01 /0699 Sys1 02/23/93 SY51 02/23/93  |APR

Last Appr.

0001

$5,500.0001/05/99 St 02/23/93 Svs1 02/23/33  |APR

Fa

August 2005

Figure 3-13 A SiteManager Window with a Multi-Row Focus
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Print Preview E

Next | Prior | Print | Setup... | i Save As... | Close | v Rulers
.|.¢.|.|.|.I.|.‘|.|.I.|.|.|.I.|.2|.|.I.|.|.|.I.|.3|.|.I.|.|.|.I.|:‘|.|.I.|.|.|.I.|.5|.|.I.|.|.|.I.|.B|.|.I.|.|.|.I.ﬂ

¥ - . -

| E. Net Pay Period PM PM Last Appr. Last Appr. |Est

1 Number End Date User ID Appr. Date User ID Date  [Stat

e o0z $12,000.00 01/07433 SY52 0341233 SY52 031233 APRV
1 = 0002 $6,340.00 01006133 S¥S1 02023199 SY51 02023193 APRY
- 0001 $5,500.00 01/05¢33 SYS1 02023199 SYs1 02023193 APRY
27
3
+3 -

Figure 3-14 The Print Preview of a SiteManager Window with a Multi-Row Focus

3.3.2.4 Exporting A Window’s Print Results —The Print Preview’s Save As Button

The Print Preview is a File menu choice only available in a window — not a report. The Save As button of
the Print Preview allows the current focus to be saved in other exportable file formats.

To save the print preview results in another format:
1. Ina window, click the area of the window that you wish to preview.
2. Click the File menu and click the Print Preview choice.
3. Click the Save As button.

4. In the Save File As Type drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

5. To include column headings, choose a With Headings file type.
6. Highlight the text in the File Name field.

7. Type the name for the file.

8. Click Ok.

The Save Rows As dialog also does not have the more traditional Windows methods of changing drive and folders.
An exported file will be created in the default directory and drive on which SiteManager is installed. In step 5, a
path can be typed in front of the filename to control where the file is created. The path C:\DATA\ACTCONT.PSR
would create a file named ACTCONT.PSR in a directory named DATA on the C drive.
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Radio Button File Extension File Format Description

Text TXT ASCII Tab Separated (Delimited) format

CSV .CSV ASCII Comma Separated (Delimited)
format

Dbase 2 .DBF dBase 2 format

Dbase 3 .DBF dBase 3 format

DIF .DIF Date Interchange Format

Excel XLS Microsoft Excel Spreadsheet format

HTML Table HTM Hyper Text Markup Language table format
(Can be viewed in a web browser.)

PowerSoft Report PSR PowerSoft Saved Report format (Can also
be viewed in SiteManager.)

SQL .SQL ASCII text file containing the SQL syntax
required to recreate the datawindow object
when run through the database.

SYLK SLK Microsoft MultiPlan format

Text TXT Text file format (Can be viewed in any text
editor.)

Windows Metafile .WMF Windows Metafile graphical format

WKS .WKS Lotus 123 early format

WK1 WK1 Lotus 123 later format

August 2005

Table 3-8 The Print Preview Save As File Formats Table
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Savens |

File name: Folders:
* xls | c:\smapp
= Cancel |
- =) c:\ =
j Metwork... |
[_1 checkin
[£3 checkout
3 cms —
~ £ smdb -
Save file as type: Dnves:

Excel ﬂ I = j

Figure 3-15 The Print Preview Save A Dialog

3.3.2.5 Displaying the SiteManager Panel

The File menu’s Main choice is used to invoke the main SiteManager navigation panel. Typically, the
SiteManager navigation panel would be activated to open another SiteManager component without closing
the current active component.

To display the SiteManager Panel:
1. Click the File menu and click the Main Panel choice.

2. Click the desired icon.

Main Panel | Contract Administration[+) |
o ¢ p .
5 S s X

Contract Daily Work Pipeline and Contractor Change Civil Rights(+) I aterials

Administration(+) T A Zipl+) Payments(+] Orders(+) tanagement(+]
|
mE E
Accessonies(+) System Manuals(+]

Administration(+]

Figure 3-16 The SiteManager Main Panel

3.3.2.6 Exiting SiteManager Using the Menu

The File menu’s Exit choice exits the SiteManager application. If current work has not been saved, a warning
message will allow the data to be saved before the application is closed or to cancel the exit.
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To exit SiteManager:
1. Click the File menu and click the Exit choice.

2. If the warning message displays, choose the desired choice.

¥ Contract funding |

Cancel |

Figure 3-17 The Exit Warning Message

Edit
3.3.3 Standard Edit Menu Choices Undo ChilZ
The following SiteManager Edit menu choices are standard throughout the
o . . . Cut  Chil+=
application and will always be performed in the same way. Sheet specific menu C ChleC
functions will be covered with the applicable SiteManager functionality. RU
Pazte Chil+

3.3.3.1 Selecting

Figure 3-18 The Edit Menu
If no column is selected, the Cut and Copy choices will be disabled and will

display in gray. To select a specific column to be cut or copied, use the mouse to
highlight the field or press the Tab key repeatedly until the field becomes
highlighted.

To select a field using the mouse:
1. In the desired field, position the I-beam in front of the current entry.
2. Press the mouse button and drag to highlight the current entry.

To select a field using the keyboard:

1. Press the Tab key repeatedly until the field is highlighted.

3.3.3.2 Undo

The Edit menu’s Undo choice will “undo” the last entry made to a field, if the user has not performed a Save
on the record.

To undo:

1. Click the Edit menu and click the Undo choice.
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3.3.3.3 Cutting, Copying, and Pasting

When a column value is selected, the value can be moved (cut) if the entry was inappropriate in that field. A
field value that needs to be entered repeatedly may also be copied to reduce typing. Pasting a cut or copied
value can be done within SiteManager or to other Windows applications.

To move (cut) the current selection:

1. Select the column value(s) to be moved.

2. Click the Edit menu and click the Cut choice.
Or

1. Hold down the Ctrl key and press the letter X.
To copy the current selection:

1. Select the column value(s) to be moved.
2. Click the Edit menu and click the Copy choice.

Or
1. Hold down the Ctrl key and press the letter C.

To paste the current contents of the Clipboard:
1. Position the insertion point in the column location to receive the value.
2. Click the Edit menu and click the Paste choice.

Or

1. Hold down the Ctrl key and press the letter V.

3.3.4 Standard Services Menu Choices

The Services menu in the most context variable menu of SiteManager — its choices will vary from window to
window. The Services menu is by far the most important menu for accessing custom SiteManager
functionality

Upon entering any SiteManager window, it is a very good habit to check the contents of the Services menu as
the first action. What appears in the Services menu may suggest the next logical step to take, such as
Choosing Keys, or may suggest additional actions which could easily be overlooked, such as adding a
Remark or recording an Address. On the other hand, the absence of these options might suggest an
alternative course of action such as clicking the Open button, rather than Choosing Keys.
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3.3.4.1 Choosing Keys

The Choose Keys choice displays a list of key field(s) to be selected. In many instances in SiteManager, the
Choose Keys choice must be selected before a new record can be created. Choosing Keys is fundamental to
using SiteManager.

To choose keys:
1. Click the Services menu and click the Choose Keys choice.
2. In the list box, scroll to and double-click desired value.

3. Repeat step 2 until all initial values are selected.

— Sel
Item |
Spec Year |
Find :
 Item
Item Code English/Metric Description =
""" Englizh MISC ITEMS
001-0000 English MISC ITEMS
001-0000 Metric MISC ITEMS
001-0000 Metric MISC ITEMS
001-0001 English BOWD INTEREST
001-0001 Metric BOND INTEREST
001-0100 English CONSTR SUPYR DONE BY OTHER THAN DOT PERSONEL -
001-0100 Metric COMNSTR SUPYR DONE BY OTHER THAN DOT PERSONEL -

Figure 3-19 The Choose Keys Window

3.3.4.2 Address

Address information is tracked by a variety of components in SiteManager. The Address choice displays an
address dialog that allows this information to be recorded.
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PYMT AND/OR BILLIN [~ | | Address For: |
BILLING ADDRESS —Address
RECORD FOR FAX ONI Line 1: |
HOME ADDRESS [ALL Line 2 [
MAILING ADDRESS (PI[gf  _ Line 3: [

|

|

City:
State/Prov:

Zip/Postal: I

Country: | [ =]

=

—Contact Numbers
Phone:' Ext: |

FaX: |

Figure 3-20 The Address Dialog

To attach an address:

1. Click the Services menu and click the Address choice.
2. In the address type list box, scroll to and click the desired type of address.
3. In the first field, type the appropriate information.
4. Press the Tab key.
5. Repeat step 2-3 until all text address information has been entered.
6. In the State/Prov drop-down list, click the expand arrow to the right of the current selection and click
the desired choice.
7. In the Country drop-down list, click the expand arrow to the right of the current selection and click
the desired choice.
8. Click outside the Address dialog to close the address.
9. Click the Save button.
3.3.4.3 Remarks
As with Addresses, Remarks may be attached to a variety of records in the various IE
components of SiteManager. The Remarks choice displays an freeform dialog
that allows any comment to be recorded. The Remarks Button
When Remarks are available for a SiteManager window, the presence of the Figure 3-21

Remarks button on the Toolbar serves as a reminder that they are appropriate,
makes it easier to access Remarks, and, unlike other Service menu choices,
precludes the need to check the Services menu to see if Remarks are available.

3-20

August 2005



Trnseport SiteManager®
Using SiteManager Menus General Concepts

To attach a remark:

1. Click the Remarks button.

Or
1. Click the Services menu and click the Remark choice.
2. Type the desired comment.
3. Click outside the Remarks dialog to close the Remark.
4. Click the Save button.

3.3.4.4 Generic Fields

SiteManager has a generic fields capability comparable to the same function in Trnseport™ (formerly known
as BAMS). Generic fields are fields attached to some of the SiteManager windows that are transportation
agency defined. After the installation of SiteManager, a transportation agency will attach descriptive labels to
the generic fields of SiteManager, will enter, and track data unique to that transportation agency. Once this
customization has be performed, the transportation agency will set up procedures for the uniform maintenance
of the data in their customized fields.

The components of SiteManager that have this Generic Fields option are:

e (Contract

Registration Number |

(] Vendor Amount |D
e Office Information Reg Date [00/00/00
e Address

e Vendor Personnel

e [tem Master

o Affiliates

e Vendor Work Class

e Vendor Security

. PrOj ect Category Figure 3-22 A Generic Fields Dialog Customized by a Transportation Agency
e Contract Item

¢ Sub Contract

e Contract Project

e Contract Milestone

e Change Order

e Checklist Events

e Contract Estimates

e Diary Milestone Credit
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To update generic fields:
1. Click the Services menu and click the Generic Fields choice.
2. In the first field, type the appropriate information.
3. Press the Tab key.
4. Repeat step 2-3 until all fields information has been entered.
5. Click outside the Generic Fields dialog to close.

6. Click the Save button.

3.3.4.5 Other Services Menu Choices

The Services menu in the most context variable menu of SiteManager — its choices will vary from window to
window. The Services menu is by far the most important menu for accessing custom SiteManager
functionality

Upon entering any SiteManager window, it is a very good habit to check the contents of the Services menu as
the first action. What appears in the Services menu may suggest the next logical step to take or may suggest
additional actions which could easily be overlooked.

3.3.5 Standard Window Menu Choices

The following SiteManager Window menu choices are standard throughout the application and will always be
performed in the same way. Sheet specific menu functions will be covered with the applicable SiteManager
functionality.

Window menu choices will be used when you have more than one component of SiteManager open.
Controlling the way the windows display can aid in navigation between these components.

3.3.5.1 Tiling

Tiling divides the screen into the number of SiteManager components that you have active. Typically, tiling
is used to display two SiteManager components side by side horizontally to compare the entries in each or to
return a single component to full screen once you have closed the other component. Typically, it is not used
when more than two components of SiteManager are active since you would not be able to see enough of each
component of SiteManager to make it worthwhile. With three components of SiteManager active, tiling
would give each component only one third of the screen. Unless you have a very large display, tiling with
more than two SiteManager components open may not be very useful.

To change your screen to a tile display:
1. Have open the number of SiteManager components that you want to tile.

2. Click the Window menu and click the Tile choice.
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FIAASHTO SiteManager [_1O[=]
File Edit Services Window Help

fiml [ S A [ = = =]

E Maintain Producer/Supplier [_[O] ] ﬂApplnved Materials _ (O] x|
Description Plants
Producer Supplier Code: 0000004 Producer Su |Malerial Code |DUDUD1 lAdditives

Producer Supplier Name: pim‘s Quarry Product Name
Vendor ID: Geog

Location:[ |+ Apg| |[Admisture B

Location Description: | Admizure C
Y —
Status:
Last Modified User 1D: [1b0833 Last Mc Product Name: |/ dmixturs &
Effective Date: IW Ezxpiration Date: |ﬁ
Product Category: [4dmisturs =l

Manufacturer Name: |Manufacturer

Method: [Manufacturer Certification =]

‘ Ready

Figure 3-23 Two SiteManager Components Tiled

3.3.5.2 Cascading

Cascading makes the number of SiteManager components that you have active an equal size and arranges
each component in an overlapping offset window. Typically, cascading is used to display more than two
open SiteManager components offset. When you have a need to navigate between more than two open
SiteManager components, the Cascade choice may make it easier to move between them.

To cascade:

1. Have open the number of SiteManager components that you want to cascade.
2. Click the Window menu and click the Cascade choice.

3. Click the visible portion of the window you want to display.
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FJAASHTO SiteManager =] x]

File Edit Services Window Help

m| i 0] 2| B =] (@] Ofm[z]

& =1o| x|
& =11
LU FContracts =1

C — ‘iption Location Papment Data ~ Critical Dates Prirnary Frime DBE I:nmr;l
— Perzonnel Contractor

Zontract ID: Fed St/PrPriMbe: [
Status: IW Primary PCN: |:
Divisiun::g District: :E Area: I:E a3 |
ress Sched: | [=] Wariance Pct: I—DU - 5.:
— Desec:| " Ba
I!:lg: ne Chalges:l |;| Bid Days: l_ Bid Amt: I—
J— . 7; Mract Type: | Spaces |;| [~ Fed Dversight
Rl Work Type: | Spaces |=] [ Local Oversight  Proposal Fund Type: I_ .
R B o

IHea-:I_l,l [Server [STEST [SMADMIN  [5v52

Figure 3-24 Three SiteManager Components Cascaded

3.3.5.3 Layering

Layering displays the SiteManager component that you have active in the most efficient full screen display.
Typically, layering is used give each active component a full window for display or to return a single active
component to full display after you have closed the other components that were tiled or cascaded.

To layer:
1. Have open the number of SiteManager components that you want to layer.
2. Click the Window menu and click the Layer choice.

To move between multiple layered SiteManager components:

1. Click the Window menu and click the name of the SiteManager component from the list.
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W indow
Tile Shift+F 4
Layer Shift+F3
LCascade Shift+F5

v 1 Server to PM Pipeline
2 Price Index Maintenance

Figure 3-25 The Window Menu with two SiteManager Components Active

3.3.6 Standard Help Menu Choices

The Help menu will contain standard Help choices — Contents, Search Help on, and Glossary. Help in
SiteManager will work like any other Windows Help.

3.3.6.1 Accessing Help Using the F1 Key

SiteManager help is context sensitive. When you are in a SiteManager window
and have a question about the window, pressing the F1 key invokes the help for
that particular window.
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Selecting or Adding a Conference in Contract Records

To access the Select Construction Conference Data panel:
1. On the Contractor Management panel, double-click the Construction
Conference icon.

in the following list.
Field Name and Description
Conference Date - Construction Conference - Selecting or Adding a Conference

Conference Title - Construction Conference - Selecting or Adding a Conference

To view a Construction Conference record:
1. Onthe Contractor Management panel, double-click the Construction
Conference icon. The Construction Conference panel opens.
2. Click the Open hutton. The Select Construction Conference Data panel
opens.
. Inthe Contract ID list hox, scroll to and click the desired choice.
4. Click Ok. If the selected Contract has conference records, the select panel
displays a list of conference titles and dates.
4. Inthe Construction Conference list hox, scroll to and click the desired
chaice.

[&5)

conference.

The Select Construction Conference Data panel lets the User select a Conference from a list of Conference
Titles and Dates, or add a new conference. The User can find, sort, and filter the Conference list.

When the Select Construction Conference Data panel opens, it displays a list of Contracts. After the User
selects a Contract ID, the panel displays a list of conferences for the selected Contract. The fields are defined

6. Click Ok. The Construction Conference panel displays data for the selected

-

Figure 3-26 The F1 Key Invokes Help

To access Help using the F1 key:
1. In a SiteManager window, press the F1 key.

2. When finished, click the File menu and click the Exit choice.

3.3.6.2 Accessing Help by Contents Using the Menu

The Content choice displays an alphabetized list of Help Topics that can be browsed for the subject on which

you need help.
To access Help by Contents:
1. Click the Help menu and click the Contents choice.
2. In the topics list box, scroll to and click the desired topic.

3. When finished, click the File menu and click the Exit choice.
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Contents

The following Help Topics are available:

General Concepts

Edit Menu - Cutting, Copying, and Pasting

Edit Menu - Unda

Edit Men :

File Menu - Displaying the Sitetd anager Panel

Filz Menu - Exiting Sitetd anager Using the Menu

File Menu - Exparting & Windaws Print Besulks - Print Previews Save &

& Buttan

File Menu Choices
General Procedures - Documentation Support

Help Menu hig Help by Conte ifg the Menu
Help Menu - £ ng Help Using the F1 Key

Help Menu - On-Line Help Development

Help Menu - Using Help by Searching

Help kenu - Uzing the Current 'Window Help

Help kMenu Choices

Menuz - Edit Menu
File bMenu
: - Frame Menus
Menus - General Guidelines
Menuz - Help Menu
Menus - Menu Lapout
nus - Object Menuy Choices
: - Object Menu
i L
b anager Menus

Menus - Window bMenus

Figure 3-27 The Help Contents

3.3.6.3 Using Help by Searching

The Search for Help on choice displays a lengthy, alphabetized list of Help Topics that can be browsed or

searched for the subject on which you need help.

To access Help by searching:

1. Click the Help menu and click the Search for Help on choice.

2. Type the topic on which you need help.
3. Click the topic.
4. Click the Display button.

5. When finished, click the File menu and click the Exit choice.
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Agaregate Mix Designs Gradations Folder Tab
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Annual EED Report
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Approval Bules ‘Window

Approval Window
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Approved Lists Reports

Approved Maternialz
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=l

Dizplay I Print...

Cancel |

Figure 3-28 The Help Search

3.3.6.4 Using the Current Window Help

With any SiteManager window active, the Help menu’s Current Window choice will access context sensitive
help that includes Help on fields.

To access Help on the current window:

1.
2.

3.

Display the SiteManager window for which you need help.
Click the Help menu and click the Current Window choice.

When finished, click the File menu and click the Exit choice.

To access Help on a field:

1.
2.

3-28

Display the SiteManager window that has the field for which you need help.

Click the Help menu and click the Current Window choice.
In the field list, scroll to and click the desired field.

When finished, click the File menu and click the Exit choice.
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File Edit Bookmark Options Help
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Aggregate Mix Designs Compression Strength Folder Tab

To add a new Aggregate Mix Design compression strength:

1. Add oropen the Mix Design description.

2. Clickthe Compression Strength folder tab.

3. Inthe Age field, type the desired value.

4. Inthe Age Type drop-down list. click the expand
arraw to the right of the current selection and click
the desired choice.

Press the Tab key.

6. Inthe Cement Percent field, type the desired
walue.

7. Pressthe Tab key.

3. Inthe Compression Strength field, type the
desired value.

9. Inthe Compression Strength Units Type
drop-down list, click the expand arrow to the right of
the current selection and click the desired choice.

10. When complete, click the Sawve button.

o

Figure 3-29 The Help on a SiteManager Window

3.3.6.5 On-Line Help Development

On-Line Help for SiteManager was created using RoboHELP™ by Blue Sky Software. The Microsoft Word
files that were used to compile the help files were provided to AASHTO. To modify the Help files using
RoboHELP, obtain the files from your AASHTO representative.

3.3.7 Using the Object Menu for Data Manipulation and Retrieval

The Object menu is a context sensitive capability — the choices that will appear Cut
in the Object menu is determined by where you right click. For instance, when Paste
you position the pointer above a searchable field, the Search Lens will appear. EOD}'
Right clicking the searchable field produces an Object menu with the Search Clear
choice as the only available choice.
Search
To make data entry and retrieval easier, SiteManager provides a Search, Filter, Filter
Find, and Sort capability throughout the application. The Filter and Find Find
functions also provide users with the ability to limit the data retrieved from the Sort
SiteManager database by specifying criteria using relational operators. The Clear —
function clears the current data retrieval choice in effect. The Show Filter/Sort Show Filker/ Sort
choice shows the current criteria in effect for these choices.
The Object Menu
Figure 3-30
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An easy way to access the Search feature is via the Object menu. The Object menu displays when the user
clicks the right mouse button on a search field. When the pointer is positioned over a search field, the

selection pointer changes to the Search Lens. B
3.3.7.1 Searching

When a data entry field requires selecting a value from a list of possible values, the Search choice allows the
user to limit the list and quickly select the desired value.

ﬂPmlland Cement Concrete Mix Design Description M=l E

e ——
Description Properties M aterials Gradations

MixID: [
Material Code: | Q |
|

Producer Supplier Code: |

Designer Name:

Concrete Class Type: I:E

Effective Date: |E|1 /3097 Termination Date: IUUEUU."DD
Approved Date: IEID.-’EID:’UD Approved By User ID: I

Figure 3-31 The Search Lens Appears
To search on a field:
1. Position the selection pointer (changes to the Search Lens) over a search field.
2. Using the right mouse button, click the field.
3. From the object menu click the Search choice.
4. Select the correct record from the list.

5. Click Ok.

B If the mouse button that opens an item (double-click) has been reassigned to the right button using the
Mouse control panel, the buttons are switched — the right button selects the column and the left button
invokes the Object menu.
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Item Code | Spec Year Short Description =
07 -0000 1933 MISCITEMS
007 -0000 1933 MISC ITEMS
007 -0000 1333 MISC ITEMS
007 -0000 13933 MISC ITERS
007 -0000 1932 MISC ITEMS
007 -0000 1332 MISC ITERS
007 -0000 1932 MISC ITEMS
007 -0000 1332 MISC ITERS =
| | 3
1] 4 Cancel

Figure 3-32 The Search Window

3.3.7.2 Filtering

The ‘Filter’ choice allows the user to specify filtering criteria for SiteManager fields and their limiting values
using relational operators. Each time a window displays, the filtering criteria, marked as default, is
automatically applied, thereby limiting the amount of data retrieved. Only one default filter criterion can be
in effect for a window at any given time.

When creating multiple conditions, remember that AND joins will be executed before OR joins.

To filter out other records:

1.
2.

Position the selection pointer over a record
Using the right mouse button, click the record.
From the object menu click the Filter choice.
Click the Add button.

In the Field drop-down list, click the expand arrow to the right of the current selection and click the
desired field.

In the Condition drop-down list, click the expand arrow to the right of the current selection and click
the desired choice.

In the Value field, select the current entry and type the desired value.
To add additional conditions, click the Add button.

In the Join drop-down list, click the expand arrow to the right of the current selection and click the
desired choice.
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10. Repeat steps 5-9 until you have selected all conditions.

11. Click Ok.

Filter Criteria E2

Field Condition Value Join Insert
| == (=1 and Add

Bemove

Clear

Test

Load!..

Save..

Cancel

Help

Figure 3-33 The Filter Criteria Window

3.3.7.3 Finding

When a window displays as a scrollable list, the Find choice allows the user to get to a specific row by
selecting the appropriate value to find.

When creating multiple conditions, remember that AND joins will be executed before OR joins.
To find specific records:

1. Position the selection pointer over a record

2. Using the right mouse button, click the record.

3. From the object menu click the Find choice.

4. Click the Add button.

5. In the Field drop-down list, click the expand arrow to the right of the current selection and click the
desired field.

6. In the Condition drop-down list, click the expand arrow to the right of the current selection and click
the desired choice.

7. In the Value field, select the current entry and type the desired value.

8. To add additional conditions, click the Add button.
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9.

In the Join drop-down list, click the expand arrow to the right of the current selection and click the
desired choice.

10. Repeat steps 5-9 until you have selected all conditions.

11. Click Ok.

3.3.7.4 Sorting

When the window displays as a list, the Sort feature allows the user to sort the list, based on specified criteria.
Each time the window displays, the default sort criterion is automatically applied. As with the Filter function,
only one default sort criterion can be in effect for a window at any given time.

To sort the records:

L.
2.

Position the selection pointer over a record
Using the right mouse button, click the record.
From the object menu click the Sort choice.
Click the Add button.

In the Field drop-down list, click the expand arrow to the right of the current selection and click the
desired field.

In the Order drop-down list, click the expand arrow to the right of the current selection and click the
desired choice.

To add additional sorts, click the Add button.
Repeat steps 4-7 until you have selected all sorts.

Click Ok.
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Insert

Bemove
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Load...

Save. .

11,4

Cancel

Help

Figure 3-34 The Sort Window

3.3.7.5 Displaying the Filter or Sort

The Display Filter/Sort choice displays the current criteria in effect.

To display the current criteria:

1.
2.

Position the selection pointer over a record
Using the right mouse button, click the record.
From the object menu click the Show Filter/Sort choice.

Click Ok.

3.4 Toolbars

3.4.1 General Guidelines

The following guidelines apply to the use and structure of SiteManager toolbars.

The most often used menu choices have a corresponding toolbar button for ease of use.

Buttons used on toolbars are consistent throughout the application.

Toolbars

All toolbar buttons have Tool Tips — text associated with the button that describes what the button does.
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If a toolbar button is sometimes applicable and sometimes not applicable, it will be enabled or hidden. For
example, a toolbar button may be applicable for one folder tab and may not be applicable for the second
folder tab. When the menu item is applicable for the active folder tab, it will be enabled and will display
normally. When the toolbar button is NOT applicable for the active folder tab, it will not appear on the
toolbar. The toolbar button will be enabled or hidden depending on which folder tab is active.

Main
Panel Exit New Close Save
=[S s E = E = =
Toolbar Help Open Delete Remarks

Figure 3-35 The SiteManager Toolbar

3.4.2 Toolbar Layout

The SiteManager Toolbar has seven common toolbar buttons to display: the Exit, New, Open, Close, Delete,
Save, and Help buttons.

Toolbar Tool Tip | Comparable Menu Description
Button Function
+ Exit File menu’s Exit choice Exits the application. It will
ask for saving of changes, if

the there are unsaved changes.

ey Help Help menu’s Contents choice | Brings up the SiteManager
I'_ﬁ:ll Help Contents Window.

New File menu’s New choice Is used in context to clear all
D the columns for data entry.
However if the sheet contains
more than one control capable
of creating new rows, the New
option will create a new row,
on whichever control is
currently active.

T Open File menu’s Open choice Allows another record to be
E? selected. Typically, it is
applicable to the current tab.
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Toolbar Tool Tip | Comparable Menu Description
Button Function
L Close File menu’s Close choice Closes the current sheet. It
E? will prompt for saving any
changes, before closing the
sheet.
Delete Edit menu’s Delete choice Like the New Choice, the
Delete choice contextual and

is applicable for the current
control. It will prompt for a
confirmation from the user
through a message.

H Save File menu’s Save choice Saves the sheet and stays on

1 the sheet.

DI Remarks | Services menu’s Remarks Displays the Remarks dialog
choice to attach freeform comments.

Table 3-9 The Toolbar Button Table

3.5 Using the SiteManager Toolbar

The SiteManager Toolbar is accessed using the mouse. Buttons unlike icons only require a single click — not
a double click.

To use a SiteManager toolbar button:
1. Click the desired button.
To display a Tool Tip:

1. Position the mouse point on the button (and hold the mouse still).

3.5.1 Standard Toolbar Buttons

The following SiteManager toolbar buttons are standard throughout the application and will always be
performed in the same way. Sheet specific toolbar buttons will be covered with the applicable SiteManager
functionality.
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3.5.1.1 Exiting SiteManager Using the Toolbar

The Exit button exits the SiteManager application. If current work has not been m!

saved, a warning message will allows the data to be save before the application is

closed or to cancel the exit. The Exit Button
Figure 3-36

Doy &

K:!) Save changes?

Figure 3-37 The Exit Warning Message
To exit SiteManager:

1. Click the Exit button.

3.5.1.2 Accessing Help by Contents Using the Toolbar

The Help button displays an alphabetized list of Help Topics that can be browsed f"-:FL;-'
for the subject on which you need help.
The Help Button

Figure 3-38

To access SiteManager Help:

1. Click the Help button.

3.5.1.3 Creating a New Record Using the Toolbar

The New button clears the old record and creates a new record. If changes have D

been made to the current record, it will prompt you to save changes before

clearing the current record. The New Button
Figure 3-39

To create a new record:

1. Click the New button.
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3.5.1.4 Opening Using the Toolbar

The Open button allows another record to be opened.

To open another record:

1. Click the Open button.

3.5.1.5 Closing Using the Toolbar

The Close button closes the current sheet. As with the Exit button, a warning
message will allows the data to be save before the current activity.

To close the current sheet:

1. Click the Close button.

3.5.1.6 Deleting Using the Toolbar

The Delete button deletes the current works on the sheet. A message will require
you to confirm the deletion, before it is made. If you subsequently save your
work after deleting records, the Edit menu’s Undo choice may not be able to
retrieve the deleted records. When you confirm a delete, be sure that you do want
to delete the data.

'\?) Save changes?

Mo | Cancel |

Figure 3-43 The Delete Confirmation Warning Message
To delete:

1. Click the Delete button.

3-38

=
The Open Button
Figure 3-40

=
The Close Button
Figure 3-41

The Delete Button
Figure 3-42
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3.5.1.7 Saving Using the Toolbar

The Save button saves your current work. If you have performed some deletion ||
during a work session, you may need to reconsider whether the deletion were ]

correct before saving. After you have saved, you may not be able to undo the The Save Button

deletions.
Figure 3-44
To save:
1. Click the Save button.
3.5.1.8 Attaching Remarks Using the Toolbar
Remarks may be attached to a variety of records in the various components of E]I
SiteManager. The Remarks button displays an freeform dialog that allows any ‘
comment to be recorded. The Remarks Button
When Remarks are available for a SiteManager window, the presence of the Figure 3-45

Remarks button on the Toolbar serves as a reminder that they are appropriate

To attach an remark:
1. Click the Remarks button.
Or
2. Click the Services menu and click the Remark choice.
3. Type the desired comment.
4. Click outside the Remark dialog to close the Remark.

5. Click the Save button.

3.5.1.9 Other Buttons of the Toolbar

Depending on what SiteManager window you are using, other buttons may appear on the Toolbar. These
other buttons will be equivalent to some SiteManager menu option that you use. To identify what a button
does, use the Tool Tip for the button. If you check the menus, you will find a comparable capability on the
menu.

To display a Tool Tip:

1. Position the mouse point on the button (and hold the mouse still).
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3.6 General Procedures

3.6.1 Documentation Support

On-line versions of the User Reference Manual and the Sampling and Testing Procedures for your DOT are
accessible in an Adobe Acrobat™ format. The Microsoft Word files that were used to compile the on-line
documentation were provided to AASHTO. To modify the documentation files, obtain the files from your
AASHTO representative.

The Sampling and Testing Procedures are also a resource provided by AASHTO.
To access on-line documentation:

1. On the Main Panel, double-click the Documentation icon.

2. Double-click the documentation icon you wish to reference.

Previous Page Button Next Page Button

First Page Button ast Page Button

Acrobat Reader

) Fie Edit View Tools ﬂin TR

K 2 (2N I R [ Y [

Eymanvmnms
1l Ceamal Dackmo
17 EAMECAS Dpuaanay

Syzmndxiameory

21 ChiemZmvw EALE Dao Mo

22 CRmE M BALS TaHa-TIN A 30K
21 CiemZmw EALG [amammar

2a Hasvhen s xd Sofoe s Aague s

Edid 5 Aaer
31 Famer Dasimen
12 EAME Tabisa Uasd 0 TAS Fagst Tenglama

Oacinm
W1 EAMEFafusao Tabm
12 PO tois Rl BUASIEAS

Dafauc Diadog
Oamsanca I mofoowna

Eyan | fan
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Fun e grtua ez axm Tacia

Ay [ 4ofse7 \ | = s0% || [M 350110000 i ¥

\

Go To Button

Figure 3-46 The Documentation in Adobe Acrobat
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To navigate in Adobe Acrobat:
1. Click the Next Page button.
Or

2. Click the Previous Page button.

3. Click the First Page button.

4. Click the Last Page button.
Or
5. Click the Go To button.
6. Type page number you want to which you wish to go.

7. Press Enter.

3.6.2 Reports

The following procedures are a general description of how to generate PowerBuilder-based SiteManager
reports. Each section of the manual describes report specifics for each component of SiteManager.

To generate a PowerBuilder-based report:
1. Double-click the desired report icon.
2. Select the criteria.

3. To generate the report on-line, click Ok.

4. To generate the report off-line to a file, click the Generate Off-line File check box (ON).
5. Click Ok.
Or
6. To generate and print the report off-line, click the Generate Off-line Print check box (ON).
7. Click Ok.
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The Summary by Project Report is unique in that multiple reports may be generated in a batch print process.

To select multiple reports to be printed:

1. On the Report Criteria window, click the Generate Off-line Print check box (ON).

2. To select multiple report criteria, highlight the desired criteria by holding down the shift and/or
control keys and clicking the desired report criteria. The shift key allows an entire block of criteria to
be selected, while the control key allows individual rows of criteria to be selected.

3. Click Ok.

To make selections in the Report Criteria dialog:

1. Click the desired radio button to select the desired format.

e By Summary selects all items

e By Criteria (field name) selects an individual field

In a By Criteria (field name) format:

2. Using the right mouse button, click the field.

3. Perform a Search using the object menu (referenced in the Getting Started section).

4. Click OK.

3.6.2.1 Report Options

The report options are available as toolbar buttons or menu options for reports that have been generated on-

line.

Components

Description

Close button

Closes the report preview.

Save button

In a simple report (see Save Reports section) invokes the Save
dialog allowing the report to be saved in a .PSR file format.

Print button Prints the report.
Prior button Displays the prior page of a multi-page selection.
Next button Displays the next page of a multi-page selection.
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Components Description
Zoom spin button Magnifies or reduces the display of the report preview.

Copies spin button | Allows more than one copy of the report to be printed.

Table 3-10 The Report Components Table

3.6.2.2 Saving, Opening, and Exporting Simple Reports

There are two types of reports in SiteManager — simple reports and complex reports. Simple report can be
saved and exported, but complex reports cannot. It is easy to identify a simple report — the File menu’s Save
choice (or the Save button) and the Service menu’s Export choice will be active for a simple report. They will
not be active for a complex report.

3.6.2.2.1 Saving and Opening Simple Reports

A simple report can be saved for later retrieval. SiteManager saves the report using a .PSR extension. The
View Saved Report icon on your reporting panel can be used to open a saved report.

To save a report:
1. Click the File menu and click the Save choice.
Or
2. Click the Save button.
3. Type the name for the file.
4. Change the drive and directory as desired.
5. Click OK twice.
To open a saved report:
1. Double-click the View Saved Reports (PSR) icon on the reports panel.
2. Change the drive and directory as needed.
3. Select the PSR file.
4. Click OK.

If the File menu’s Save choice or the Service menu’s Export choice is grayed out, the report is a complex report that
can NOT be saved or exported. The Save button will only make your standard error sound for the same reason.
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3.6.2.2.2 Exporting Simple Reports

A simple report can also be exported into file formats other than PSR. To access an exported simple report
file, you must have an applications software package that can access one of the file formats.

File Extension File Format Description

TXT ASCII Tab Separated (Delimited) format
XLS Microsoft Excel Spreadsheet format
.WKS Lotus 123 early format

.WMF Windows Metafile graphical format

Table 3-11 The Export File Formats Table
To export a report:
1. Click the Services menu and click the Export choice.
2. Type the name for the file.

3. Inthe Save File As Type drop-down list, click the expand arrow to the right of the current selection
and click the desired file format.

4. Change the drive and directory as desired.

5. Click OK twice.

3.7 Plug-In, URL, and OLE Attachments

The URL/Plug-In/OLE functionality of SiteManager allows URL links, Plug-In applications, and OLE
documents to be attached to certain SiteManager functions or specific records within that function. The
stand-alone feature also allows URL links, Plug-In applications and OLE documents to be accessible to the
User through a separate Attachments window accessed through the Accessories panel.

L]
If the File menu’s Save choice or the Service menu’s Export choice is grayed out, the report is a complex report that
can NOT be saved or exported. The Save button will only make your standard error sound for the same reason.
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URL links, Plug-In applications, and OLE documents may be associated to:

Material Test Templates
DWR Templates

Contracts

Contract Estimate History
Correspondence Log
Change Order Header
DWR - Record Work Item
Maintain Sample - Additional Sample Data
Force Accounts

Contract Adjustments
Contract Time Adjustments
Line Item Adjustments
Contractor Evaluation

Milestone Time Adjustment

Trnseport SiteManager®
General Concepts

Attachments are activated either by a User click or configured to trigger automatically when a window to
which an attachment is associated is initialized. Each Plug-In application, URL, or OLE document may be
associated to a specific record.

The Plug-In functionality also allows a limited amount of data to be automatically passed to a Plug-In
application upon execution.

August 2005
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3.7.1 URL, Plug-In and OLE Attachment Icons

@ Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachments Attachment window.

Appears on the toolbar of any window that may have an
attachment associated with it.

Allows User to activate Plug-In applications or URLSs associated with the
window.

5

Run Attachments

Opens a dialog box allowing the properties of a URL attachment to be
modified or entered.

=

New URL

Opens a dialog box allowing the properties of a Plug-In attachment to be
modified or entered.

&

New Plug-In

Opens a dialog box allowing the properties of an OLE attachment to be
modified or entered.

B

New OLE Document

'ﬂ Deletes the current OLE document.

Delete OLE Document

Figure 3-47 The Attachment Icon Table
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3.8 Using Attachments

3.8.1 Attachments Associated with Records

Trnseport SiteManager®
General Concepts

URL links, Plug-In applications, and OLE documents may be associated to the following record types:

Material Test Templates

DWR Templates

Contracts

Contract Estimate History
Correspondence Log

Change Order Header

Daily Work Reports - Record Work Item
Maintain Sample - Additional Sample Data
Force Accounts

Contract Adjustments

Contract Time Adjustments

Line Item Adjustments

Contractor Evaluation

Milestone Time Adjustment

Attachments may be associated to a specific record. Attachments may also be configured to either activate
when a window is opened, or when selected through the Attachment window. System-based attachments are
URL links, Plug-In applications, and OLE documents that do not need to be associated with a specific
SiteManager function or record. System Attachments are accessed through the Accessories panel.
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3.8.1.1 Attachment Usage

Figure 3-48 The Attachment Window

To display Plug-In, URL, and OLE attachments:
1. Navigate to the SiteManager function associated with the attachment you wish to use.

2. Click the Attachment icon to access the Attachment window. Note: As the attachment is associated
to a specific record, that record must be opened before accessing the Attachment Window. The
Autorun feature indicates that the attachment will be run as soon as the Attachment Window is
opened without the user having to click the Run button.

3. The previously-created URL, Plug-In, and OLE attachments appear as a table grid on the
Attachments window. Sort and Filter features may be used on this window by right-clicking and
choosing a feature from the Object menu.

4. Double-click the desired attachment to activate, or highlight the desired attachment and click the Run
Attachments icon.

5. Activating a Plug-In opens the specified application in a separate window. Activating a URL or
HTML File item launches the system’s default browser. Activating an OLE opens the specified
document.

6. Once the User has completed work with the URL, Plug-In application, or OLE document, the browser
or application may be closed as normal.

3.8.1.2 Attachment Definition

Once the appropriate area of SiteManager has been reached, the creation steps are identical.
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Figure 3-49 The Attachment Window

Field Description

Name Name of the attachment

Type OLE, URL or Plug (executable)

Description Short textual description of the attachment.

Autorun Indicates that the attachment will be run as soon as the user opens the attachment
window.

Figure 3-50 The Attachment Window Field Description Table

To access the Attachments window, click the Attachments button, or click the Services Menu and click
Attachments.
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3.8.1.2.1 Plug-In Attachment Definition

=4 Plug-in Attachn

X

Mame:

Enter command line:

Build Command. _. i

D escription:

Attachment Security:

Group 1D De=cription Fs
ACCTPG  [Accounting - Projects and Grants Add -> i

DMASST [Bdministrative Assistant Add All ->>
ICOSTEST [Cost Estimates L] ._._._...j

IFINLENG  [Firalz Enginzer
NG lrvquiry Tl - D3R

INSP [rspectar Standalons oy I
INSPTST  [Field Inspector/Taster

INSPTSTS [Field Inspector/Taster - Standalcij:-l <<- Bem All
3

Description Access

1 |

[ Bun Automatically

Add |  Cancel

Figure 3-51 The Plug-In Attachment Window

Field Description

Name Required field. The User-entered name of the attachment entered in freeform
text.

Enter Command Line The executable application’s command line. Either entered by the User or

returned through the Build Command function.

Description Not a required field. A short, User-entered description of the executable
application in freeform text.

Attachment Security Allows the User to restrict access to the attachment at the Group level.
Run Automatically If checked, the Plug-In is executed upon activation of the window it is attached
to.

Figure 3-52 The Plug-In Attachment Window Fields Table
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To create a new Plug-In Attachment:

L.
2.

6.
7.

Click the New Plug-In button to access the Plug-In Attachment window.
On the Plug-In Attachment window, click the Name field and add a name for the new plug-in.

Click the Enter Command Line field. The command line may be entered directly into this field or
returned from the Build Command button. Note: The Build Command function is discussed in the
next section.

Click the Description field and enter a description.

In the Attachment Security box, choose the Group(s) to which this Attachment will be visible and
click Add to add each one to the Access box.

To make the Plug-In executable upon window initialization, click the Run Automatically box on.

After all fields defining the Plug-In are entered, click the Save button.

Note: The Run Automatically check box does not appear in the stand-alone function.
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3.8.1.2.1.1 The Build Command Function

The purpose of the Build Command function is to assist the User in the set up of a plug-in attachment’s
executable command line and any additional data that needs to be passed to the application at execution.

Build Command Line --I
Command Line:
Executable File:

Select File...

~ Parameters

Field Variables: { ycer id
user passward

Other:

il |

add I
oKk | clear | [ cCancel |

Figure 3-53 The Plug-In Attachment Build Command Window

Field Description

Command Line This protected field displays the command being built from the Executable File,
Parameters: Field Variables, and Parameters: Other fields. This line may not be
longer than 255 characters.

Executable File Required field. This may be entered by the User or populated by selecting a file
from the Select File function.

Parameters: Field Field variables are selected from the list provided. This list will differ depending
Variables upon which function is being accessed. Variables are retrieved from the
SiteManager database and passed to the executable application.

Parameters: Other Variables entered in this field are passed as entered to the plug-in application
when it is activated by a User.

Figure 3-54 The Plug-In Attachment Window Fields Table
To build a command using the Build Command function:

1. On the Plug-In Attachment window, click the Build Command button. The Build Command
window opens.

2. Enter the executable command path or click the Select File button. The Select File window opens,
allowing browsing of the system’s directories to locate and select an executable file and its path
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directory. Click Open. The file name and path are passed to both the Executable File and the
Command Line fields.

If desired, select an item from the Parameter Field Variable list by clicking on the desired item.
Click the Add button to add the field variable to the Command Line. These variables for the selected
record will be passed to the plug-in attachment when it is activated.

Note: If the attachment is for Contracts, the Contract ID is a variable that may be passed to the
attachment automatically by the system.

Note: Since a 'space’ is the defined parameter delimiter for plug-in command lines, there should be
no spaces in the path defining where the plug-in attachment can be found by the system. For
example, if a user wishes to have a plug-in attachment that initializes a Word document called
form.doc, the command line might be:

c:\program files\msoffice\winword\winword.exe c:\templates\form.doc

If the command line were written as follows, the command would not work because of the space in the
‘my documents” directory name:

c:\program files\msoffice\winword\winword.exe c:\my documents\templates\form.doc

To add additional data to be passed to the application at execution, click the Parameter: Other field
and enter the desired data.

Click Add. The additional data appears on the Command Line.

6. When the Command Line has been completed, click the OK button. The Build Command Line
window closes, and the Command Line is passed to the Plug-In Attachment window’s Enter
Command Line field.

Note: The Command Line may not be longer than 255 characters.

3.8.1.2.2 Fields Available For Use By Plug-Ins
The following table, organized by SiteManager functionality, lists the fields available to the Plug-In function.

Functional Area Field ID Field Description

All Areas
USER User ID
PSWD User Password

Daily Work Reports
CONT DWR Contract ID
DATE Daily Work Report Date
INSP DWR Inspector User ID
PROJ DWR Project Number
ITEM DWR Line Item Number
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Functional Area Field ID Field Description
LOCA DWR Location Sequence Number
Materials Management
SMPL Sample ID
METH Test Method
TST# Sample Test Number
RGHT User Rights
MTR# Material Code
SPBY Sampled By
PSC# Producer/Supplier Number
ATHZ Authorized By user ID
RVS# Revision Number
SPFR Sampled From
GEOA Geographic Area
STAT Sample Status
MIX# Sample Mix ID
MIXT Sample Mix Design
LAB# Lab ID
SPDT Date Sampled
AZDT Date Authorized
CMDT Date Completed
Contract Administration
CONT Contract ID
EST# Estimate Number
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Definition

X

Enter command line:

Description:

Build Command... i

Attachment Security:
Group 1D Description s Description P
Accounting - Proj Add > i

DMASST [Edmiristrative Assistant

COSTEST [Cost Estimates

Add All -»> i

FINLENG  [Fihals Engires

T

MO [IFvquiiny Tkl - DR

IMSF [[Fspector Standalone P I
IMSPTST [Field Inspector/T ester

o

INSPTSTE [Field Inspector/T ester - Standalone <] = Hemal
3

[ Run Automatically

Add | Cancel

Figure 3-56 The Select File or URL Window

Field Name Description

Name Required field. The User-entered name of the attachment, entered in
freeform text.

Enter the URL or Specify a Required field. The location of a local html document or web page

Local File address.

Description Not required. A short, User-entered description of the html document or

web page address.

Table 3-57 The Select File or URL Attachment Window Fields Table

To create a new URL or html File attachment:

1. Click the New URL button to access the Select File or URL window.

2. Click the Name field and
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3. Click the Enter Command Line field. The command line may be entered directly into this field or
returned from the Choose File function.

4. Click the Description field and enter a description.

5. Inthe Attachment Security box, choose the Group(s) to which this Attachment will be visible and
click the Add button to add each one to the Access box.

6. After all fields defining the URL or html File are entered, click the Save button.

3.8.1.2.4 OLE Attachment Definition

Inzert Object | x| |

. Create New | Create Fram Filel Inzert Eantroll

i Object Type:

ActionBuwr Clazz - [ Dizplay Az lcon
ActorBywr Class
Adbook, Document
Adbook. Document D
Adobe Acrobat Document

ColorBwr Class

Bitrnap |rnage
EED'D[B'-,-‘[ I gy

Cr Behavior Factom
Datalt Class
DHTML Edit Control for IES

DHTHL Edit Contral 5afe for Scripting fo

EffectBywr Clazs LI Browsze... |

— Result

Inzertz a new ColorBwr Class object into pour

document.

| k. I Cancel

Figure 3-58 OLE Insert Object Dialog Box (Create New Tab)

Field Name Description

Object Type List of OLE-compliant applications that are installed on the client
machine that may be used to create an OLE document.

Figure 3-59 The OLE Insert Object Dialog Box Fields Table
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[ER0LE Attachment | ||| | | | [ [ e

OLE contents:
' ordPad D ocument

Description:

Attachment Security:

Description Access

Add ->

ADMASST administrative Assistant Add All ->> |
COSTEST [Cost Estimates |

FINLENG |Finals Engineer
INSPTST |Field Inspector/T ester
INSPTSTS [Field Inspector/Tester - Standalone

<- Bemove

MANAGEF [Manager - Inquiry Dnly

PR Froject Manager o Bem All |
L | ol

[~ Pun Automatically

Add r LCancel |

Figure 3-60 The OLE Attachment Definition Window

Field Name Description

Name Required field. The User-entered name of the attachment, entered in
freeform text.

OLE Contents A non-editable field which indicates the application in which the OLE
attachment is generated.

Description A freeform text explanation of the OLE attachment and its purpose.

Attachment Security: Group ID | The Group ID to which the attachment is to be accessible.

Attachment Security: The full, descriptive name of the Group ID.
Description
Run Automatically When checked, this box indicates that the OLE will be run automatically

when the Attachments icon is clicked.

Figure 3-61The OLE Attachment Definition Window Fields Table
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To create a new OLE attachment:

L.

Click the OLE button to access the Insert Object dialog box.

Select the type of OLE object to be created by clicking the application name in the Object Type box.
Click OK. The OLE Attachment definition window appearl

Click the Name field and enter a name for the OLE attachment.

Click the Description field and enter a description.

In the Attachment Security box, choose the Group(s) to which this Attachment will be visible and
click the Add button to add each one to the Access box.

If it is desirable to have the OLE attachment appear upon entering the Attachments window, click the
Run Automatically check box ON.

After all fields defining the OLE are entered, click the Add button.

On the Attachments window, double click the OLE definition just created to begin creating the OLE
document.

10. When finished, click File then Update, and close the window normally.
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4.1 Contract Administration Overview

Contract Administration Overview

Contract Administration includes the reference data and program functions that are used to view, add, modity,
and delete Contract records. These are grouped on the following panels:

Panel Name Description
Reference Tables (CA) | The Reference Tables (CA) panel contains the Contract
Panel defaults and standard data. This includes the Vendors,

Funding Sources, and Items that the user can add to
Contracts. The Interface Load Messages window displays
the results of processes that load data from other systems.

Contract Records
Panel

The Contract Records panel contains the functions that
maintain Contract records. This includes the Contract
description, Milestones, Projects, Categories, Items,
Funding, Stockpiled Materials, Key Dates, Scheduled
Events, Permits, user authority, and design evaluations.

Contractor
Management Panel

The Contractor Management panel contains functions for
recording Contract-specific data on Prime Contractors
and Subcontractors. This includes conference and
document tracking, Subcontract descriptions, Contractor
Payrolls, Progress Schedules, and Contractor
Evaluations.

Reports Panel

The Reports panel contains Contract-specific reports.
These include reports on Contract status, Contractor
status, Subcontract value, disputes and claims, Item
quantity, Item work, and Contract history.

Table 4-1 The Contract Administration Panels Table
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MisiteManagerPanel 1 ||| || E)|
Main Panel T[ : :';“:’E":a:ci :‘: : : : : : : : :;: : ‘T Reference T ables(Ca+]

M B & & =

Reference Contract Contractor Reports [CA+]  Process List
Tables(Ca+) Records(+)  Management(+)

Figure 4-1 The Contract Administration Panel
To access the Contract Administration panel:

1. On the SiteManager main panel, double-click the Contract Administration icon.

4.2 Reference Tables (Contract Administration)

The Contract Administration reference tables store the defaults and the agency-defined standards that are
added to Contracts. Typically, the reference table data is loaded into SiteManager from another system using
an interface load process. This section of the manual describes how to view and maintain the reference table
data in SiteManager.

Through the Reference Tables (CA) panel, an authorized user can add the following standards and defaults to
the reference tables: Administrative Offices, Funding Sources, Vendor information, default Key Date types,
default Checklist Event types, and default liquidated damage rates. The Reference Tables (CA) panel can not
be used to add the default Critical Date types or Items. The default Critical Date types were defined during
system development. Items are added to the Item Master via the Pre-construction system load program.

The defaults include the Critical Date types, Key Date types, Checklist Event types, and the liquidated
damage rates. After defaults are entered in the reference tables, SiteManager adds the defaults to new

Contracts automatically. For other Contract defaults, see the topic System Operational Parameters for

Contracts.

The standards include the Administrative Offices, Items, Funding Sources, and Vendor information. The
standards are defined by the transportation agency. After standards are entered in the reference tables, a user
can add standard data to a Contract by selecting it on the appropriate SiteManager window. For example, the
Funding Sources can be selected on the Contract Funding window.

Important! SiteManager will not let users overwrite the Reference Table data loaded from the Pre-
construction system by the interface load process.

The Reference Tables (CA) icons represent the following windows:

e Interface Load Messages

e  Administrative Offices
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Item Master

Funding Sources
Vendors

Default Critical Dates
Default Key Dates
Default Checklist Events

Tables Reference Tables (Contract Administration)

Default Liquidated Damages

ﬂSileManaget Panel [ x|
Main Panel T Contract Administration[+] T Reference Tables(CA+)
MeShase : T = Schedule
Ll W = &
(EIEEGELR Administrative  [tem Master  Funding Sources Wendors Default Critical — Default Key
M B Offices Dates Dates

2\

Default Checklist Default
Events Liquidated
Damages

Figure 4-2 The Reference Tables (CA) Panel

To access the Reference Tables (CA) panel:

1. On the Contract Administration

4.2.1 Interface Load Messages

This Interface Load Messages window 1

panel, double-click the Reference Tables (CA) icon.

ists the messages generated during the interface load processes. The

user can view and delete the messages on this window. The user can find, filter, and sort the message list.

Reference data load process
(REFLOAD)

Reference Table data is loaded into SiteManager from
another system by the REFLOAD process.

Pre-construction Contract data
load process (PRELOAD)

New Contracts are loaded into SiteManager from the
Pre-construction system by the PRELOAD process.

4-4
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Construction Contract data
load process (CONLOAD)

Contracts to be converted are loaded into SiteManager
from the Pre-construction system by the CONLOAD
process.

Table 4-2 The Interface Load Process Table

ﬂ Interface Load Messages

=] B

Load

19330408 | REFLOAD

Date Process | Contract ID

Table ID Message

T_INTRFC_MSG MIULL during insert]

19330403 | REFLOAD

T_INTRFC_MSG Record 8: SOLSTATE = 23000N[INTERSOLY][ODEC Orac

19330403 | REFLOAD

T_INTRFC_MSG Oracle]0RA-07400: mandatory [MOT NULL] column is miss

19330403 | REFLOAD

T_INTRFC_MSG Record 3: SOLSTATE = 23000N[NTERSDLYODEC Orac

19330403 | REFLOAD

T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT MULL) colurnn is miss

19330402 | REFLOAD

T_INTRFC_MSG MULL during insert]

19330416 | REFLOAD

T_INTRFC_MSG Oracle]0RA-07400: mandatory (NOT NULL) column is miss

19330416 | REFLOAD

T_INTRFC_MSG MIJLL during insert]

19330416 | REFLOAD

Record 10 inwalid

19330416 | REFLOAD

T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT MULL) colurnn is miss

19330416 | REFLOAD

T_INTRFC_MSG Record 8: SOLSTATE = Z3000NINTERSOLYIODEC Orac

19330416 | REFLOAD

T_INTRFC_MSG MILL during insert]

19330416 | REFLOAD

T_INTRFC_MSG Record 3: SOLSTATE = 23000N[NTERSOLYIODEC Orac

Al

-

Ready [Server [PROD [SMADMIN  [5¥51
Figure 4-3 The Interface Load Messages Window

Field Name Description

Date Date the interface load message was generated.

Load Process Name of the interface load process that generated the message
(REFLOAD, PRELOAD, or CONLOAD).

Contract ID Transportation agency-defined ID for the Contract associated
with the interface load message.

Table ID Name of the database table associated with the interface load
message.

Message Interface load message text.

Table 4-3 The Interface Load Messages Window Fields Table
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To delete an interface load message:
2. On the Reference Tables (CA) panel, double-click the Interface Load Messages icon.
3. To select one message to delete, click the row. To select multiple messages, Ctrl-click each row.
4. Click the Delete button. The selected message is deleted from the list.
5. Click the Save button.

Tip:  Find, filter, or sort the list to find specific information.

4.2.2 Default Liquidated Damage Rates

The Default Liquidated Damages window lets the user view and modify the default liquidated damage rates.
SiteManager adds a default rate to new Contracts based on the bid amount of the Contract. On the Default
Liquidated Damages window, the user can enter the rate per day for each Contract bid amount range. The
system only displays the highest value for each range. The lowest possible value for the Contract Amount
Range is $0.00, while the highest possible value is always $999,999,999,99.99.

Tip:  If the user does not enter a Contract’s liquidated damages rate manually, the system adds the default
rate to the Contract automatically when the Contract status is changed to active.

ﬂ Default Liquidated Damages [_ (O] x]
Contract Hange Max Amt Hate Amount =
20.000.00 40.00
26,000.00 50.00
50,000.00 100.00
100,000.00 150.00
500.,000.00 300.00
¥50,000.00 350.00
1.000.000.00 400.00
2,000,000.00 500.00
3,000,000.00 525.00
3.500.000.00 550.00
5,000,000.00 £00.00
10,000.000.00 200.00
15,000,000.001 1.000.00°
< | v

Figure 4-4 The Default Liquidated Damages Window

4-6 August 2005



Trnseport SiteManager®

Reference Tables (Contract Administration) Contract Administration - Reference Tables
Field Name Description
Contract Range Max The maximum amount for which the liquidated damages rate
Amount can be used. The total Contract bid amount must be equal to or

less than this amount and more than the previous ending
amount. This value must be unique. For states with one
standard amount for all Contracts, this value defaults to
99,999,999,999.00 and cannot be modified.

Liquidated Damages The default liquidated damages rate per day. This amount is
Rate Amount associated with the Contract Range Maximum Amount.

Table 4-4 The Default Liquidated Damages Window Fields Table
To add a default liquidated damages rate:
1. On the Reference Tables (CA) panel, double-click the Default Liquidated Damages icon.
2. Click the New button. An empty row is inserted before the selected row.
3. Type the ending range for the Contract Range Max Amt.
4. Press the Tab key.
5. Type the Rate Amount.
6. Click the Save button.
7. Click the Yes button.
8. The list is sorted in ascending order of ending range amounts.

Tip:  The large value in the last row cannot be modified or deleted.

4.2.3 Default Critical Dates

The Default Critical Dates window lets the user view and modify the default Critical Dates. The default
Critical Date types were defined during system development. The transportation agency can not add, modify,
or delete the Critical Date types. However, an authorized user can modify the default Critical Date settings.
SiteManager adds the default Critical Dates automatically to each new Contract. The Critical Date types are
listed here in alphabetical order:

e Accepted Date
e Adjusted Completion Date

e Award Date
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Checked Out to Field Date
Contract Archived Date
Contractor Bankruptcy Date
Contractor Default Date
Contractor Final Release Date
Execution Date

Letting Date

Notice to Proceed Date

Open to Traffic Date

Original Completion Date
Physical Work Complete Date
Price Adjustments Base Date
Signed Date

Substantial Work Complete Date

Work Begin Date

Reference Tables (Contract Administration)

These dates are considered critical because SiteManager includes them in the standard Contract
record reports.

ﬂ Default Critical Dates

=] B

Critical Date Type

Adjusted Completion Date

ired to Finalize

Contract Archived Date

Award Date

Contractor Bankruptcy Date

Checked Out to Field Date

Contractor Default Date

Execution Date

Contractor Final Release Date

Letting Date

Motice to Proceed Date

s|l=z(=|L|=|=|==|=|=

ZZ|IZ|Z|(Z=|Z|Z|Z|Z=|Z

[+| |

o

Critical Date Type: lﬁ‘ccepted Date

Distribution List: |

Recipient ID: |

[T Required to Activate
[ Required to Finalize

Message Text: |

Figure 4-5 The Default Critical Dates Window
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Field Name Description

Critical Date Type | System-defined default Critical Date type. The default Critical
Date types were defined during system development. The
transportation agency can not add, modify, or delete the Critical

Date types.
Required to Indicates that a Critical Date event must occur before the Contract
Activate status can be changed from Pending to Active (e.g., the Execution

Date). A Critical Date can not be both Required to Activate and
Required to Finalize.

Required to Indicates that a Critical Date event must occur before the Contract
Finalize status can be changed to Complete. A Critical Date can not be
both Required to Activate and Required to Finalize.

Distribution List Group to be notified when the actual date of the Critical Date
event is entered. The user can search this field. After valid entry of
a Distribution List, the Recipient ID field is protected.

Recipient ID Person to be notified when the actual date of the Critical Date
event is entered. The user can search this field. After valid entry of
a Recipient ID, the Distribution List field is protected.

Message Text Standard message to be sent to the recipient(s).

Table 4-5 The Critical Dates Window Fields Table
To make a Critical Date Required to Activate:
1. On the Reference Tables (CA) panel, double-click the Default Critical Dates icon.
2. Click the critical date.

3. If'the date is currently not required for either status change, click the Required to Activate radio
button.

4. Click the Save button.
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To select one or more recipients for notification that a date has occurred:
1. On the Reference Tables (CA) panel, double-click the Default Critical Dates icon.

2. In the Distribution List field or the Recipient ID field, type the entry or click the right mouse button
and perform a Search.

3. Click the Save button.

4.2.4 Default Key Dates

The Default Key Dates window lets the user add, modify, and delete the default Key Dates. The Key Date

types are defined by the transportation agency in the system code tables. On the Default Key Dates window,
the user can add pre-defined Key Date types to the default list. The user can find, filter, and sort the list, and
modify the Key Date settings. SiteManager adds the default Key Dates automatically to each new Contract.

Tip:  The main purpose of a Key Date is to monitor a key Contract activity and notify personnel when the
activity actually occurs.

5 Default Key Dates M= E

Fed/State/
Prov Ind

Required
to Finalize

Required

Key Date Type
to Activate

Closed ta Traffic D ate

ol o

Key Date Type: ICIosed to Traffic Date

Fed/State/Prov Ind: | Federal [~ Required to Activate
" State/Province
* Both [~ Required to Finalize

Distribution List: |

Recipient User ID: |

Message Text: |

Figure 4-6 The Default Key Dates Window

Field Name Description

Key Date Type | The Key Date Types are the names given by the transportation agency
to the Key Dates (e.g., Closed to Traffic Date, State Final Inspection
Date, Open to Traffic Date). The Key Date type is a required field and
must be unique. This field is protected unless the user selects the New
menu option.

Required to Indicates that a Key Date must occur before the Contract status can be
Activate changed from Pending to Active (e.g., Letting Date, Award Date,
Execntion Nate). A Kev Date can not be hoth Reanired to Activate and

4-10 August 2005



Trnseport SiteManager®
Reference Tables (Contract Administration) Contract Administration - Reference Tables

Field Name Description

Execution Date). A Key Date can not be both Required to Activate and
Required to Finalize.

Distribution List | Group to be notified when the actual date of the Key Date event is
entered. The user can search this field. After valid entry of a
Distribution List, the Recipient User ID field is protected.

Required to Indicates that a Key Date is part of the Contract finalization process. A
Finalize Key Date can not be both Required to Activate and Required to
finalize.

Recipient User | Person to be notified when the actual date of the Key Date event is
ID entered. The user can search this field. After valid entry of a Recipient,
the Distribution List field is protected.

Fed/State/Prov Indicates that this date is for Federal Contracts, State/Province
Ind Contracts, or for both types of Contracts. This is a required field.

Message Text Standard message to be sent to the recipient(s).

Table 4-6 The Default Key Date Window Fields Table
To add a default Key Date type to the window:
1. On the Reference Tables (CA) panel, double-click the Default Key Dates icon.
2. Click the New button. An empty row is added to the list.

3. In the Key Date Type drop-down list, click the expand arrow and click a Key Date Type on the list of
available Key Date Types.

4. In the Fed/State Prov Ind field, select one of the radio buttons.

5. Click the Save button.

4.2.5 Default Checklist Events

The Default Checklist Events window lets the user add, modify, and delete the default Checklist Events. The
Checklist Event types are defined by the transportation agency in the system code tables. On the Default
Checklist Events window, the user can add pre-defined Checklist Event types to the default list. The user can
find, filter, and sort the list, and modify the Checklist Event settings. SiteManager adds the default Checklist
Events automatically to each new Contract.
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Tip:

4-12

The main purpose of a Checklist Event is to schedule an event that occurs more than once or at
regular intervals, and to notify personnel when a date arrives and an action (e.g., approval) has not occurred.

5 Default Checklist Events [ [O]x]

Bonding Verified Uzer Defined Federal

Final Inspection Completed | User Defined State/Pravince M M

Fed/State/ | Hequired Doc Type Discrepancy | Required =
Prov Ind Indicator | to Activate

Event Type Event Group Type

DBE Commitment Yerified User Defined M M

ol o

Event Type: |Bonding Verified Fed/State/Pro¥ Ind: [ {* Federal
Event Group Type: [User Defined [=] ((: g:ja‘:.eIvaince
Required Doc Type: [Spaces [=] [~ Extemal Indicator
Freq Type: [Monthly (=] [T Required to Activate
Event Day: IT [~ Discrepancy Indicator
Distribution Lisl:l Recipi User ID: f=nduserl

Message Text: |

Figure 4-7 The Default Checklist Events Window

Field Name Description

Event Type The Event Types are the names given by the transportation agency to
the Checklist Events that occur throughout the life of the Contract (e.g.,
Bonding Verified, DBE Commitment Verified, Final Inspection
Completed). The Event Type is a required field and must be unique.
This field is protected unless the user selects the New menu option.

Event Group Grouping of associated event types (e.g., EEO, Training, and

Type Certification). This is a required field.

Frequency Type | For repetitive events, the frequency with which they occur (i.e., Daily,

Weekly, Biweekly, Monthly, Quarterly, Semi-Annually, Annually, and
One Time Only). This is a required field. If the user selects One Time
Only, the user can also select Required to Activate.

Event Day

The day of the week or month that the event is to occur. For weekly and
bi-weekly events, enter the day of the week (01-07). For monthly
events, enter the day of the month (01-30). This field is protected for all
other frequency types.
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Field Name Description

Required Doc Transportation agency-defined codes identifying each type of document

Type (e.g., Trainee report, EEO report, and Material Certification). This field
is required when the External Indicator is checked (ON).

Required to Indicates that an event must occur before the Contract status can be

Activate changed from Pending to Active (e.g., ‘DBE commitment verified').

Discrepancy Ind

Indicates that if an event has not occurred before estimate generation, it
will be reported as a discrepancy.

Distribution List | Group to be notified when the event’s projected date expires before the
actual date is entered. The user can search this field. After valid entry of
a Distribution List, the Recipient User ID field is protected.

External Indicates that a document is due to be received from an external source.

Indicator

Recipient User
ID

Person to be notified when the event’s projected date expires before the
actual date is entered. The user can search this field. After valid entry of
a Recipient, the Distribution List field is protected.

Fed/State/Prov
Ind

Indicates that the checklist event is for a Federal Contract,
State/Province Contract, or Both. This is a required field.

Message Text

Standard message to be sent to the recipient(s).

Table 4-7 The Default Checklist Event Window Fields Table

To add a Checklist Event to this window:

L.
2.

On the Reference Tables (CA) panel, double-click the Default Checklist Events icon.

Click the New button. An empty row is added to the list.

In the Event Type drop-down list, click the expand arrow and click an Event Type on the list of

available Event Types.

In the Fed/State Prov Ind field, click a radio button.

Press the Tab key.
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6. In the Event Group Type drop-down list, click the expand arrow and click an Event Group Type on
the list of available types.

7. Press the Tab key.

8. To require the receipt of an external document, in the Required Doc Type drop-down list, click the
expand arrow and click the document type.

9. Press the Tab key.

10. To require the receipt of an external document, click the External Indicator check box (ON).

11. Press the Tab key.

12. In the Frequency Type drop-down list, click the expand arrow and click the frequency of the event.

13. If the Frequency Type is Weekly, Bi-weekly, or Monthly, tab to the Event Day field and type a
number representing the day of the time period on which the event is to occur (e.g., type 3 to
represent the third day of each month).

14. If the Frequency Type is One Time Only, tab to the Required to Activate check box. If desired, click
the check box (ON).

15. Press the Tab key.

16. To require a discrepancy notification, click the Discrepancy Ind check box (ON).

17. To select a recipient or recipients, tab to either the Distribution List field or the Recipient ID field and
type the entry, or click the right mouse button and perform a Search.

18. Click the Save button.

4.2.6 Funding Sources

The Funding Sources window lets the user add, modify, and delete standard funding sources. The user can
view but not modify funding sources loaded from the Pre-construction system. After a funding source is
entered on the Funding Sources window, the user can add the funding source to a Contract by selecting it on
the appropriate SiteManager panels (e.g., Contract Funding).

4-14
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5 Funding Sources [ [3] x|
Funding Source List
Funding Src Cd Description Participation Pct ;.
%503 CONVERSION STATE FUNDING 0
FO30 EMERGENCY RELIEF FUNDS 100,00
MOD ENGLIS(STANDARD) TEST 0
FO30 FHWwA (D10) FUNDS 7587 N |
F146 FHw A [075) FUNDS 7E.87
F100 FHwA (D51] FUNDS 50.00
F144 FHwA (D85) FUNDS 50.00
Fi48 FHWA [138] FUNDS 90.00

M|

Funding Source Detail

Funding Source Code: [FO03 Funding Source Desc: FDVANCE COMSTRUCTION INTERSTATE FUR
[¥' Fed Aid Funding Indicator Accounting Fund Code: IDEIB [V Preconstruction Indicator
Participation Percent: IQD.DU Fund Prefix: I[AC][I] Funding Group: [FH'w?

Figure 4-8 The Funding Source Window

Field Name Description

Funding Source Code Identifies a source of funding (e.g., Federal grant, Federal fuel
tax, State general fund). This is a required field. This field can
not be modified after the funding source is saved.

Description Name or description of a funding source.
Fed Aid Funding Indicates whether or not this fund contains federal aid dollars.
Indicator

Accounting Fund Code | A code assigned to a fund by the transportation agency’s
accounting department. This field can not be modified after
the funding source is saved.

Pre-Construction Ind Indicator to show that the data is from the Pre-construction
system and can not be modified.

Source Participation The percentage of this fund paid by federal aid. This field is
Percent required if the Federal Aid Funding Indicator is checked (ON).
Fund Prefix An alternate identification code for a fund.

August 2005
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Field Name Description
Funding Group Allows several funds to be associated with the same group
code.

Table 4-8 The Funding Source Window Fields Table

To add a funding source to the reference table:

1.
2.

10.
11.

12.
13.
14.
15.
16.

On the Reference Tables (CA) panel, double-click the Funding Source icon.
Click the New button.

In the Funding Source Code ficld, type the source of funding (e.g., Federal grant, Federal fuel tax,
State general fund).

Press the Tab key.

In the Description field, type a name or description of the funding source.

Press the Tab key.

If the funding includes federal aid money, click the Fed Aid Funding Indicator check box (ON).
Press the Tab key.

Click the Accounting Fund Code field and type the code assigned to the fund.

Press the Tab key.

If the funding includes federal aid money, in the Participation Percent field, type the percentage of
this fund paid by federal aid.

Press the Tab key.

In the Fund Prefix field, type the fund prefix.

Press the Tab key.

In the Funding Group field, type the funding group.

Click the Save button.

To delete a funding source from the reference table:

1.
2.
3.
4.

4-16

On the Reference Tables (CA) panel, double-click the Funding Source icon.
In the Funding Source list box, scroll to and click the funding source.
Click the Delete button.

Click Ok.
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Tip:  If the funding source is loaded from the Pre-construction system, the data can not be modified or
deleted in SiteManager.

4.2.7 Item Master

The Item Master window lets the user view the standard Item list. An interface load process adds the Items
from the Pre-construction system to this list. The user can not add, modify, or delete Item Master data. The
default sorting order of the list is by Item Code first, then Spec Year, and then Unit. The user can find, filter,
and sort any column on the list. The selected Item’s Historical Price is displayed only if the user has the
authority to view this data. The user can add a standard Item to a Contract by selecting the Item on the
appropriate SiteManager window (e.g., the Items window).

Eitembaster. | [ || | [ =l
Item Code Short Description
TOTAL ESTIME
00015 1334 EQUIPMENT TOTAL ESTIME
00020 1934 MATERIALS TOTAL ESTIME
00037-11570 1394 DEMOBILIZATION & REMOBILIZATION EACH E
00033-16568 1334 DEMOEILIZE-REMOBILIZE (STOP WORK REQL) LUMP SUM  |E
00033-15564 1394 ADDITIONAL MOBILIZATON LUMP SUM  |E
00100 1334 MOBILIZATION LUMP SUM  |E
=
Alternate ID: [00010 Spec Book Reference:
Description: |LABEIF|
: [
'_ Material Item '_ DObsolete ltem '7 Major Item '— Suppl Desc Req'd
Item Historical Price: [$.00000 Fuel Adjust Type: I
Figure 4-9 The Item Master Window
Field Name Description
Item Code Transportation agency-defined code that identifies an Item.
Spec Year The year of the specification book in which the Item appears.
Unit The unit of measure for this Item.
Unit Type Indicates that the measurement system used is English (E) or
Metric (M).
Short Description Short text description of the Item.
Alternate ID Alternate ID of an Item.
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Field Name Description
Spec Book Reference Identifies an Item-specific section or paragraph from the

transportation agency’s spec book.

Description Text description of an Item. Two lines are provided.

Material Item Indicator | Indicates that materials are associated with the Item.

Obsolete Item Indicator | Indicates that this Item is obsolete and no longer used.

Major Item Indicator Indicates that an Item is important enough to be printed on the
notice to Contractors, regardless of the dollar amount allocated
to it.

Require Supplemental When checked, indicates that a supplemental description must

Description Indicator be entered for an item being added to a project
Fuel Adjust Type Fuel price adjustment type to use for this Item.
Item Historical Price Historical price of an Item.

Table 4-9 The Item Master Window Fields Table
To view reference table Item data:
1. On the Reference Tables (CA) panel, double-click the Item Master icon.

2. In the Item list box, scroll to and click the Item or perform a Find. The window displays data for the
selected Item.

4.2.8 Vendors

The Vendors window lets the user add, modify, and delete Vendors and related data in the reference table.
The Vendors are the material suppliers, contractors, financial institutions, insurance companies, consultants,
and others who provide goods and services to the transportation agency. Typically, an interface load process
adds the Vendors from the Pre-construction system to SiteManager. The user cannot modify or delete Vendor
data loaded from the Pre-construction system. The user can add Vendor data to a Contract by selecting it on
the appropriate window (e.g., the Contract Prime Contractor folder tab). The Vendors window contains the
following folder tabs:
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Tab Name Description
Description The Description folder tab displays the Vendor description. The

Vendor addresses and remarks can be accessed from this folder tab.

Work Classes The Work Classes folder tab displays the Vendor’s work classes and
the qualification amount for each type.

Affiliates The Affiliates folder tab displays the Vendor’s Affiliates (i.e., the
other Vendors affiliated with this Vendor) and their relationship.
The Affiliate addresses can also be accessed from this folder tab.

Personnel The Personnel folder tab displays the Vendor’s personnel. The
Vendor personnel addresses can also be accessed from this folder
tab. If the Vendor is a Prime Contractor, the personnel entered here
can be selected as Prime Contacts for specific Contracts on the
Contract Prime Contractor folder tab.

Prime Contacts | The Prime Contacts folder tab displays the Vendor’s personnel who
have been selected as the Prime Contacts for specific Contracts.

Associates The Associates folder tab displays the Vendor’s Associates (i.e., the
other Vendors associated with this Vendor) and the role of the
Associate. If the Vendor is a Prime Contractor, the Vendor’s
insurance company and surety company must be entered here before
they can be selected for specific Contracts on the Prime Contractor

folder tab.
Security The Security Accounts folder tab has a security accounts section and
Accounts a security transaction section. The security accounts section displays

the Vendor’s security accounts; the security transaction section
displays a history of transactions made against the selected account
at the financial institution.

Securities On the Securities Usage folder tab, the user can associate the

Usage Vendor’s security accounts to specific Contracts for use in lieu of
retainage. After a Contract is selected, the current retainage
percentage and other Contract amounts are calculated by the system
and displayed on this folder tab.

Table 4-10 The Vendor Window Folder Tabs Table
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The Vendor Description folder tab lets the user add and modify the Vendor descriptions and addresses. The
user can view but not modify Vendor data loaded from the Pre-construction system. The Vendor remarks can
also be accessed from this folder tab. The Ethnic Group and Gender fields are displayed only if the user is
authorized to see this data. The Ethnic Group and Gender data is required for federal reports when the Vendor

is a DBE.
ﬂVendols !E m
Description ‘Work Classes Affiliates Personnel Prime Agzociates Security Securities
Contacts Accounts Usage
VYendor ID: IRS Tax Nbl:l
Short Name: |
Full Name: |
Vendor Type: | [z] Al ¥endor ID:I
DBE Type: |Spaces E Cert Type: |Spaces E
Cert Date: |00./00/00 Cert End Date: |EID!EID!DEI
Corp Type: [Spaces [=] Corp State: | =l
Prequal Date: [00/00/00 Prequal End Date: IDU)‘DU.»"UIJ
Uncompleted Work Amount: | 0.00 [ Preconstruction Indicator
Ethnic Group: |Spaces Eender:l
Figure 4-10 The Vendor Description Folder Tab

Field Name Description

Vendor ID Transportation agency-defined ID for the Vendor.
Usually the company's Federal Tax ID.

IRS Tax Nbr Federal Employer tax ID number.

Short Name Short name for the Vendor.

Full Name Full name of the Vendor.

Vendor Type Identifies which type of company the Vendor is (e.g.,
Prime, Subcontractor, Sub-Subcontractor). This is a
required field.

4-20
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Field Name Description

DBE Type Transportation-agency defined code to indicate that the
Vendor has certification as a Disadvantaged Business
Enterprise (DBE). Examples are DBE, MBE, and WBE.
‘Not a DBE’ is also a valid DBE Type.

Corp Type Identifies the Vendor’s company type (e.g., private
corporation, public corporation, partnership).

Corp State Identifies the Vendor’s state or province of incorporation.

Cert Type Code indicating whether the DBE is certified by the
federal government, state/provincial government, or both.
If the Vendor is a DBE, this field is required.

Cert Date For DBEs, the DBE certification date. If the Vendor is a
DBE, this field is required.

Cert End Date The date on which the Vendor’s DBE certification
expires.

Prequal Date For transportation agencies that pre-qualify Contractors,
the date on which the Vendor was pre-qualified.

Prequal End Date The date on which the Vendor‘s pre-qualification expires.

Uncompleted Work Displays the uncompleted work amount for this Vendor.

Amount The uncompleted work amount is the sum of the

Vendor’s current Prime Contractor and Subcontract
amounts minus the Vendor’s installed-to-date amounts.

Preconstruction Ind

Indicates whether or not the data is from a Pre-
construction system.

Ethnic Group

Transportation agency-defined code identifying the
Vendor’s certified ethnic background (e.g., Black
American, Hispanic American, Native American). The
Ethnic Group field is only displayed if the user is
authorized to see this data.

August 2005
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Field Name Description
Gender Indicates the Vendor’s certified gender (i.e., Male or
Female). The Gender field is only displayed if the user is
authorized to see this data.

Table 4-11 The Vendor Description Folder Tab Fields Table

To view a Vendor description:

1.
2.

On the Reference Tables (CA) panel, double-click the Vendors icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
To access the Vendor’s address, click the Services menu and click the Address choice.

In the Address Type list box, scroll to and click the address type. If the address type has multiple
addresses, use the Prior and Next toolbar buttons to access all addresses.

To add a new Vendor:

10.
1.

12.

13.

4-22

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the New button.

In the Vendor ID field, type the Vendor’s ID.

Press the Tab key.

In the IRS Tax Nbr field, type the IRS tax number.

Press the Tab key.

In the Short Name field, type the short name of the Vendor.

Press the Tab key.

In the Full Name field, type the full name of the Vendor.

In the Vendor Type drop-down list, click the expand arrow and click the vendor type.

If the Vendor is a DBE, in the DBE Type drop-down list, click the expand arrow and click the DBE
type.

If the Vendor is a DBE, in the Cert Type drop-down list, click the expand arrow and click the
certification type.

Press the Tab key.
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14.
15.
16.
17.
18.

19.
20.
21.
22.
23.
24.
25.
26.
27.

28.
29.
30.
31.
32.
33.
34.
35.

36.
37.
38.

If the Vendor is a DBE, in the Cert Date field, type the DBE certification date.

Press the Tab key.

If the Vendor is a DBE, in the Cert End Date ficld, type the DBE certification expiration date.

In the Corp Type drop-down list, click the expand arrow and click the Vendor’s corporation type.

In the Corp State drop-down list, click the expand arrow and click the Vendor’s state or province of
incorporation.

Press the Tab key.

In the Prequal Date ficld, type the date on which the Vendor was pre-qualified.

Press the Tab key.

In the Prequal End Date field, type the date on which the Vendor’s pre-qualified status expires.
In the Ethnic Group drop-down list, click the expand arrow and click the Vendor’s ethnic group.
In the Gender drop-down list, click the expand arrow and click the Vendor’s gender.

To enter the Vendor’s address, click the Services menu and click the Address choice.

In the Address Type list box, scroll to and click the address type.

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

Press the Tab key.

In the City field, type the Vendor’s city location.

In the State/Prov drop-down list, click the expand arrow and click the Vendor’s state or province.
Press the Tab key.

In the Zip/Postal field, type the Vendor’s zip code or other postal code.

In the Country drop-down list, click the expand arrow and click the Vendor’s country location.
Press the Tab key.

Type the Vendor’s primary phone number. If necessary, tab to the ext field and type the phone
number extension.

Press the Tab key.
In the FAX field, type the Vendor’s FAX number.

To add another address of the same type, click the New button and repeat Steps 27 through 37.
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39. To add another address type, repeat Steps 26 through 37.
40. To close the Address box, click the Description folder tab.
41. To save the new Vendor description, click the Save button.

Tip:  To be selected as a Prime Contractor, a Vendor must have a Payment Address.

4.2.8.2 Address Function

In SiteManager, users can enter many types of addresses depending on the functional area. For example, a
vendor can have shipping address, billing address, a field address, etc. A common interface has been
developed to provide the same address functionality across the system.

The Address functionality has been implemented in two ways:

1. Access to the address through Address option under Services menu or an Address button on the main
toolbar. Clicking the Address button or selecting Services/Address causes a pop up address window to
appear.

2. The address information appears directly on the currently-selected window. This occurs when the window
has enough space to accommodate the address. The Address window in Administrative Offices is an example
of this type.

If a window does not allow address entry through the pop-up window, the Services/Address menu option and
the Address button will not be available. In some cases, the Address button may appear in the toolbar, but it
does not function. It beeps. The Services/Address menu option will appear grayed and will not function when
address entry is not allowed.

When the address pops up, initially it displays the address for the first address type if address already exists.
Payment Address is the default address-type. If the vendor, trainee, etc. has multiple address types, a list of
available address types and an icon adjacent to each type indicating an address exists for that type is
displayed. If a new address is to be entered, the Address entry area is empty and the user must click the new
button.

The Address Pop-up

The Address pop-up window is divided in two parts. First part, Types, displays a list of available address
types. If a Check Mark i appears next to the address type, an address for that type has been entered.
Whenever user selects a type (by clicking it), the corresponding address is displayed in the Address part of the
window and the cursor is placed there. Each address type can have multiple addresses. For example, a
vendor could have many Field Trailer type addresses. Users can see that multiple addresses are listed because
the Address part of the window shows how many pages (addresses) are listed, i.e., 1 of 4. When the address
pop-up appears, up and down arrows are present on the toolbar. The arrows are used to move through the list
of addresses for a type.

Create an Address one time - Associate it thereafter

A new address is created one time only. Thereafter, the address is associated to the window by selecting it
from the appropriate picklist. For example, a new vendor is created in the Contract Admin. Reference tables,
Vendor window. In the Contracts, Prime Contractor tab, the Current Prime:, Prime Contracts:, and Prime
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Associates: ficlds are completed by searching, selecting and associating the address to the field. The
addresses for these fields are created in the Vendor window tabs, not in the Contracts window tabs.

An address is maintained, modified or deleted in the window where the address was created. An address may
not be deleted if it is associated to any contract. Clicking the Delete button deletes the address for the selected
Address type. The association of the address takes place in any window where the address capability exists.
As in the preceding example, the address is created, maintained or deleted in the Vendor tabs, but is
associated in the Contracts, Prime Contractor tab.

If an address pop-up window appears with the address fields grayed, the address originated in a pre-
construction contract and cannot be modified or deleted.

An address may be maintained without ever being associated. For example, the address and telephone
numbers for an EEO officer may never be associated.

A new, modified or deleted address is saved on window where the address was opened. The address is
automatically saved when the origination window is saved. Save is performed on the window, not on the
address object.

The Address function is available or displayed in the following components of SiteManager:
Contract Administration, Reference Tables, Vendors icon folder tabs:
Description -  Create, modify or delete
Personnel - Create, modify or delete
Affiliates - Display only
Associates - Display only
Affiliates and Associates are Vendors. Select the Vendors ID to add, modify or delete an Address for them.
Prime Contact - Display only - associated in the Prime Contact tab
Civil Rights, Contract Compliance, Trainees icon
Materials Management, Approved Lists icon
Inspectors
Welders
Producer/Supplier
Qualified Labs
Testing Personnel

The address function works consistently across the system. Although the following figures and procedures
relate specifically to Vendors, the methodology applies across the system.
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e T e e o e —
Description Location Payment Data  Ciitical Dates Primary Prime DEE Commit — Training Plan
o L Contrack

[P Tl G v Address For: [EREENBANK SERVICES COMPENY, INC
BILLING ADDRESS BILLING ADDRESS 1 -of 1

FIELD TRAILER ADDR Line 1: [4507 DAKLAWN BLVD.
PREQUALIFICATION A Line 2: [ 1 Paid

STREETADDRESS OR .| | ||jne3 |

City: IHEIPEW'ELL
State/Prov: [v& Z|
Zip/Postal: |23BED-UDDU

Pri Country: |United States of America

T

—Contact Numbers
Phone: [304-453-8538 Ext: |

P FAX:

FLANTEFD BANK THUS 1 LU, TN
NEWBERG MARBLE HILL

Figure 4-11 The Address Pop-Up Window

Field Name Description

Types This is a list of available address types. Users can select only
one type at a time.

Address This is the actual address for the selected type.
One field of Line 1, 2, or 3 is a required field.

City, State or Province: and Zip/Postal: are required fields.
Messages will appear to complete required fields on the
Address pop-up when the user saves the window.

Table 4-12 The Vendor Description Folder Tab Fields Table
To create an address for a new vendor:
1. On the main panel, double-click the Contract Administration icon.
2. On the Contract Administration icon, double-click the Reference Tables icon.
3. On the Reference Tables panel, double-click the Vendors icon.
4. Select the Description folder tab.
5. Click the New button.

6. Inthe Address Type list box, scroll to and click the address type.
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7. Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

8. Press the Tab key.

9. In the City field, type the Vendor’s city location.

10. In the State/Prov drop-down list, click the expand arrow and click the Vendor’s state or province.
11. Press the Tab key.

12. In the Zip/Postal ficld, type the Vendor’s zip code or other postal code.

13. In the Country drop-down list, click the expand arrow and click the Vendor’s country location.
14. Press the Tab key.

15. Type the Vendor’s primary phone number. If necessary, tab to the ext field and type the phone
number extension.

16. Press the Tab key.

17. In the FAX field, type the Vendor’s FAX number.

18. To add another address of the same type, click the New button and repeat Steps 6 through 17.
Or,

19. To add another address type, repeat Steps 6 through 17.

20. To close the Address box, click the Address button or just outside the Address pop-up.

21. To save the new Vendor description and Address, click the Save button.

5 Vendors M=l 5
Description "Work Classes ~ Affilates | Pesonnel  Prime  Associates | Secuity  Secuities |
Contacts Accounts Uszage
Vendor ID:4 IRS Tax Nbe:|
Short Name: |
Full Name: |
Vendor Type: | [x] AltVendor ID: I—
DBE Type: [Spaces =] Cert Type: [Spaces =]
Cert Date: lm Cert End Date: Im
Corp Type: [Spaces =l Corp State: | =l
Prequal Date: lm Prequal End Date: Im
Uncompleted Work Amount: I—DDD [T Preconstruction Indicator
Ethnic Group: ISpaces Gender: I—

Figure 4-12 The Vendor Window and Folder Tabs
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Addresses for Vendors Personnel, are created using the procedures for creating a new address in the
Description tab. Affiliates, Prime Contacts, and Associates folder tabs are display only.

The same procedures apply in Trainees, Materials Approved Lists.

To modify an address:

1.
2.

7.
8.

Navigate to the window where the address was created.

Click the Open button and select a vendor from the picklist.

Click OK

Click the Address button or the Services/Address choice.

Select the desired Address type.

Type the new information.

Click the Address button or click outside the pop-up to close the pop-up.

Save the window.

The same procedures apply in Trainees and Materials Approved Lists.

To delete an address not associated to a contract

L.
2.

7.
8.

Navigate to the window where the address was created.
Click the Open button and select a vendor.

Click OK

Click the Address button or the Services/Address choice.

Select the desired Address type (use the up and down arrows on the toolbar to move through multiple
addresses for a type.)

Click the Delete button.
Click the Address button or click just outside the pop-up to close it.

Save the window.

The same procedures apply in Trainees and Materials Approved Lists.

To associate an address to a Contract:

1.
2.
3.
4.
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On the main panel, double-click the Contract Administration icon.
On the Contract Administration icon, double-click the Contract Records icon.
On the Contract Records panel, double-click the Contract icon.

On the Contracts window, select the Description folder tab.
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5. On the Description folder tab, click the Open button and select the desired contract.
6. Double-click the highlighted contract or click Ok.

7. Select the Prime Contractor folder tab.

8. Click on the Prime Contractor field to focus.

9. Associate a new Vendor’s address by clicking the New button and selecting a vendor from the
picklist,

Or

10. Change the existing vendor by clicking the Open button and selecting a different Vendor from the
picklist.

11. Click Ok on the Vendor picklist.
12. On the Prime Contractor folder tab, click the Services menu and choose the Select Address choice.
13. Click the Address button or click just outside the pop-up to close it.
14. Save the window.
The same procedures apply in Trainees and Materials Approved Lists.

If an incorrect address is associated to a contract, the address is replaced with the correct address. The
incorrect address is not deleted, but is replaced using the procedures for associating an address with a
contract. SiteManager recognizes the most current association.

4.2.8.3 Vendor Work Classes

The Vendor Work Classes folder tab lets the user add, modify, and delete the Work Class type and
qualification amount for the selected Vendor. If the Vendor was loaded from the Pre-construction system, the
user can view but not modify the data on this folder tab.
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ﬂVendurs _[O] x|
Description Work Alffiliates Personnel Frime Agsociates Security Securities
Classes Contacts Accounts Usage

VYendor ID: |G022

Short Name: [GREENEANK SERVICES COMPANY, INCORPORATE

L

Workclass Type Qualification Amount o
GEMERAL HIGHWAY CONSTRUCTION ﬂ

.

Figure 4-13 The Vendor Work Classes Folder Tab

Field Name

Description

Workclass Type

Code that identifies the major type of work class for a Vendor
(e.g., Roadway Construction, Bridge Construction, Utilities).

Qualification Amt

Amount specified for the major type of work for which the
Vendor is qualified.

Table 4-13 The Vendor Work Class Folder Tab Fields Table
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To add a Vendor Work Class to the reference table:
1. On the Reference Tables (CA) panel, double-click the Vendor icon.
2. Click the Open button.
3. On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
4. Click the OK button. The Description folder tab displays data for the selected Vendor.
5. On the Vendors window, click the Work Class folder tab.
6. Click the New button.

7. In the Work Class Type drop-down list, click the expand arrow and click the Vendor’s work class
type.

8. Press the Tab key.

9. In the Qualification Amt field, type the Vendor’s qualification amount.

10. Click the Save button.
Tip: Ifthe Vendor is from a Pre-construction system, both the Work Class Type and the Qualification
Amount fields are protected, and no work classes can be added.
4.2.8.4 Vendor Affiliates

The Vendor Affiliates folder tab lets the user add, modify, and delete the Affiliates for a selected Vendor. The
Affiliates are also Vendors and must be entered in SiteManager as Vendors before they can be selected as
Affiliates. On the Vendor Affiliates folder tab, the user specifies the Affiliate’s relationship to the Vendor. For
example, a ‘Joint Venture’ Contract must have a Prime Contractor with a ‘Joint’ Affiliate. If the Vendor was
loaded from the Pre-construction system, the user can view but not modify the data on this folder tab.

August 2005 4-31



Trnseport SiteManager®

Contract Administration - Reference Tables Reference Tables (Contract Administration)
E\Fendms _ (O] x|
Description  ‘Work Classes  Affiliates Personnel Prime: Associates Security Securities
Contacts Accounts Usage
Yendor ID: |DL333 Short Name: [LBX General Contractors
Affiliate Short Name Relationship Type Ownership % il
| [+ .00

Figure 4-14 The Vendor Affiliates Folder Tab

Field Name Description

Affiliate Short Name Abbreviated name of the Vendor. The user can search
this field. This field is required.

Relationship Type Type of Affiliate (e.g., parent, joint, partner). This field
is required.

Ownership % The Vendor's percentage of ownership of the Affiliate.
This field is required.

Table 4-14 The Vendor Affiliates Folder Tab Fields Table
To add a new Vendor Affiliate to the reference table:
1. On the Reference Tables (CA) panel, double-click the Vendor icon.
2. Click the Open button.
3. On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
4. Click the OK button. The Description folder tab displays data for the selected Vendor.
5. On the Vendors window, click the Affiliates folder tab.
6. Click the New button.

7. In the Affiliate Short Name field, type the short name of the Vendor’s Affiliate or perform a Search.
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8. In the Relationship Type drop-down list, click the expand arrow and click the relationship of the
Affiliate to the Vendor.

9. Press the Tab key.
10. In the Ownership % field, type the Vendor’s percentage of ownership of the Affiliate.
11. Click the Save button.

Tip: If the Vendor is from a Pre-construction system, all the fields are protected and no Affiliates can be
added.

4.2.8.5 Vendor Personnel

The Vendor Personnel folder tab lets the user add and modify personnel records for the selected Vendor. The
user can also add and modify Vendor addresses. This folder tab is primarily used to enter the contact person
and DBE-related personnel for the Vendor, especially Vendors who are Prime Contractors. The folder tab
displays the Vendor personnel list and data for the person selected on the list. The Social Security Number
(SSN) or Social Insurance Number (SIN), Ethnic Group, and Gender fields are displayed only if the user is
authorized to see this data.

ﬂ\/endms M=l

Description Work Classes Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage

Vendor ID: |DL333 Short Name:  [LB¥ General Contractors

Person Name Dfficer Title

Christing Morriz PRESIDEMNT

ot o

Person Name: |Chrislina arris User ID:I
Officer Title: [FRESIDENT [=] SSN: Do0-00-0000
Ethnic Group: ICaucasian |ﬂ Gender: "} +F

Figure 4-15 The Vendor Personnel Folder Tab
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Field Name Description
User ID Transportation agency-defined ID for the user. The user can

search this field.

Personnel Name The name of a person employed by the Vendor. When a valid
User ID is entered, this field defaults to the name associated with
the User ID and can not be modified. The name must be unique
for the Vendor. This is a required field.

Officer Title Transportation agency-defined code that identifies the title of the
Vendor’s employee (e.g., Owner).

SSN/SIN Social Security Number or Social Insurance Number of the
Vendor’s employee. This field is displayed only if the user is
authorized to see this data.

Ethnic Group Transportation agency-defined code identifying an ethnic
background (e.g., Black American, Hispanic American, Native
American). This field is required when the Vendor is a DBE
(i.e., a DBE Type is entered on the Vendor Description folder
tab). The Ethnic Group field is displayed only if the user is
authorized to see this data.

Gender Indicates the gender of the person employed by the Vendor (i.e.,
Male or Female). This field is required when the Vendor is a
DBE (i.e., a DBE Type is entered on the Vendor Description
folder tab). The Gender field is displayed only if the user is
authorized to see this data.

Table 4-15 The Vendor Personnel Folder Tab Fields Table
To add Vendor Personnel to the reference table:
1. On the Reference Tables (CA) panel, double-click the Vendor icon.
2. Click the Open button.
3. On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
4. Click the OK button. The Description folder tab displays data for the selected Vendor.

5. On the Vendors window, click the Personnel folder tab.
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10.
1.
12.
13.

14.

15.
16.
17.
18.
19.
20.
21.
22.

23.
24.
25.
26.

Tip:

Click the Person Name ficld and type the person’s name.

In the Officer Title drop-down list, click the expand arrow and click the title.

Press the Tab key.

In the SSN field, type the person’s social security number.

In the Ethnic Group drop-down list, click the expand arrow and click the ethnic group.
To select a Gender, click the ‘M’ or ‘F’ radio button.

To enter the Vendor’s address, click the Services menu and click the Address choice.

In the Address Type list box, scroll to and click the address type. If an address is displayed, click the
New button to add another address of the same type.

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

Press the Tab key.

In the City field, type the person’s city location.

In the State/Prov drop-down list, click the expand arrow and click the person’s state or province
Press the Tab key.

In the Zip/Postal field, type the person’s zip code or other postal code.

In the Country drop-down list, click the expand arrow and click the person’s country location.
Press the Tab key.

In the Phone field, type the person’s primary phone number. If necessary, tab to the ext field and type
the phone number extension.

Press the Tab key.

In the FAX field, type the person’s FAX number.

To close the Address box, click the Personnel folder tab.

To save the new personnel description, click the Save button.

To be selected as a contact person for a Vendor who is a Prime Contractor, the person must have a

title and an address entered.
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To delete Vendor Personnel from the reference table:
1. On the Reference Tables (CA) panel, double-click the Vendor icon.
2. Click the Open button.
3. On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
4. Click the OK button. The Description folder tab displays data for the selected Vendor.
5. On the Vendors window, click the Personnel folder tab.
6. In the Personnel list box, scroll to and click the person.
7. Click the Delete button.

8. Click Ok.

4.2.8.6 Vendor Prime Contacts

The Vendor Prime Contacts folder tab lets the user view the Vendor’s personnel who have been selected as
Prime Contacts. A Prime Contact is a Prime Contractor’s contact person for a specific Contract. The Prime
Contacts folder tab displays the name and contact type of the person, and the Contract ID for which the
person is a contact. The user cannot add, modify, or delete a Prime Contact on this folder tab. To add a Prime
Contact, the user must first enter the name as personnel on the Vendor Personnel folder tab. Then the user can
select the name as a Prime Contact for a specific Contract. This is done on the Contract Prime Contractor
folder tab.

5 Vendors M= E3
Description  ‘Work Classes Affiliates Personnel Prime Azzociates Security Securities
Contacts Accounts Usage
Vendor ID: [S018 Short Name:  [SHIRLE'Y CONTRACTING CORF.
Contact Name Contract ID Contact Type User ID -

9303195 TEPL
Kirk. Clark. SITEMGR_18 EEO

L .0

Figure 4-16 The Vendor Prime Contacts Folder Tab
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Field Name Description
Contact Name Name of the person who is a contact for this Vendor.
Contact Type Title of the person who is a contact for this Vendor (e.g.,
EEO).
Contract ID Transportation agency-defined ID of the Contract for which
this person is a contact.
User ID Transportation agency-defined ID of the user who is a
contact for this Vendor.

Table 4-16 The Vendor Prime Contact Folder Tab Fields Table

To view a Vendor’s Prime Contacts:

L.
2.

Tip:

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Prime Contacts folder tab.

If Prime Contacts have been recorded for the selected Vendor, the window displays the Prime Contact
data.

The user cannot add, modify, or delete a Prime Contact on this folder tab.

4.2.8.7 Vendor Associates

The Vendor Associates folder tab lets the user add, modify, and delete the Associates in the reference table.
The Associates are also Vendors and must be entered in SiteManager as Vendors before they can be selected
as Associates. On the Vendor Associates folder tab, the user selects the type of association the Associate has
with the Vendor.

Tip:

To be selected as a Prime Contractor, a Vendor must have at least two Associates—an insurance

company and a surety company.
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VYendor ID: 125 Short Name: [J &K CONSTRUCTION

Associate Short Name Associate Type *I

o .0

Figure 4-17 The Vendor Associates Folder Tab

Field Name Description

Associate Short Name | Short name for an Associate of the Vendor. The user
can search this field. This field is required.

Associate Type Type of Vendor Associate (e.g., Surety, Escrow). This
field is required.

Table 4-17 The Vendor Associates Folder Tab Fields Table
To add a Vendor Associate to the reference table:
1. On the Reference Tables (CA) panel, double-click the Vendor icon.
2. Click the Open button.
3. On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
4. Click the OK button. The Description folder tab displays data for the selected Vendor.
5. On the Vendors window, click the Associates folder tab.
6. Click the New button.
7. Click the Associate Short Name field and type the name of the associate or perform a Search.
8. In the Associate Type drop-down list, click the expand arrow and click the type of associate.

9. To save the new Associate description, click the Save button.
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To delete a Vendor Associate from the reference table:

L.

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Associates folder tab.

In the Associate Short Name list box, scroll to and click the Vendor.

Click the Delete button.

Click Ok.

4.2.8.8 Vendor Security Accounts

The Vendor Security Accounts folder tab lets the user add, modify, and delete the Vendor’s security accounts
and account transactions. The folder tab has a security account list at the top and a transaction section at the
bottom. The transaction section lists the transactions made against the selected account at the financial
institution. The transactions are the amounts deposited and withdrawn, which are recorded as credits and
debits to the account.

Tip:

The usage of the securities on Contracts is shown on the Securities Usage folder tab.

ﬂ\"endols M=l B3
Description ‘Work Classes Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage
Vendor ID: 125 Short Name: [_\ & K CONSTRUCTION
Account ID Description Current Retainage Amount =
Balance Required Available
UNTRUST

Transaction

Type |Sec Type Certificate ID Amount Post Date  Maturity Dt Comments
Credit ﬂ Biond ﬂ R9432-RT-4290 $10,000.001999/04/27 1209 04/27419

Figure 4-18 The Vendor Security Accounts Folder Tab
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Field Name Description
Account ID Transportation agency-defined ID for a security account for
the Vendor.
Description Description of a security account for the Vendor.
Current Balance Current value of a security account for the Vendor. The

current balance is the sum of all credits to the account minus
the sum of all debits to the account. This value is calculated
by the system. The system will not accept account
transactions that make the Current Balance negative.

Retainage Required The amount required to be encumbered for all the Contracts
associated to this account. The required amount is the sum of
all estimate retainage amounts and securities used amounts for
all Contracts associated with this account. This value is
calculated by the system.

Amount Available Amount of the current balance that can be encumbered. The
amount available is the difference between the current balance
of the account and the total amount encumbered for all
Contracts associated to the account. This value is calculated
by the system. The system will not accept account
transactions that make the Amount Available negative.

Transaction Type Type of transaction (D = Debit or C = Credit).

Transaction Sec Type Type of security (e.g., Bond, Certificate of Deposit).

Transaction Certificate | Certificate of Deposit ID number.

ID

Transaction Amount Amount of the transaction. Only positive values are accepted
in this field. (If the amount is a withdrawal, enter ‘D’ for debit
as the Transaction Type.) A value that makes the account
negative can not be entered.

Transaction Post Date System-generated date when the transaction is entered into the

svstem.
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Field Name Description
system.
Transaction Maturity Date on which the security matures.
Date
Transaction Comments | Description of the transaction.

Table 4-18 The Security Account Folder Tab Fields Table

To add a Security Account:

1.
2.

8.
9.

Tip:

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID field, type the security account ID.

Press the Tab key.

In the Description field, type the name of the account.

Click the Save button.

The system updates the Current Balance of the account when the user records transactions. The

system calculates the Retainage Required and the Amount Available when the user associates Contracts with
the account and securities are encumbered in lieu of retainage.
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To delete a Security Account:

L.
2.

7.
8.

Tip:

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID list box, scroll to and click the account.

Click the Delete button.

Click Ok.

If a security account is associated with a Contract, the account can not be deleted. When an account is

deleted, the account transactions are also deleted.

To add a Security Transaction:

1.
2.

10.
11.
12.
13.
14.
15.
16.
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On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID list box, scroll to and click the account description.

Click the Transaction datawindow.

Click the New button.

In the Type drop-down list, click the expand arrow and click the transaction type (‘D’ for debit or ‘C’
for credit).

In the Sec Type list box, click the expand arrow and click the security type.
Press the Tab key.

In the Certificate ID ficld, type the ID number.

Press the Tab key.

In the Amount field, type the amount of the transaction.

Press the Tab key. The current date is displayed in the Post Date field.

In the Maturity Date field, type the date on which the security matures.
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17. Press the Tab key.

18. In the Comments field, type additional information about the transaction.

19. Click the Save button. The Current Balance is updated.
Tip:  The user cannot add or delete an account transaction that would cause the Current Balance or the
Amount Available to become negative.
4.2.8.9 Vendor Securities Usage

The Vendor Securities Usage folder tab lets the user associate security accounts with Contracts, and displays
the securities used in lieu of retainage. A security account can be associated to one or more Contracts, or not
associated with any Contract. The folder tab lists the accounts at the top and displays Contract data at the
bottom. In the Contracts section, the user can select Contracts to associate with an account.

Tip:  The security accounts are entered on the Security Accounts folder tab.
ﬂVendurs _[O] x|
Description  Work Classes Alffiliates Personnel Frime Agsociates Security Securities
Contacts Accounts Usage
Yendor ID: [1125 Short Name: [J &K CONSTRUCTION
Account ID Description Current Retainage Amount &
Bal Required Avnil ol

4005-23-41

SUNTRUST 10000

10000

Contract ID = RETAIN PCT: |2.50
ﬂ Contract A Securities/Retainage Amounts
Original: IW Required: l—
Installed: l— Covered: [—
Paid: l— Difference: [—EID

Figure 4-19 The Vendor Securities Usage Folder Tab

Field Name Description

Account ID Transportation agency-defined ID for a security account for a
Vendor.

Description Description of the security account.

Current Balance

Current value of the account. The current balance is the sum of
all the credits to the account minus the sum of all debits to the

August 2005
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Field Name

Description

account.

Retainage Required

The amount required to be encumbered for all the Contracts
associated to this account. The required amount is the sum of
all estimates retainage amounts and securities used amounts for
all Contracts associated with this account.

Amount Available

Amount available that can be encumbered. The amount
available is the difference of the current balance of the account
and the total amount encumbered from the amount for all the
Contracts associated to the account.

Contract ID

Transportation agency-defined ID for the Contract.

Retain Pct

Percentage retainage for the Contract.

Contract Original
Amount

Displays the bid amount of the Contract. The Contract bid
amount is the sum of the Contract Item amounts (Item quantity
* Item price).

Contract Installed
Amount

Displays the total installed amount for the Contract. The
installed amount is the sum of the installed-to-date amounts
from the Daily Work Reports (quantity * Item price).

Contract Paid Amount

Displays the total paid amount for the Contract. The Contract
paid amount is the sum of the estimate net pay totals.

Covered Amount

Displays the total amount covered by the securities for this
Contract. The covered amount is the sum of all estimates’
securities used amounts.

Required Amount

Displays the required retainage withholding from this account
for this Contract. The required amount is the sum of all
estimates’ retainage amounts and securities used amounts.

Difference Amount

Displays the difference between the covered amount and the
required amount.

Table 4-19 The Vendor Securities Usage Folder Tab Fields Table
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To associate a Contract to a Security Account:

L.
2.

8.
9.

Tip:

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Securities Usage folder tab.

In the Account ID list box, scroll to and click the account description.

Click the New button.

In the Contract ID drop-down list, click the expand arrow and click the Contract.
Click the Save button.

The drop-down list displays the Contract IDs for which the Vendor is the Prime Contractor. After a

Contract ID is selected, the window displays data for the selected Contract.

To disassociate a Contract from a Security Account:

1.
2.

4.2.9

On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected Vendor.
On the Vendors window, click the Securities Usage folder tab.

In the Account ID list box, scroll to and click the account description.

In the Contract ID drop-down list, click the expand arrow and click the Contract ID.
Click the Delete button.

Click Ok.

Administrative Offices

The Administrative Office window lets the user add, modify, and delete the offices in the reference table.
Every state or province must have at least three levels of administrative offices—the transportation agency
headquarters and two lower levels. No state or province can have less than three or more than four levels.
States or provinces with three levels will display three office datawindows. States or provinces with four
levels will display four office datawindows. The office level field labels are stored in a system operational
parameter table. Since the transportation agency defines the labels, this manual does not specify the actual
labels that appear on the window.
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The office datawindows display top to bottom on the left side of the window. The selected (highlighted or
focused) office’s address will display on the window’s right side. Upon entry into this window, the first row
in the level two office datawindow will be highlighted and the address information pertaining to that office
will be displayed on the right side datawindow.

To view the information for a different level two office or a specific level three or four office, the user must
select the desired row in the proper office datawindow. Third level offices are subordinate to the highlighted
second level office. Fourth level offices are subordinate to the third level offices.

The current selected office is listed at the top of the right side data window (above the address information).
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ﬂAdminisllalive Offices

| Central: |
Division |Engineer | « Division: 01
~Address -1 -of -1
e DCEZ Line 1: FE75 Long Drive
L DCE1 Line 2: |
L DLET ﬂ Line 3: |
District | Engineer | + City: [Calumbia
State/Prov: |South Carolina [=1
e DCET Zip/Postal: [23170
- A Country: United States of Ameri
04 DTET | +f ountiy:  [United States of America =l

—Contact Numbers

Area

2

Engineer | «

Phone: Ext: I
COM2 252

3

[DTEd

4 | COM1 d

Figure 4-20 The Administrative Offices Window

Field Name

Description

Level 1 Office
(user-defined label)

The name of the Level 1 office. The Level 1 office is the
transportation agency headquarters (i.e., the Central Office or
Department of Transportation).

Level 2 Office
(user-defined label)

The office number or transportation agency-defined ID of the
Level 2 office. The Level 2 office can have any user-defined label,
such as District, Division, Region, or Section.

Level 2 Office
Engineer

User ID of the Level 2 office’s chief engineer. The user can search
this field. The title of engineer is unrelated to the transportation
agency’s actual title used.

Level 3 Office

The office number or transportation agency-defined ID of the
Level 3 office. The Level 3 office can have any user-defined label,
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Field Name Description

(user-defined label) | such as District, Division, Region, or Section.

Level 3 Office User ID of the Level 3 office’s chief engineer. The user can search
Engineer this field. The title of engineer is unrelated to the transportation
agency’s actual title used.

Level 4 Office The office number or transportation agency-defined ID of the
Level 4 office. The Level 4 office can have any user-defined label,
(user-defined label) | sych as District, Division, Region, or Section. If a state a province
has only three office levels this list and its columns will not

display.
Level 4 Office User ID of the Level 4 office’s chief engineer. The user can search
Engineer this field. The title of engineer is unrelated to the transportation

agency’s actual title used.

Address Line 1 First address line that identifies the office location.

Address Line 2 Second address line that identifies the office location.

Address Line 3 Third address line that identifies the office location.

City City location of the office.

Zip/Postal Postal code for the office.

State/Prov Two-character abbreviation for the state/province.

Country Four-character code identifying the country.

Phone Primary telephone number for the office.

Ext Extension number of the primary telephone number for the office.
FAX Primary fax number for the office.

Table 4-20 The Administrative Office Window Fields Table
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To add the Level 1 office:

L.
2.

10.

11.
12.
13.

14.
15.
16.
17.
18.
19.

On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

Click the Level 1 office field. (The Level 1 office is displayed in the top left corner. The window will
not have a label that says ‘Level 1.” The office level labels are user-defined.)

Click the New button.

Type the ID of the Level 1 office.

Press the Tab key.

In the Line 1 field, type the first line of the office address.

If necessary, tab to Line 2 and Line 3 and type additional address lines.
Press the Tab key.

In the City field, type the city name.

In the State/Prov drop-down list, click the expand arrow to the right of the current selection and click
the state or province.

Press the Tab key.
In the Zip/Postal field, type the zip code or other postal number.

In the Country drop-down list, click the expand arrow to the right of the current selection and click
the country.

Press the Tab key.

In the Phone field, type the office’s primary phone number.
Press the Tab key.

In the Ext field, type the phone number extension.

In the FAX field, type the office’s primary fax number.

To save the office description, click the Save button.

To add a new Level 2 office:

1.
2.
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On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

Click the Level 2 office datawindow. (The Level 2 office IDs are displayed directly under the Level 1
office ID. The window will not have a label that says ‘Level 2.” The office level names are user-
defined.)

Click the New button. A new row is added to the end of the list.

Type the office ID of the new office.
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10.
11.
12.

13.
14.
15.

16.
17.
18.
19.
20.

21.

Press the Tab key.

In the Engineer User ID field, type the User ID of the office’s Chief Engineer or perform a Search.
Press the Tab key.

In the Line 1 field, type the first line of the office address.

If necessary, tab to Line 2 and Line 3 and type additional address lines.

Press the Tab key.

In the City field, type the city name.

In the State/Prov drop-down list, click the expand arrow to the right of the current selection and click
the state or province.

Press the Tab key.
In the Zip/Postal field, type the zip code or other postal number.

In the Country drop-down list, click the expand arrow to the right of the current selection and click
the country.

Press the Tab key.

In the Phone field, type the office’s primary phone number.
Press the Tab key.

In the Ext field, type the phone number extension.

In the FAX field, type the office’s primary fax number.

To save the office description, click the Save button.

To delete a Level 2 office:

1.
2.

3.

On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

In the Level 2 office datawindow, scroll to and click the office ID. (The Level 2 offices are displayed
directly under the Level 1 office ID. The window will not have a label that says ‘Level 2.” The office
level names are user-defined.)

Click the Delete button.

For more information on making individual users available as Engineers for Administrative Offices, please
refer to the section on User Security.
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4.3 System Operational Parameters for Contracts

The following are the default settings of the system operational parameters related to Contract Administration.
The system operational parameters are defined by the transportation agency. For information on how your

SiteManager installation varies from these defaults, contact your local support personnel.

Default Description
Number of Office The number of administrative office levels, including the
Levels central office, for the state/province. For every level, the state

must have a label identifying the level as division, section,
region, district, area, etc. Every state/province must have at
least two levels below central office. No state/province can
have more than three levels below central office. The range is 3
to 4. The default is 3.

Level 1 Office Long

Label to identify the first level office. Examples are Division,
Section, Region, District, Area. The default is Central.

Level 2 Office Long

Label to identify the second level office. Examples are
Division, Section, Region, District, Area. The default is
District.

Level 3 Office Long

Label to identify the third level office. Examples are Division,
Section, Region, District, Area. The default is Residency.

Level 4 Office Long

Label to identify the fourth level office. Examples are Division,
Section, Region, District, Area. The default is Area.

Level 1 Office Short

Label to identify the first level office. Examples are Division,
Section, Region, District, Area. The default is Cent.

Level 2 Office Short

Label to identify the second level office. Examples are
Division, Section, Region, District, Area. Default is Dist.

Level 3 Office Short

Label to identify the third level office. Examples are Division,
Section, Region, District, Area. The default is Resi.

Level 4 Office Short

Label to identify the fourth level office. Examples are Division,
Section, Region, District, Area. The default is Area.
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Default Description
Level 2 Office Left The beginning (left most) position of the state's/province's

second level of administrative office in the 5-character
Trnseport™ office number format. The first level is central or
department. The second level could be division, region, district,
etc. The third level could be district, area, residency, etc. Valid
values are 1 through 5. The default is 0.

Level 2 Office Right The ending (right most) position of the state's/province's
second level of administrative office in the S-character
Trnseport™ office number format. The first level is central or
department. The second level could be division, region, district,
etc. The third level could be district, area, residency, etc. Valid
values are 1 through 5. This position must be equal to or
greater than the beginning (left most) position. The default is 0.

Level 3 Office Left The beginning (left most) position of the state's/province's third
level of administrative office in the S5-character Trnseport™
office number format. The first level is central or department.
The second level could be division, region, district, etc. The
third level could be district, area, residency, etc. Valid values
are 1 through 5. The default is 0.

Level 3 Office Right The ending (right most) position of the state's/province's third
level of administrative office in the 5-character Trnseport™
office number format. The first level is central or department.
The second level could be division, region, district, etc. The
third level could be district, area, residency, etc. Valid values
are 1 through 5. This position must be equal to or greater than
the beginning (left most) position. The default is 0.

Level 4 Office Left The beginning (left most) position of the state's/province's
fourth level of administrative office in the 5-character
Trnseport™ office number format. The first level is central or
department. The second level could be division, region, district,
etc. The third level could be district, area, residency, etc. Valid
values are 1 through 5. The default is 0.
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Default Description

Level 4 Office Right The ending (right most) position of the state's/province's fourth
level of administrative office in the 5-character Trnseport™
office number format. The first level is central or department.
The second level could be division, region, district, etc. The
third level could be district, area, residency, etc. Valid values
are 1 through 5. This position must be equal to or greater than
the beginning (left most) position. The default is 0.

Maximum Allowed The default value for the maximum percentage of the total
Subcontractor % Contract amount the Prime Contractor is allowed to
subcontract (excluding specialty items).

Progress Schedule The default percentage difference between a contract’s
Variance scheduled completion date and the actual completion date,
which will generate a warning message when exceeded. The
default percentage is 0. The user can override the default while
setting up a Contract.

Default Funding The user-designated code that identifies the default contract
Source Code funding source. The code appears in the Funding Source Code
field on the Contract Funding window. The user can override
the default while setting up a Contract.

Table 4-21 The System Operational Parameters Fields Table

4.4 Tab-Level Security for Contracts

As of release 2.3a, SiteManager provides the system administrator with the ability to establish security level
access for each Contract tab for each SiteManager user group.

For example, a user group that monitors on-the-job training commitments might need Update access to the
Training Plan tab, whereas a different user group might be assigned No Rights to this information.

These security levels are set on the Group Security window. Each tab name will appear on the window, and
access for each tab may be set to Update, Inquiry, or No Rights.
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5.1 Adding New Contracts

SiteManager gives the user the option of adding new Contracts either by loading the data from a Pre-
construction system or by entering the data into SiteManager one field at a time. The transportation agency
specifies which method to use, and should provide the user with instructions for any Pre-construction system
that is used in conjunction with SiteManager.

The procedures given here describe how to add Contract data to the SiteManager database through
SiteManager’s windows and data entry fields. An authorized user can add a new Contract using these data
entry procedures. New Contracts from the Pre-construction system may also need some data added or
modified by an authorized user.

New Contracts are given pending status by default. While a Contract is in pending status, an authorized user
can modify the Contract data and even delete the Contract, if necessary. To begin tracking the construction
work in SiteManager, an authorized user must change the Contract’s status to active. Whenever a Contract’s
status is changed, the system notifies selected personnel.

Tip: To add a new Contract, the user must have a Level 1 or Level 2 office assignment, Contract Record
window Update rights, and belong to a group with office-wide access. For more information, refer to the
Security Administration topic.

5.1.1 From Pre-Construction Systems

Trnseport™ is one of the Pre-construction systems that can be used to add a new Contract to the SiteManager
system. In addition to Trnseport™, there are several other Pre-construction systems that can be used to add a
new Contract to the SiteManager system. For information on the Pre-construction system that your
transportation agency uses, refer to the documentation provided by your local support personnel.

Contract data can be loaded into SiteManager using the Pre-construction Contract data load process
(PRELOAD) or the Construction Contract data load process (CONLOAD). When Contract data is loaded into
SiteManager from a Pre-construction system, the SiteManager system verifies that required data is present
and that the data is acceptable. If a Contract fails the verification process, SiteManager generates error
messages and displays them on the Interface Load Messages window. Some SiteManager windows have a
check box that indicates whether or not a Pre-construction system was used to add the selected Contract. After
the Contract status is changed to active, the data loaded from the Pre-construction system can not be modified.

5.1.2 Entry Directly into SiteManager

An authorized user can add Contract data to the SiteManager database through SiteManager’s windows and
data entry fields. For field definitions and detailed data entry procedures, the user can refer to the appropriate
topic. The field definitions include information about data that is subject to limitations or validation by the
system. The transportation agency should provide the user with any agency-defined procedures for entering
new Contract data.
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5.1.3 General Procedure for Adding New Contracts

To add a new Contract to the SiteManager system, without using a Pre-construction system, an authorized
user can follow the general procedure below. For field definitions and detailed data entry procedures, refer to
the appropriate topic.

Step 1 Saving a New Contract

Enter the data required to save the Contract as follows:

1.

Tip:

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens and
displays the Description folder tab.

Enter Contract description data on this folder tab.
Click the Location folder tab. Enter location data on this folder tab.

Click the Primary Personnel folder tab. Enter the Project Manager and Project Engineer on this
folder tab.

Click the Prime Contractor folder tab. Enter the Prime Contractor and associated data on this folder
tab.

At this point, if data is entered in all required fields, the user can save the Contract. Click the Save
button. After the Contract is saved, proceed to Step 2.

The following data must be entered before the Contract can be saved:
a. Contract ID
b. Level 2 Office (the field label is user-defined)
c. Federal/State/Province Project Number
d. Funding Indicator
e. Time Charges
f. Bid Days (if time is charged as Calendar Days or Work Days)
g. Description
h. Contract Type
i.  Work Type
j-  Spec Year
k. Unit System (English or metric)
l.  Location

m. Project Manager
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n. Project Engineer

0. Prime Contractor

Step 2 Adding Contract Data

To finish defining the Contract:

Click the Payment Data folder tab. Enter Contract payment data on this folder tab and save the data.

Click the Critical Dates folder tab. Enter Contract Critical Date data on this folder tab and save the
data. (The user is no longer required to enter a ‘Notice to Proceed’ date before activating the
Contract.)

Note: Contract activation is no longer tied to the Notice to Proceed date. The user can now activate a
contract using the Contract Status field on the Description tab. All functions, except for the Estimate
functions, are available to the user after the contract status is changed to ‘Active.” Estimate functions
are not available to the user until the Notice To Proceed date is entered.

5-4

Click the DBE Commit folder tab. Enter DBE commitment data on this folder tab and save the data.

Click the Training Plan folder tab. Enter training plan data on this folder tab and save the data. Close
the Contracts window.

To add Milestones, on the Contract Records panel, double-click the Milestones icon. The
Milestones window opens. Enter Contract milestone data and save the data. Close the Milestones
window.

To add Project data, on the Contract Records panel, double-click the Projects icon. The Projects
window opens. Enter Contract Project data and save the data. Close the Projects window.

To group Items under a funding Category, on the Contract Records panel, double-click the
Categories icon. The Categories window opens. Enter Category data and save the data. Close the
Categories window.

On the Contract Records panel, double-click the Items icon. The Items window opens. Enter Items
data and save the data. Close the Items window.

On the Contract Records panel, double-click the Contract Funding icon. The Contract Funding
window opens. Enter funding source data and save the data. Close the Contract Funding window.

On the Contract Records panel, double-click the Contract Authority icon. The Contract Authority
window opens. Enter Contract authority data and save the data. Close the Contract Authority window.

On the Contract Records panel, double-click the Key Dates icon. The Key Dates window opens.
Enter Key Date data and save the data. Close the Key Dates window.

On the Contract Records panel, double-click the Checklist Scheduled Events icon. The Checklist
Scheduled Events window opens. Enter Checklist Event data and save the data. Close the Checklist
Scheduled Events window.
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On the Contract Records panel, double-click the Permits icon. The Permits window opens. Enter
permit data and save the data. Close the Permits window.

To enter invoice data for stockpiled materials, on the Contract Records panel, double-click the
Stockpiled Materials icon. The Stockpiled Materials window opens. Enter stockpiled materials data
and save the data. Close the Stockpiled Materials window.

To record construction conferences, on the Contractor Management panel, double-click the
Construction Conference icon. The Construction Conference window opens. Enter construction
conference data and save the data. Close the Construction Conference window.

To enter progress schedule data, on the Contractor Management panel, double-click the Progress
Schedule icon. The Progress Schedule window opens. Enter progress schedule data and save the data.
Close the Progress Schedule window.

To enter Subcontract data, on the Contractor Management panel, double-click the Subcontracts
icon. The Subcontracts window opens. Enter Subcontract data and save the data. Close the
Subcontracts window.

Step 3 Activating a Contract

Contract work cannot be recorded in SiteManager until the Contract status is changed from pending to active.
After all required Contract data is entered, an authorized user can change the status to active. The following
data is required for activation:

Tip:
Description tab. All functions, except for the Estimate functions, are available to the user after the contract
status is changed to ‘Active.” Estimate functions are not available to the user until the Notice To Proceed date
is entered.

A Wage Decision selected on the Description folder tab.
A Primary County selected on the Location folder tab.

A surety company and an insurance company entered as Associates on the Prime Contractor folder
tab. (If the selected contractor has no associates, enter these companies first as Associates of the
contractor in the Vendor reference tables.)

Actual Dates for all dates marked ‘Required to Activate’ on the Key Dates window.

Actual Dates for all events marked ‘Required to Activate’ on the Checklist Event Dates window.
At least one Project defined on the Projects window.

At least one Item defined on the Items window.

Funding sources selected on the Contract Funding window to fully fund the Contract.

Actual Dates for all dates marked ‘Required to Activate’ on the Critical Dates folder tab.

The user must change the contract status to ‘Active’, using the Contract Status field on the
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5.2 Contract Status Validation

SiteManager looks at the data entered for a Contract to determine the Contract’s status. When the user saves a
Contract, the save process determines if the Contract status has been changed. If the Contract status has been
changed, the system validates the status and performs related tasks as described below. The following
Contract states are possible:

e Pending
e Active
e Complete
e Archived
To change the Contract’s status from pending to active, the following criteria must be met:
e There must be an Execution Contract Critical Date with the Actual Date filled in.

e Ifthe Contract’s price adjustment allowed indicator is Yes, the Price Adjustment Base Contract
Critical Date must have an Actual Date.

e The Prime Contractor must have a surety and an insurance company.
e The Contract must have entries in all of the following fields:
Wage Decision
Primary County
Project Manager
Project Engineer
Prime Contractor
Liquidated Damages Rate Amount
e The Contract must have at least one record for each of the following:
Project
Item
Retainage
Contract Funding (all parts fully funded)
Contract Authority for the Project Manager and Project Engineer

Note: For transportation agencies that do not include Contract Funding in their construction management
system, a dummy Contract Funding record is added with 100% non-participating no-limit funding. Funding
source validation is bypassed.
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When the Contract’s status changes to active, the system performs the following tasks:

Personnel identified in the Primary Personnel folder are notified by an In-Box message.

All Contract Item status will be modified from pending to active.

If a Contract Liquidated Damages Amount does not exist, this amount is obtained and displayed from

the default Liquidated Damages table.

If no Project is indicated as the Primary Project, the Primary Project is defaulted as:

The only Project, if the Contract has only one Project.

The Project with greatest total dollar amount, if the Contract has multiple Projects.

All Checklist Scheduled Events that do not have Next Projected Date displayed are automatically

updated with the first logical date after the Notice To Proceed Date.

To delete a Contract, its status must be pending.

To change a Contract’s status back to pending, the following criteria must be met.

Contract Items can not have:
An associated Change Order
An associated Dispute

An associated Stockpiled Material

The Contract cannot have:

If a Contract status change cannot be saved because the data fails validation:

An associated Force Account

An associated Estimate

An associated Dispute

An associated Sample

An associated Change Order

An associated Plan Discrepancy

Been downloaded (checked out) to the field
Milestones can not have an associated Change Order.

The Contract can not have Daily Work Reports associated with it.

Change the Contract’s status to pending.
Delete the Contract.

If the Contract has been active, delete the Contract’s associated record(s), or upload the Contract back to the
Server (check it in).

August 2005

5-7



Trnseport SiteManager®
Contract Administration - New Contracts Contract Records

Entering the Physical Work Complete Date does not change the Contract status. However, it marks the
beginning of the Contract completion procedure. To save the Physical Work Complete Date, all draft and
pending Change Orders must be either approved or not approved. When the Physical Work Complete Date is
entered, the Project Manager and Project Engineer are notified by In-Box message, any active Items are
assigned final quantities and the Items’ status is changed to from ‘Active’ to ‘Final’ (i.e., no longer able to log
work to these items).

To change a Contract’s status from active to complete, the following criteria must be met.

e The Physical Work Complete Date must have an Actual Date.

e All Critical Dates and Key Dates marked ‘Required to Finalize’ must have Actual Dates.

e All Checklist Scheduled Events must have Actual Dates.

e All Items must have approved final quantity.

e No Change Order can have a status of pending.

e All Progress and Final Estimates must be paid.

e All Disputes and Claims must be resolved.

e All stockpiled materials must be zero.
When the Contract status changes to complete, Contract authority is end-dated for all Contract personnel
except the Project Manager and Project Engineer. After a Contract is complete, only the Project Manager,
Project Engineer, and personnel with Office-Wide and Update access can make changes to a Contract. When

the Contract status changes to complete, the system marks the Contract ‘To Be Sent to DSS.” The archived
status is used to store the archived file.

5.3 Contract Records

The Contract Records panel lets the user access other windows to view, add, modify, and delete Contract
records. The Contract Records panel has icons that represent the following windows:

e Contracts

e Milestones

e Projects

e (Categories

e Items

e Contract Funding

e Contract Authority

e Key Dates

e Checklist Scheduled Events

e Checklist Event Dates

e Correspondence Log

e Plan Discrepancies
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e Stockpiled Materials
e Force Accounts
e Design Evaluation

e Disputes/Claims

ESuhcontracts

Figure 5-1 The Contract Records Panel
To access the Contract Records panel:

1. On the Contract Administration panel, double-click the Contract Records icon.
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5.4 Contracts

The Contracts window lets the user add new Contracts, and view, add, modify, or delete the basic Contract
data. The following table describes the nine folder tabs on the Contracts window:

Folder Tab Name Description

Description The Description folder tab displays the Contract description
data. This includes the Contract’s status, Project number(s),
administrative offices, funding sources, and other
descriptive information that determines how the system
processes data for this Contract.

Location The Location folder tab displays the Contract location data
that can be added, modified, or deleted. This includes the list
of available counties for each state or province and those
associated with the selected Contract. Authorized users may
add and remove counties to and from the Contract. A
primary county must be selected.

Payment Data The Payment Data folder tab displays the Contract payment
data that can be added, modified, or deleted. This data
includes Liquidated Damages Rate Amount, Retainage,
Estimate Generation indicators, and Limit Amount.

Critical Dates The Critical Dates folder tab displays the Critical Dates
(Letting date, Notice to Proceed date, etc.). These dates are
required by the system for the standard Contract status
reports. The default date types can not be deleted or
modified.

Primary Personnel The Primary Personnel folder tab lets the user maintain data
on the Contract creator, designer, Project Manager, and
Project Engineer. This folder tab also identifies the
personnel who will receive messages when the Contract
becomes active or falls behind schedule.

Prime Contractor The Prime Contractor folder tab displays the Prime
Contractor data that can be added, modified, or deleted. This
data includes the Prime Contractor, contractor defaulted
data, maximum Subcontract amount, payroll requirements,
Prime Contacts, and Prime Associates. The Prime
Contractor’s surety and insurance companies must be
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Folder Tab Name

Description

entered as Prime Associates.

DBE Commitment

The DBE Commitment folder tab lets the user add and
modify Contractor DBE Commitments. This folder tab also
displays system-calculated DBE amounts.

Training Plan

The Training folder tab lets the user identify the Prime
Contractor’s on-the-job training commitments for a Contract
(i.e., the training plan), which is then used during estimate
generation to perform automated reimbursement. This folder
tab also displays system-calculated training hour usage.

Table 5-1 The Contracts Window Folder Tabs Table

ﬂ[ﬁonllacls M=l B
Description ~ Location | PaymentData  Criical Dates | Primary | Prme | DBE Commit | Training Plan
Personnel Contractor
ContractID:[ Fed St/Pr Prj Nbr: |
Stalus:W Primary PCN: |:E
Division::E District: I:'H Area: I:'H = Fe’;‘;’:::"g
Progress Sched: | ||| variance Pct: I—EIEI  State/Province
Desc: | " Both

Time Charges: I

|LI Bid Days: I Bid Amt: I $0.00

Contract Type: | Spaces

[*] I Fed Dversight

Work Type:|Spaces

E [~ Local Dversight Proposal Fund Type: I

Spec Yr:l Unit System: I:B Suppl Spec Bk Yr: | Alt ID:|

Wage Wage Decision ID Wage Decision Description Genil Wg Dcsn ID

Decision: [

To access the Contracts window:

Figure 5-2 The Contracts Window

1. On the Contract Administration panel, double-click the Contract Records icon.

2. On the Contract Records panel, double-click the Contracts icon.

5.4.1 Contract Description

The Description folder tab displays the Contract description data that can be added, modified, or deleted. This

includes the Contract’s status, project

number(s), administrative offices, funding type, and other descriptive

information that determines how the system processes data for this Contract.
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Field Name Description

Contract ID Transportation agency-defined ID for the Contract. Corresponds to
the Contract ID assigned by Trnseport™ or another Pre-
construction system. This is a required field.

Status Indicates the current status of a Contract (e.g., Pending, Active,
Complete, Archived).

Primary PCN The Contract’s primary Project Control Number. This field lists the

Projects defined for this Contract. If multiple Contracts are defined,
the user selects the primary Project in this field.

Fed St/Pr Prj Nbr

The federal, state, or province Project number for the Contract,
Project or Category. This is a required field.

Level 2 Office
(user-defined label)

The office number for the Level 2 office responsible for
administering the Contract. The Level 2 office can have any user-
defined label, such as District, Division, or Region. This is a
required field. (The Level 1 office is the transportation agency
headquarters, e.g., the Central Office or the Department of
Transportation.)

Level 3 Office
(user-defined label)

The office number for the Level 3 office responsible for
administering the Contract. The Level 3 office can have any user-
defined label. If there are only two administration levels, this field
does not display.

Level 4 Office
(user-defined label)

The office number for the Level 4 office responsible for
administering the Contract. The Level 4 office can have any user-
defined label. If there are only two or three administration levels,
this field does not display.

Progress Sched

The type of Progress Schedule used for the Contract (i.e., Percent
Complete for a Time Period, Percent of Critical Iltems Complete for
a Time Period, or Critical Path Method.) If Critical Path Method is
selected, no schedule is processed for this Contract in SiteManager.
If the user selects a different schedule type on the Progress
Schedule window, the system changes this field.
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Field Name

Description

Variance Pct

The percentage difference between a schedule's anticipated and
actual completion percent. A message is generated when the
difference is greater than this percentage. For example, if 30% of
the work is anticipated to be complete by a certain date and the
actual percentage complete is 19%, if the Variance Pct is 10%, a
message notifies the recipient(s) of the variance.

Time Charges How time charges are assessed for the Contract (i.e., Work Days,
Calendar Days, or Fixed Completion Date). This is a required field.

Bid Days The original number of days for the Contract. This field is required
when the Time Charges entry is Work Days or Calendar Days.

Bid Amt The original bid amount of the contract. This field is display only.

Desc Text description of the Contract. This is a required field.

AltID An alternate transportation agency-defined ID for the Contract.
This field can not be modified if an estimate has been generated.

Contract Type Transportation agency-defined classification of the Contract type
(e.g., Biddable, Safety, A + B, Prime Contract). This is a required
field.

Work Type Transportation agency-defined classification of the major type of
work being done on the Contract (e.g., Bridge Work,
Beautification). This is a required field.

Spec Yr The Item Master specification year of the Items used for the

Contract. This is a required field.

Unit System

Indicates that the measurement system used for the Contract is
either English or Metric. This is a required field.

Fed Oversight

Indicates that federal authorities must receive and approve any
Change Orders for this Contract.
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Field Name Description
Funding Indicates that the Contract is funded by federal funds only, non-

federal funds only (state, province, etc.), or both. This is a required
field. If the user selects funding sources on the Contract Funding
window that do not match this field, the system changes this field.
If funding is subsequently changed, the indicator will change with
the funding assignment.

Suppl Spec Bk Yr A supplemental Item Master specification year of the Items used
for the Contract.

Local Oversight Indicates that local authorities must be copied on and approve
Change Orders.
Wage Decision ID Transportation agency-defined ID for a wage decision applicable to

the Contract. The user can search this field. Wage decision data is
required during the loading of Contractor payrolls; it is used to
determine potential wage rate variances. The wage decision records
are maintained in the Civil Rights reference tables.

Genrl Wg Dcsn ID General Wage Decision ID.

Wage Decision Description of the wage decision (first 40 characters).
Description

Proposal Fund Type | Type of funds used for the Contract (e.g., ST1 = State Fund 1,
FEDI = Federal Fund 1, MUNI = Municipal Fund)

Table 5-2 The Description Folder Tab Fields Table

To add a new Contract:

L.

5-14

On the Contract Records panel, double-click the Contracts icon. If the user is authorized to add
Contracts, the Description folder tab fields are empty and the user can add new Contract data.

To add a new Contract ID, click the Contract ID field and type the new ID.
Press the Tab key.
In the Fed St/Pr Prj Nbr field, type the federal, state, or province Project number for the Contract.

In the Primary PCN drop-down list, click the expand arrow and click the Project’s Primary Control
Number.
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10.
11.

12.

13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.

In the Level 2 Office drop-down list, click the expand arrow and click the office ID.

If a Level 3 or 4 office administers the Contract, in the Level 3 Office drop-down list, click the
expand arrow and click the office ID.

If a Level 4 office administers the Contract, in the Level 4 Office drop-down list, click the expand
arrow and click the office ID.

In the Progress Schedule drop-down list, click the expand arrow and click the schedule type.
To change the default variance percentage, tab to the Variance Pct field and type the percentage.

In the Time Charges drop-down list, click the expand arrow to the right of the current selection and
click the time charges type.

If the Time Charges entry is Work Days or Calendar Days, tab to the Bid Days field and type the
original number of days for the Contract.

Press the Tab key.

In the Desc field, type a description of the Contract.

In the Contract Type drop-down list, click the expand arrow and click the Contract type.
If Federal Oversight is required, click the Fed Oversight check box (ON).

In the Work Type drop-down list, click the expand arrow and click the work type.

If Local Oversight is required, click the Local Oversight check box (ON).

Press the Tab key.

In the Spec Yr field, type the Item Master specification year.

Press the Tab key.

In the Unit System drop-down list, click the expand arrow and click either English or Metric.
Press the Tab key.

If required, in the Suppl Spec Bk Yr field, type a supplemental Item Master spec year.
Press the Tab key.

In the Alt ID field, type an alternate ID for the Contract.

To select a Funding type, click the radio button for Federal, State/Province, or Both.

A new Contract ID can not be saved until the following data is entered: the Location, the Primary
Personnel, and the Prime Contractor. Click the Location folder tab and continue adding data (refer to
the Location topic).
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To modify a pending Contract’s description:
1. On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
2. Click the Open button. The Select Contract list is displayed.

3. In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

4. In the Fed St/Pr Prj Nbr field, type the federal, state, or province Project number for the Contract.

5. In the Primary PCN drop-down list, click the expand arrow and click the Project’s Primary Control
Number.

6. In the Level 2 Office drop-down list, click the expand arrow and click the office ID.

7. IfaLevel 3 or 4 office administers the Contract, in the Level 3 Office drop-down list, click the
expand arrow and click the office ID.

8. Ifa Level 4 office administers the Contract, in the Level 4 Office drop-down list, click the expand
arrow and click the office ID.

9. To change the default variance percentage, tab to the Variance Pct field and type the percentage.

10. In the Time Charges drop-down list, click the expand arrow to the right of the current selection and
click the time charges type.

11. If the Time Charges entry is Work Days or Calendar Days, tab to the Bid Days ficld and type the
original number of days for the Contract.

12. Press the Tab key.

13. In the Desec field, type a description of the Contract.

14. In the Contract Type drop-down list, click the expand arrow and click the Contract type.
15. If Federal Oversight is required, click the Fed Oversight check box (ON).

16. In the Work Type drop-down list, click the expand arrow and click the work type.

17. If Local Oversight is required, click the Local Oversight check box (ON).

18. Press the Tab key.

19. In the Spee Yr field, type the Item Master specification year.

20. Press the Tab key.

21. In the Unit System drop-down list, click the expand arrow and click either English or Metric.
22. Press the Tab key.

23. If required, in the Suppl Spec Bk Yr field, type a supplemental Item Master spec year.
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24. Press the Tab key.

25. In the Alt ID field, type an alternate ID for the Contract.

26. To select a Funding type, click the radio button for Federal, State/Province, or Both.

27. Click the Save button.

To add a Wage Decision to a Contract:

1.
2.

Tip:

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Wage Decision ID list box and click the New button. An empty row is added to the list.

In the Wage Decision ID field, type a wage decision ID or click the right mouse button and perform
a Search.

Click the Save button.

The wage decision records are maintained in the Civil Rights reference tables.

To change a Contract’s status:

L.
2.

5.

Tip:

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

In the Status drop-down list, click the expand arrow to the right of the current selection and click the
status.

Click the Save button.

When the user saves a Contract status change, the system runs a validation process. If the Contract

data passes validation, the status change is saved in the database.

To delete a pending Contract:

1.
2.

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Delete button.
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5. Click the Yes button (to confirm the deletion).
6. Click the Yes button (to confirm deletion of associated records).

7. Click the Save button.

5.4.2 Contract Location

The Location folder tab lets the user add, modify, and delete Contract location data, and to add or remove
counties. Each Contract must have one county selected as the primary county. The user can not remove a
county that is currently associated with one of the Contract’s projects.

ﬂl:unllacls _[O] x|
— e e e o o e
Description Location Payment Data  Ciitical Dates Primary Prime DEE Commit — Training Plan
Personnel Contractar
Contract ID: | ﬂ
Location: |

|
Beg Sta Nbr: | Beg Termini:l Route Nbr: |
End Sta Nbr: I End Termini:l Highway Nbr: I

Road System: [Spaces  [~||| Highway Type: [Spaces  [~]
Town- | hd
4 I I 3
| Contract County Primary County
i [

Figure 5-3 The Location Folder Tab

Field Name Description

Location Description of the Contract location. This is a required field. Two
lines are provided.

Beg Sta Nbr Precisely defines the station number where the work begins.
Beg Termini Precisely defines the termini where the work begins.

Route Nbr Route number where the primary work is done.

End Sta Nbr Precisely defines the station number where the work ends.
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Field Name Description

End Termini Precisely defines the termini where the work ends.

Highway Nbr Highway number where the primary work is done.

Road System Type of road system where the primary work is done (e.g.,
interstate, state highway, county road).

Highway Type Type of highway where the primary work is done (e.g., asphalt,
concrete, gravel).

Contract County | Name of a county in which the work is done. The user can search
this field.

Primary County | Indicates the primary county in which the work is done. At least
one and only one county must be indicated as the primary county.

Table 5-3 The Location Folder Tab Fields Table

To modify the Contract location:

1.
2.

9.

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Location folder tab.

In the Location field, type a description of the construction location. If necessary, tab to the second
line and type more text.

Press the Tab key.
In the Beg Sta field, type the Station number where the work begins.
Press the Tab key.

In the Beg Termini field, type the Termini where the work begins.

10. Press the Tab key.

11. In the Route Nbr field, type affected route number.

12. Press the Tab key.
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13. In the End Sta field, type the Station number where the work ends.

14. In the End Termini field, type the Termini where the work ends.

15. In the Highway Nbr, type the primary work roadway number.

16. In the Road System drop-down list, click the expand arrow and click the road system.
17. In the Highway Type drop-down list, click the expand arrow and click the highway type.
18. Press the Tab key.

19. In the Town field, type the name of the town.

20. Click the Contract County datawindow and click the New button. An empty row is added to the
datawindow.

21. In the Contract County field, type the name of the county or perform a Search.
22. To add another county, click the New button and repeat Step 21.

23. In the Contract County list box, scroll to the primary county and click the Primary County
indicator (ON).

24. Click the Save button.

To delete a county from a Contract:
1. On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
2. Click the Open button. The Select Contract list is displayed.

3. In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

4. Click the Location folder tab.
5. In the Contract County list box, scroll to and click the county (click the Primary County indicator).
6. Click the Delete button.

7. In the Contract County list box, scroll to the primary county and click the Primary County
indicator (ON).

8. Click the Save button.

Tip:  The user cannot remove a county that is currently associated with one of the Contract’s projects.

5-20 August 2005



Contracts

5.4.3 Contract Payment Data

Trnseport SiteManager®

Contract Administration - New Contracts

The Payment Data folder tab lets the user add, modify, or delete Contract payment data such as the Liquidated

Damages Rate Amount, the day of the month to generate estimates, Contract payment amount limits, and

retainage data. The retainage data includes the type of retainage allowed and the values that determine how
retainage is to be applied to the Contract.

ﬂ Contracts M=l B

e
Description Location

Payment Critical Dates Primary Prime DBE Commit — Training Plan
Data Personnel Contractor

Contract 1D: I Current Contract Amk: I $0.00
Generate Estl Day: m Contract Limit Amt:l $.00 Liquidated Dam Rate Aml:l .00

Generate Est2 Day: I_ Contract Limit Pct:l oo [v Auto Liquidated Dam

™ Price Adjmnt Ind
RETAINAGE

[ Securities Allowed [ Retain Stkpiled Ind [ Unlimited Escrow  Max Escrow Aml:l $.00 |

Retainage Changes:

Work Compl Basis |Effect Date| Pct Pct Base Max Pct Max Amt Lump Amt |Trgr Pct| Tror Base

[ [=] 00/00/00 .0l = [ $.00 $.00 .00 E

Figure 5-4 The Payment Data Folder Tab

Field Name

Description

Current Contract Amt

The current amount of the contract (original bid amount plus
approved change orders). This field is display only.

Generate Estl Day

The day of the month, 1 - 30, that the Contract’s first
monthly estimate should be generated. Three days before this
day, the system notifies the Project Manager that estimate
generation is approaching.

Contract Limit Amt The amount over the original bid amount that is allowed for
the Contract. The limit amount is added to the bid amount to
calculate the maximum amount that can be paid for the
Contract. If a value is entered in this field, the Contract Limit
Pct field is protected.

Liquidated Dam Rate | The liquidated damages rate amount for the Contract.

Amt
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Field Name

Description

Generate Est2 Day

The day of the month, 2 - 30, that the Contract’s second
monthly estimate should be generated. Three days before this
day, the system notifies the Project Manager that estimate
generation is approaching. The value in this field must be
greater than the Generate Estl Day.

Contract Limit Pct

The percent over the original bid amount that is allowed for
the Contract. The product of the limit percent multiplied by
the bid amount is added to the bid amount to calculate the
maximum amount that can be paid for this Contract. If a
value is entered in this field, the Contract Limit Amt field is
protected.

Auto Liquidated Dam

Indicates that liquidated damage values are generated
automatically.

Price Adjmnt Ind

Indicates that price adjustments are allowed for the
Contract’s Items.

Retainage

Retainage Securities
Allowed

Indicates whether or not securities are allowed in lieu of
Retainage for the Contract.

Retainage Stkpiled Ind

Indicates that Retainage includes stockpiled materials in the
earnings calculation.

Retainage Max
Escrow Amt

Maximum amount that can encumbered in an escrow account
used in licu of Retainage.

Retainage Unlimited
Escrow Ind

Indicates that there is no limit to how much Retainage can be
covered by the escrow account.

Retainage Changes

Retainage Changes
Work Compl Basis

Method for calculating Retainage (i.e., Work Reported Per
Period, Work Remaining, or Work In Place).

August 2005



Trnseport SiteManager®

Contracts Contract Administration - New Contracts
Field Name Description
Retainage Changes Effective date of Retainage. The effective date can not be
Effect Date duplicated on different Retainage records.

Retainage Changes Pct | The Retainage percentage to be applied to the Contract. Must
be less than or equal to the maximum Retainage percentage.
This field is required if a lump sum amount is not entered.

Retainage Changes Pct | Indicates that Retainage should be calculated as a percentage

Base of the bid amount or the current amount.

Retainage Changes The maximum Retainage percentage allowed for the

Max Pct Contract.

Retainage Changes The maximum Retainage amount allowed for the Contract.
Max Amt

Retainage Changes The lump sum amount of Retainage. If a Retainage

Lump Amt percentage is not entered, a value must be entered here.
Retainage Changes The percentage of Contract completion at which the

Trgr Pct Retainage change is to occur.

Retainage Changes Indicates that the trigger percentage should be a percentage
Trgr Base of the bid amount or current amount.

Table 5-4 The Payment Data Folder Tab Fields Table

To modify a pending Contract’s payment data:

1.
2.

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Payment Data folder tab.

In the Generate Est 1 field, select the current entry and type the day of the month the Contract’s first
monthly estimate should be generated.

Press the Tab key.
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7. In the Contract Limit Amt field, type the payment limit amount.

8. Press the Tab key.

9. To enter a Liquidated Damages Rate Amount or overwrite the default value, in the Liquidated Dam
Rate Amt field, select the current entry and type the rate.

10. Press the Tab key.

11. In the Generate Est 1 field, select the current entry and type the day of the month the Contract’s
second monthly estimate should be generated.

12. Press the Tab key.

13. In the Contract Limit Pct ficld, select the current entry and type the Contract’s limit percentage

14. To turn off automated liquidated damage generation, click the Auto Liquidated Dam check box
(OFF).

15. To allow Item price adjustments, click the Price Adjmnt Ind check box (ON).

16. To allow securities to be used in lieu of Retainage, click the Securities Allowed check box (ON).

17. To include stockpiled materials in earnings calculations, click the Retain Stkpiled Ind check box
(ON).

18. To allow unlimited Retainage coverage by the escrow account, click the Unlimited Escrow check
box (ON).

19. In the Max Escrow Amt ficld, select the current entry and type the maximum amount to be
encumbered in an escrow account.

20. Click the Save button.

To add data that determines how retainage is to be applied to the Contract:

1.
2.

5-24

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Payment Data folder tab.

In the Retainage Changes area, click the Work Compl Basis field and click the New button. An
empty row is added.

In the Work Compl Basis drop-down list, click the expand arrow to the right of the current selection
and click the method for calculating Retainage.

Press the Tab key.

In the Effect Date field, select the current entry and type the effective date of Retainage.
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9. Press the Tab key.
10. In the Pct field, select the current entry and type the Retainage percent to be applied.

11. In the Pct Base drop-down list, click the expand arrow to the right of the current selection and click
either Bid Amount or Current Amount.

12. Press the Tab key.

13. In the Max Pct field, select the current entry and type the maximum Retainage percentage allowed.
14. Press the Tab key.

15. In the Max Amt field, select the current entry and type the maximum Retainage amount allowed.
16. Press the Tab key.

17. In the Lump Amt field, select the current entry and type the lump sum amount of Retainage.

18. Press the Tab key.

19. In the Trgr Pct field, select the current entry and type the trigger percentage (percentage of Contract
completion at which the Retainage change is to occur).

20. Press the Tab key.

21. In the Trgr Base drop-down list, click the expand arrow to the right of the current selection and click
either Bid Amount or Current Amount.

22. Click the Save button.

Tip: If a Retainage record is effective when an estimate is generated, the record can not be deleted.
Therefore, the user can not delete a Retainage record when:

e The Retainage Effective Date is less than or equal to the current date, and an estimate has been
generated.

e The Estimate Generate date is greater than or equal to the Retainage Effective Date.

5.4.4 Contract Critical Dates

The Critical Dates folder tab lets the user view and record the occurrence of Critical Dates. The user can also
add or modify related data. The actual occurrence of a Critical Date event is recorded as the Actual Date of
the event. Some Actual Dates are entered by the system and some are entered by an authorized user. The
Critical Date types were defined during system development and cannot be added or deleted. These dates are
considered critical because SiteManager includes them in the standard Contract record reports. When a new
Contract is added, either manually or from the pre-construction system, SiteManager includes the Critical
Date types defined in the Default Critical Date reference table. Therefore, every Contract has the same
Critical Date types.

August 2005 5-25



Trnseport SiteManager®

Contract Administration - New Contracts

5-26

Critical Date Type

Requirements for entering the Actual Date

Accepted Date

This date can not be required to activate the Contract.

Adjusted Completion Date

The system enters this date and the user can not modify it.
This date is entered by the Change Order process.

Award Date

This date can not be modified when the Contract is from the
pre-construction system.

Checked Out to Field Date

The system enters this date and the user cannot modify it.
This date is entered by Pipeline when the Contract is
checked out. This date cannot be required to activate the
Contract.

Contract Archived Date

The system enters this date and the user cannot modify it.
This date is entered by the Contract archival process. This
date cannot be required to finalize the Contract. This date
cannot be required to activate the Contract.

Contractor Bankruptcy Date

This date cannot be required to finalize the Contract. This
date cannot be required to activate the Contract.

Contractor Default Date

This date cannot be required to finalize the Contract. This
date cannot be required to activate the Contract.

Contractor Final Release
Date

This date cannot be required to activate the Contract.

Execution Date

This date can be modified only when the Contract is
pending.

Letting Date

The user cannot modify this date if the contract was
transferred from the pre-construction system.

Notice to Proceed Date

The user cannot modify this date until the Contract’s status is
changed to ‘Active.’

August 2005

Contracts




Trnseport SiteManager®

Contracts Contract Administration - New Contracts
Critical Date Type Requirements for entering the Actual Date
Open to Traffic Date This date can not be required to activate the Contract.

Original Completion Date

If time is charged as Calendar Days, the system enters this
date and the user can not modify it. If time is charged as a
Fixed Completion Date, this date can be modified while the
Contract is pending. If time is charged as Available Work
Days, this date should not be entered.

Physical Work Complete
Date

This date can not be required to activate the Contract. This
date can be modified only when the Contract is active.
Before entering this date, all Change Orders must be
approved or denied. When this date is entered, the system
notifies personnel and enters final quantities for active Items
and moves all active items to final status. Note: The user is
now notified that all items will be moved to Final status
upon entering and saving this date, and is prompted
whether to continue the operation. Once this date has
been entered and saved, the user will no longer be able to
post DWR’s on items moved to the Final status.

Price Adjustments Base
Date

This date can be modified only when the Contract is
pending.

Signed Date

This date can not be modified when the Contract is from the
pre-construction system.

Substantial Work Complete
Date

This date can not be required to activate the Contract. This
date can be modified only when the Contract is active.

Work Begin Date

This date can not be required to activate the Contract.

Table 5-5 The Critical Date Type Requirements Table
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Description Location Payment Data Critical Primary Frime DBE Commit — Training Plan
Dates Personnel Contractor
Contract I1D: I
Critical Date Description Actual Date Required to Activate | Required to Finalize ﬂ
Accepted Date 00400400 M M
Adjusted Completion D ate 00/00/00 M M
Contract &rchived Date 0000400 M N
Award Date 00/00/00 M M
Contractor Bankruptey D ate 00400400 M M
Checked Dut to Field Date 0000400 M N
Contractor Default D ate 00/00/00 M M -
K1 LI_I
Critical Date Description: Iﬂxccepted Date
Actual Occurrence Date: [~ Required to Activate [ Required to Finalize
Distribution List: | HRecipient ID: I—
Message Text: |

Figure 5-5 The Critical Dates Folder Tab

Field Name Description
Critical Date System-defined Critical Date type. All Contracts have the default
Description Critical Date types. The Critical Date types can not be added,

modified, or deleted.

Actual Date The date the event actually occurred. In most cases, the date must be
current or in the past. If time is charged as ‘Fixed Completion Date,’
the ‘Original Completion Date’ can be in the future. When an Actual
Date is entered, the system notifies the selected recipient(s). When an
Actual Date is entered for the ‘Physical Work Complete Date,’ the
system notifies Level 1 office personnel, and enters final quantities
for any active Items and changes their status to final (i.e., no longer
able to log work to these items).

Rqrd to Activate Indicates that the event must occur before the Contract status can be
changed from pending to active (e.g., Letting Date, Award Date,
Execution Date).

Rqrd to Finalize Indicates that the event must occur before the Contract status can be
changed to complete.
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Field Name Description
Distribution List Group of users to be notified that the event has occurred. Either a

Distribution List or Recipient must be entered. After valid entry of
either, the other is protected. The user can search this field.

Recipient ID User ID of the person to be notified that the event has occurred. Either
a Distribution List or Recipient must be entered. After valid entry of
either, the other is protected. The user can search this field.

Message Text Standard message to be sent to the recipient(s).

Table 5-6 The Critical Dates Folder Tab Fields Table

To enter the Actual Date of a Contract Critical Date:

L.
2.

10.
11.

Tip:

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Critical Dates folder tab.

In the Critical Date Description list box, scroll to and click the date. The data for the selected date is
displayed below the list.

In the Actual Date ficld, click in front of the current entry and type the date when the Critical Date
event occurred.

To make this date Required to Activate, click the Rqrd to Activate check box (ON).
To make this date Required to Finalize, click the Rqrd to Finalize check box (ON).

To select a recipient for notification, in either the Distribution List ficld or the Recipient ID field,
perform a Search.

In the Message Text field, type a message to include with the notification.
Click the Save button.

The Notice to Proceed Date can only be entered when the Contract status is ‘Active.” Before the

Physical Work Complete Date is entered, Item final quantities should be approved and all Change Orders
must be approved or denied.

Tip:

If an Original Completion Date is entered for an Available Work Days Contract, the date will be

removed when the Contract is activated.
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5.4.5 Contract Primary Personnel

The Primary Personnel folder tab lets the user add, modify, and delete the Contract’s primary personnel.
Every Contract must have a Project Manager and a Project Engineer. When an authorized user adds the
Project Manager and Project Engineer to the Contract, SiteManager adds them to Contract Authority
automatically. If primary personnel are later replaced, SiteManager starts authority for the new personnel and
ends authority for the previous personnel.

The user can also select personnel—an individual or group—to be notified of certain conditions. Personnel
can be notified when the Contract status is changed to active, when the Contract work falls behind schedule,
or when Civil Rights data fails validation.

ﬂﬁuntlacts [_ O] x|
D escription Location Payment Data  Critical Dates Primary Prime DEE Commit  Training Plan
Personnel Contractar

Contract ID: I

Project Manager:{ |

Project Engineer: | |

Contract Designer: |

Contract Created By: |S_l,lstem Adrminigtrator 1

—Motification Recipients

— Contract Status Changed to Active:
User ID: I Distribution List: |

—work Progress Behind 5chedul

User ID: I Distribution List: |
— Civil Rights Exception Report Generated:

User ID: I Distribution List: |

Figure 5-6 The Primary Personnel Folder Tab

Field Name Description

Project Manager Name of the Project Manager for the Contract. Specific
messages and reports are sent to this person. The user can
search this field. This is a required field.

Project Engineer Name of the Project Engineer for the Contract. Specific
messages and reports are sent to this person. The user can
search this field. This is a required field.

Contract Designer Name of the person or firm that designed the Contract.
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Field Name Description

Contract Created By Name of the user who added the Contract, or a system
indicator for Contracts built by the system.

Recipient Notified when Contract Status Changed to Active

User ID User ID of the person to be notified when the Contract’s
status changes from pending to active. The value is
protected if a Distribution List is entered. Either a User ID
or Distribution List must be entered. The user can search
this field.

Distribution List Name of the Distribution List to be notified when the
Contract’s status changes from pending to active. The value
is protected if a User ID is entered. Either a User ID or
Distribution List must be entered. The user can search this
field.

Recipient Notified when Work Progress Behind Schedule

User ID User ID of person to be notified when the Contract’s
progress falls behind schedule equal to or greater than the
variance percentage. This message can be generated only if
the Variance Pct is entered and the Contract work is tracked
by a Progress Schedule. The value is protected if a
Distribution List is entered. Either a User ID or
Distribution List must be entered. The user can search this
field.

Distribution List Name of the Distribution List to be notified when the
Contract’s progress falls behind schedule equal to or
greater than the variance percentage. This message can be
generated only if the Variance Pct is entered and the
Contract work is tracked by a Progress Schedule. The value
is protected if a User ID is entered. Either a User ID or
Distribution List must be entered. The user can search this
field.

Recipient Notified when Civil Rights Exception Report Generated
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Field Name Description
User ID User ID of the person to be notified when the Contract’s

civil rights monitoring generates an exception report. This
field is protected if a Distribution List is entered. Either a
User ID or Distribution List must be entered. The user can
search this field.

Distribution List Name of the Distribution List to be notified when the
Contract’s civil rights monitoring generates an exception
report. This field is protected if a User ID is entered. Either
a User ID or Distribution List must be entered. The user
can search this field.

Table 5-7 The Primary Personnel Folder Tab Fields Table

To add Primary Personnel to a pending Contract:

1.
2.

10.

1.

12.

5-32

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Primary Personnel folder tab.

In the Project Manager field, type the User ID of the Contract’s Project Manager or perform a
Search.

Press the Tab key.

In the Project Engineer field, type the User ID of the Contract’s Project Engineer or perform a
Search.

Press the Tab key.
In the Contract Designer field, type the name of the Contract’s Designer.

To select a recipient to be notified when a Contract’s status changes from pending to active, tab to the
appropriate field and type the User ID or Distribution List name or perform a Search.

To select a recipient to be notified when a Contract’s progress falls behind schedule, tab to the
appropriate field and type the User ID or Distribution List name or perform a Search.

To select a recipient to be notified when a Contract’s civil rights monitoring generates an exception
report, tab to the appropriate field and type the User ID or Distribution List name or perform a
Search.
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13. Click the Save button.

5.4.6 Prime Contractor, Contacts, and Associates

The Prime Contractors folder tab lets the user add and delete the Prime Contractor, the Prime Contacts, and

the Prime Associates. The user can also specify the Prime Contractor’s payroll frequency and the maximum
percentage of the Contract work that can be subcontracted. If the Prime Contractor is in default, the user can
record the defaulted date and reason. The Prime Contractor entities are defined as follows:

Prime The Prime Contractor is the Contractor who is awarded the
Contractor Contract.

Prime Contacts The Prime Contacts are the Prime Contractor’s personnel who
are contact persons for the Contract. This includes safety
officers, Contractor supervisors, and EEO compliance officers.

Prime Associates | The Prime Associates are vendors who have a Contract-specific
relationship with the Prime Contractor. This includes the surety
and insurance companies that are supplying business services to
the Prime Contractor for the Contract.

EContocts | 1|1 1| 1] 11111 LI e = (.5
" Description = Location  Papment Data  Critical Dates © Primary Prime  DBE Commit Training Plan
Personnel Contractor

Contract ID:

Current Prime:
1l-

Pay
ITV Required  Freq in Weeks: ID ~ || Max Subcontract Pct: .o [v Subcontractors Paid

Bankruptey Date: |00/00/00 Bankruptcy Type Desc: |Spaces

Defaulted
[ Indicator  Reason: [Spaces Date: [00/00/00
Original Prime Contractor: | |

[~ Joint Yenture

Prime Contacts: Contact Name Contact Type ‘ User Id

Lm el sso ey Assoc Yendor ID Associate Short Name Associate Type ‘

Figure 5-7 The Prime Contractor Folder Tab

Field Name Description

Current Prime Transportation agency-defined Vendor ID and short name
for the current Prime Contractor. The user can search this
field. This is a required field. If the user changes the
current Prime Contractor, the data in the other fields is
deleted.
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Contracts

Field Name

Description

Defaulted Original
Prime Contractor

Transportation agency-defined Vendor ID and short name
for the original Prime Contractor who was awarded the
Contract and then defaulted.

Joint Venture

Indicates that the Contract was awarded to a joint venture.

Subcontractors Paid

Indicates whether or not the Prime Contractor has paid all
of the Subcontractors. This indicator is checked (ON) by
default.

Payroll Required

Indicates that certified payrolls are required for the
Contract. Must be checked (ON) for federal Contracts.
Must be checked (ON) to process payrolls in SiteManager.
If this indicator is checked, a Payroll Frequency in Weeks
must be entered.

Payroll Freq in Weeks

Weekly frequency that certified payrolls are required to be
received for the Contract. Every week (1), every 2 weeks
(2), every 4 weeks (4), etc. This field is required if the
Payroll Required indicator is checked. This value must be
entered before the Contract status is changed to active.

Max Subcontract Pct

Maximum percentage of the total Contract amount that the
Prime Contractor is allowed to subcontract (excluding
specialty items).

Bankruptcy Date Date the Prime Contractor filed for bankruptcy.
Bankruptcy Type Desc | Type of bankruptcy filed (e.g., Chapter 11 or Chapter 13).
Defaulted Indicator When checked (ON), the Defaulted Indicator indicates that
the Prime Contractor is in default and another Contractor
or surety has taken over responsibility for the Contract.
Defaulted Date The date the Prime Contractor defaulted. This field is
required if the Defaulted Indicator is checked (ON).
Defaulted Reason Reason the Original Prime Contractor is defaulted (e.g.,

performance or bankruptcy). This field is required if the
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Field Name Description

Defaulted Indicator is checked (ON).

Defaulted Reason Reason the Original Prime Contractor is defaulted (e.g.,
performance or bankruptcy). This field is required if the
Defaulted Indicator is checked (ON).

Prime Contact Name The name of the Contact person for the Prime Contractor.
The user can search this field.

Prime Contact Type Title of the Contact person for the Prime Contractor (e.g.,
EEO).

Prime Contact User ID | The transportation agency-defined user ID for the Prime
Contact, if one has been assigned.

Prime Assoc Vendor Transportation agency-defined ID for the Prime
ID Contractor’s Associate. Usually the Federal Tax ID. The
user can search this field.

Associate Short Name Short name for the Prime Contractor’s Associate.

Associate Type Type of Prime Contractor Associate (i.e., Surety,
Insurance, Escrow, Banking, Surety Agent, Escrow Agent,
Other Payee, Other)

Table 5-8 The Prime Contractor Folder Tab Fields Table

To add a Prime Contractor to a pending Contract:

1.
2.

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find.
Click the Prime Contractor folder tab.

In the Current Prime ficld, type the name of the Contract’s Current Prime Contractor or perform a
Search.

If a joint venture won the award, click the Joint Venture check box (ON). The Prime Contractor
must have Affiliates defined in the Vendor reference table.
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10.
11.

12.
13.
14.
15.
16.

Tip:

If the payrolls will be processed in SiteManager, in the Freq in Weeks drop-down field, click the
frequency of receipt in weeks.

Or
If the payrolls will not be processed in SiteManager, click the Payroll Required check box (OFF).
Press the Tab key.

In the Max Subcontract Pct field, type the maximum percentage of the total Contract amount that
the Prime Contractor is allowed to subcontract.

Click the Services menu and select Address.

Choose the Address that will be used as the Prime Contractor’s Payment Address.
Click the Services menu and choose Select Address.

(or click the Address button on the Toolbar).

Click the Save button.

To be selected as a Current Prime, a contractor must first be entered as a vendor in the Vendor

reference tables. To save a Contract, the Prime Contractor must have a Payment Address selected via the
Services menu.

To add a Prime Contactor to a Contract:

L.

7.
8.

Tip:

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find.
Click the Prime Contractor folder tab.

To add a Contact, click the Prime Contact Name field and click the New button. An empty row is
added to the list.

In the Prime Contact Name ficld, perform a Search. After the user selects a name, the system enters
the User ID.

In the Contact Type drop-down list, click the contact type.
Click the Save button.

To be selected as a Prime Contact, a contact person must first be entered as personnel of the Prime

Contractor on the Vendor Personnel folder tab.

To add a Prime Associate to a Contract:

L.

2.

5-36

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.

Click the Open button. The Select Contract list is displayed.
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3. In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find.
4. Click the Prime Contractor folder tab.
5. To add an Associate, click the Prime Assoc Vendor ID field and click the New button. An empty
row is added.
6. In the Prime Assoc Vendor ID field, perform a Search. After the user selects an ID, the system
enters the Associate Short Name and the Associate Type.
7. Click the Save button.
Tip: To be selected as a Prime Associate, a Vendor must first be selected as an Associate of the Prime

Contractor on the Vendor Associates folder tab. Every Contract requires two Associates—a surety company
and an insurance company.

To record a Prime Contractor’s defaulted status:

L.
2.

10.
11.

12.

13.

14.

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find.
Click the Prime Contractor folder tab.

If the Prime Contractor has filed for bankruptcy, in the Bankruptcy Date field, type the date the
bankruptcy was filed.

If the Prime Contractor has filed for bankruptcy, in the Bankruptcy Type Desc drop-down list, click
the bankruptcy type.

Click the Defaulted indicator. A message says that defaulting the Current Prime also removes the
Prime Contacts and Associates.

Click Yes to continue. The system removes the Prime Contacts and Associates and enters the
defaulted Prime Contractor in the Original Prime Contractor field.

In the Reason drop-down list, click the reason for defaulting.
In the Date field, type the date the Prime Contractor defaulted.

In the Current Prime ficld, type the name of the Contract’s new Current Prime Contractor or
perform a Search.

To add an Associate, click the Prime Assoc Vendor ID field and click the New button. An empty
row is added.

In the Prime Assoc Vendor ID field, perform a Search. After the user selects an ID, the system
enters the Associate Short Name and the Associate Type.

Click the Save button.
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Tip:  When the user places the Current Prime in defaulted status, the user must also select a new Current
Prime and Prime Associates. For example, the Original Prime Contractor’s surety company can be selected as

the Current Prime.

5.4.7 DBE Commitments

The DBE Commit folder tab lets the user add and modify the DBE goal percentage and view the DBE
commitments for a Contract. If the Prime Contractor is a DBE, the user can also enter the DBE Work Class
on this folder tab. The system calculates the DBE commitment amounts displayed on this folder tab using
values entered on the Subcontracts window.

5 Contracts =]
Description Lacation Payment Data  Critical Dates PFrirnary Prime DBE Commit Training Flan
Personnel Contractar

Contract 1D: I DBE Work Class: |Spaces
DBE Goal Percent: I IDU DBE Goal Value: |$.EID

— DBE Commitment

Original Amount: I $.00
Total Current Pct: I .00

Total Current Amount: I $.00

—Total DBE Subcontracts

Installed to Date: |—$DD
Towards Goal: $.00
Mot Towards Goal: $.00
Amount: |—$DD

Figure 5-8 The DBE Commit Folder Tab

Field Name Description

DBE Work Class The Prime Contractor’s DBE Work Class for the Contract. This
value can only be entered if the Prime Contractor is a DBE.

DBE Goal Percent DBE goal percentage for the Contract. This value can be
modified.

DBE Goal Value DBE goal amount for the Contract. The system calculates this
field by multiplying the Contract bid amount by the DBE goal
percentage.

DBE Commitment

5-38
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Field Name Description
DBE Commitment DBE commitment amount at award of the Contract.

Original Amount

DBE Commitment Percentage of the current DBE commitment on the Contract.
Total Current Pct The system calculates this value by dividing the total current
amount of the DBE commitment by the Contract bid amount.

DBE Commitment Sum of the current DBE commitments for all Subcontracts to
Total Current Amount | date. Calculated by the system.

Total DBE Subcontracts

Installed to Date Installed to Date amount for all DBE Subcontracts in the
Contract. The sum of all DBE Subcontract reported Item
quantities multiplied by the Item prices.

Towards Goal Subcontract amount counted towards the DBE commitment
goal. The sum of the DBE Subcontract amounts multiplied by
the DBE goal percentage.

Not towards Goal Subcontract amount not counted towards the DBE commitment

goal. The sum of the DBE Subcontract amounts minus the
amount counted towards the DBE commitment goal.

Amount Sum of all the DBE Subcontract amounts for the Contract.

Table 5-9 The DBE Commitments Folder Tab Fields Table

To modify the DBE goal percentage for a Contract:

L.
2.

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the DBE Commitments folder tab.

If the Prime Contractor is a DBE, in the DBE Work Class drop-down list, click the expand arrow to
the right of the current selection and click the DBE Work Class.

August 2005 5-39



Trnseport SiteManager®
Contract Administration - New Contracts Contracts

6. In the DBE Goal Percent field, type the DBE goal percentage for the Contract. The remaining fields
are calculated by the system.

7. Click the Save button.

5.4.8 Training Plan

The Training Plan folder tab lets the user view, add, and modify the Prime Contractor’s on-the-job-training
commitments for a Contract. If the Contract includes the training plan as a Line Item, the system enters the
training plan and the user can not modify it. If training is not a Line Item, the user can enter the plan. The plan
consists of the total training hours for the Contract, the hourly (unit) price to be used for reimbursement, and
the approximate number of trainees. This data is used by the estimate process to reimburse the Prime
Contractor.

If a training plan is specified, the trainees must be entered on the Trainees window in Civil Rights. The
training plan hour usage is typically entered through certified payrolls. To accrue training plan hours, the
trainee data (names, SSN/SIN numbers, and training program) must match the payroll employee data. The
Total Hours Used to Date field is updated automatically via the Accrue Training Experience batch process.
The hours are accrued from certified payrolls that include trainee data. The Total Hours Paid to Date field is
calculated during the estimate generation process. For more information, refer to the Civil Rights, Contractor
Payroll, and Contract Adjustment topics.

Tip: If the training plan is a Line Item, it must be a single Line Item. The Training Plan folder tab retrieves
only the first Item Code of the type (metric or English) specified in the system operational parameter table.

5 Contracts !E E

T T T
Description Location Payment Data ~ Critical Dates Primary Prime DEE Commit Training
Personnel Contractor Plan

Contract 1D: |

Planned Training Hours: § Total Hours Used To Date:l 0

Training Unit Price: | $.00 Total Hours Paid To Date: | 0

Planned Number of Trainees: | Actual Humber of Trainees: | 0

Figure 5-9 The Training Plan Folder Tab
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Field Name Description

Planned Training Hours | Specifies the planned number of training hours committed by
the Prime Contractor. If specified by a training Item Code,
this field defaults to the Item’s bid quantity and can not be

modified.
Planned Number of Specifies the planned number of trainees committed by the
Trainees Prime Contractor. If specified by a training Item Code, this

field defaults to the Item’s bid quantity divided by the system
operational parameter‘s average training program hours and
can not be modified.

Training Unit Price Specifies the hourly (unit) price to reimburse a Prime
Contractor for training hours logged via Contractor Payrolls.
If specified by a training Item Code, this field defaults to the
Item’s bid unit price and can not be modified.

Total Hours Used To Total number of hours used by the trainees on the Contract to
Date date. This value is calculated by a batch process using data
from Contractor Payrolls and Civil Rights. The user can
modify this value by entering DOT Hours on the Trainee

window.
Actual Number of Actual number of trainees allocated to the Contract. This
Trainees value is calculated by a batch process using Trainee data from
Civil Rights.
Total Hours Paid To Total number of hours used by the trainees on the Contract
Date after the last paid date. This value is calculated during

estimate generation.

Table 5-10 The Training Plan Folder Tab Fields Table
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To add a Training Plan to a Contract:

L.
2.

0.

10.

5.4.9

On the Contract Records panel, double-click the Contracts icon. The Contracts window opens.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a Find. The
Select Contract list closes and the Description folder tab is displayed.

Click the Training Plan folder tab.
In the Planned Training Hours ficld, type the number of planned training hours.
Press the Tab key.

In the Training Unit Price field, type the unit price (hourly) that the Contractor will be reimbursed
for training.

Press the Tab key.
In the Planned Number of Trainees ficld, type the number of trainees.

Click the Save button.

Custom Records

The Custom Contract Record Usage window is a Services menu option on the Contracts window. The
Custom Contract Record Usage window lets the user add and modify Contract data on a custom template. The
user selects a custom template on the window, and the window displays the selected template. If data has been
entered on this template for the selected Contract, the data is displayed. The templates are created by the
System Administrator.

5-42

ﬂtuslom Contract Record Usage =] E3

Contract: S|TEMGRE 30 I Template Id: | .

Template Name:| |

a1 o

Figure 5-10 The Custom Contract Record Usage Window
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Field Name Description
Contract Transportation agency-defined ID for the selected
Contract.
Template ID Templates available for selection. The user can search
this field.
Template Name Name of the template selected on the window.

Table 5-11 The Custom Contract Record Usage Window Fields Table

To modify custom records:

L.

On the Contract Records panel, double-click the Contracts icon. The Contract Description folder
tab is displayed.

Click the Open button. The Select Contract window opens.
In the Contract list box, scroll to and double-click the Contract ID.

Click the Services menu and click the Custom Record choice. The Custom Contract Record Usage
window opens.

In the Template ID field, type the template ID or perform a Search. The window displays the
template.

Add or modify the data.

Click the Save button.

5.5 Contract Milestones

The Milestone window lets the user add, modify, and delete Contract Milestones. The user can enter an
incentive or disincentive rate for each milestone, and specify either days or hours to be used in calculating the
amount to be paid or withheld. The user also enters the dates the milestone work was started and completed.
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EMileslones H=] B3
Contract ID: SITEMGR_30
Mistn Description Time Cur Mlstn =
Hbr Used(%) | Cmpl Date
00/00/00
-
4 I I 3
Milestone Mbr: Descriptiol )
Time Ch vi Bid Days: | Charged: 0 Adjusted: 0
Rate Time Period: |:E Bid Hours:l Remaining: 0 Credit Days: 0
Date — Time [ Aut Disit tind [ Preconstruction Ind
Work Start:| 00/00/00 [ 00:00 [~ Autogen Incentive Ind [ Milestone Compl Ind
Original Milestone Compl: | 00/00/00 | 00:00 Incentive Rate Amt: l—m
Current Milestone Compl: | 00/00/00 | 00:00 Disi tive Rate Amt: .00
Actual Completion: [ 00/00/00 [ 0C:00 Incentive Cap Amk: [—$UU

Figure 5-11 The Milestones Window

Field Name

Description

Milestone Nbr

System-generated sequential number of the milestone. This
value can not be modified.

Description

Text description of the milestone.

Time Charges

How time charges are assessed for the Contract. Can be
Available Work Days, Calendar Days, or Fixed Completion
Date.

Bid Days

The original number of days bid for the milestone. This field is
required if the Time Charges value is Available Work Days or
Calendar Days and the Rate Time Period value is Days. A
value can not be entered if the Time Charges value is Fixed
Completion Date.

Charged

The total number of days charged to the milestone to date.
Calculated by the system. Can be Available Work Days or
Calendar Days, depending on the Time Charges entry. This
field is empty if the Time Charges value is Fixed Completion
Date.

Adjusted

Adjustment to the days charged for a milestone. This value is
provided by the Change Order function.
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Field Name Description

Remaining Total days remaining to complete the milestone work on time.
This value is calculated by the system [(Bid Days + Adjusted
Days) - Charged Days].

Credit Days The total number of credit days recorded for the milestone to
date. Calculated by the system.

Bid Hours The original number of hours for the milestone. This field is

required if the Time Charges value is Available Work Days or
Calendar Days and the Rate Time Period value is Hours. The
Bid Hours value must be evenly divisible by 12. A value can
not be entered if the Time Charges value is Fixed Completion
Date.

Original Milestone
Compl Date

Original date the milestone is to be completed. If the Time
Charges entry is Calendar Days, the system calculates this
value (Work Start Date + Bid Days). This field is required if
the Time Charges entry is Fixed Completion Date.

Original Milestone
Compl Time

Original time the milestone is to be completed. Calculated
from the Work Start Time if the Time Charges entry is
Calendar Days (Work Start Time + Hours).

Current Milestone
Compl Date

Current expected date of completion. Calculated by the system.
The Change Order function enters this date when time
adjustments for milestones are approved. For new milestones,
this field defaults to the milestone’s original completion date.

Current Milestone
Compl Time

Current expected time of completion. Always calculated from
the Work Start Time if the Time Charges entry is Available
Work Days or Calendar Days (Work Start Time + Hours).

Actual Completion
Date

The date the work was completed for the milestone. Must be
greater than or equal to the Work Start Date.

Actual Completion
Time

The time the work was completed for the milestone.
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Field Name Description

Work Start Date The date the work is expected to begin and time is charged
against the milestone. Must be less than or equal to the Current
Milestone Completion Date.

Work Start Time The time the work is expected to begin and time is charged

against the milestone.

Incentive Rate Amt

Rate in dollars paid to the Contractor if the milestone work has
progressed beyond expectations.

Disincentive Rate Amt

Rate in dollars the Contractor is to be penalized if the
milestone work has not progressed to expectations.

Incentive Cap Amt

Maximum incentive amount allowed for this milestone.

Rate Time Period

The rate time period (days or hours) is used to calculate the
incentive or disincentive for the milestone.

Autogen Disincent Ind

Indicates whether or not a disincentive is automatically
generated for the milestone.

Autogen Incentive Ind

Indicates whether or not an Incentive is automatically
generated for the milestone.

Preconstruction Ind

Indicates that the data was entered from a Pre-construction
system and can not be modified.

Milestone Compl Ind

Indicates that the Milestone work is completed.

Table 5-12 The Milestones Window Fields Table

August 2005

Contract Milestones




Trnseport SiteManager®

Contract Milestones Contract Administration - New Contracts

To add a Milestone with time charges of Available Work Days or Calendar Days:

L.

10.
1.

12.
13.

14.
15.
16.

On the Contract Records panel, double-click the Milestones icon. The Milestone window opens and
a Contract select list is displayed.

In the Contract ID list box, scroll to and double-click the Contract. The Milestones for the selected
Contract are displayed.

Click the New button. An empty row is inserted in the Milestone list box.
In the Description field, type a description of the Milestone.

In the Time Charges drop-down list, click the expand arrow and click Available Work Days or
Calendar Days.

In the Rate Time Period drop-down list, click the expand arrow and click either Hours or Days to be
used for the incentive or disincentive calculation.

If the Rate Time Period is days, in the Bid Days field, type the number of days bid for the milestone.

If the Rate Time Period is hours, in the Bid Hours field, type the number of hours bid for the
milestone.

To generate a disincentive automatically, click the Autogen Disincent Ind check box (ON).
To generate an incentive automatically, click the Autogen Incentive Ind check box (ON).

In the Incentive Rate Amt field, type the rate in dollars a Contractor is to be compensated if work
has progressed beyond expectations.

Press the Tab key.

In the Disincentive Rate Amt field, type the rate in dollars a Contractor is to be penalized if work has
not progressed to expectations.

Press the Tab key.
In the Incentive Cap Amt field, type the maximum incentive amount for this milestone.

Click the Save button. The system enters the next sequential Milestone Number for the new
Milestone.

To add a Milestone with a Fixed Completion Date:

L.

On the Contract Records panel, double-click the Milestones icon. The Milestone window opens and
a Contract select list is displayed.

In the Contract ID list box, scroll to and double-click the Contract. The Milestones for the selected
Contract are displayed.

Click the New button. An empty row is inserted in the Milestone list box.

In the Description field, type a description of the Milestone.
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5. In the Time Charges drop-down list, click the expand arrow and click Fixed Completion Date.
6. Inthe Rate Time Period drop-down list, click the expand arrow and click either Hours or Days to be
used for the incentive or disincentive calculation.
7. In the Original Milestone Compl Date field, type the date the Milestone is to be completed.
8. In the Original Milestone Compl Time field, type the time the Milestone is to be completed.
9. To generate a disincentive automatically, click the Autogen Disincent Ind check box (ON).
10. To generate an incentive automatically, click the Autogen Incentive Ind check box (ON).
11. In the Incentive Rate Amt field, type the rate in dollars a Contractor is to be compensated if work
has progressed beyond expectations.
12. Press the Tab key.
13. In the Disincentive Rate Amt field, type the rate in dollars a Contractor is to be penalized if work has
not progressed to expectations. Press the Tab key.
14. In the Incentive Cap Amt field, type the maximum incentive amount for this milestone.
15. Click the Save button. The system enters the next sequential Milestone Number for the new
Milestone.
Tip:  The user can not enter values for Milestone Number, Current Milestone Completion Date, and

Current Milestone Completion Time.

To record a Milestone Actual Completion date:

L.

5-48

On the Contract Records panel, double-click the Milestones icon. The Milestone window opens and
a Contract select list is displayed.

In the Contract ID list box, scroll to and double-click the Contract. The Milestones for the selected
Contract are displayed.

In the Milestone list box, scroll to and click the milestone. Data for the selected Milestone is
displayed in the fields below.

In the Actual Completion Date field, type the date of completion.
Press the Tab key.
In the Actual Completion Time field, type the time of completion.

Click the Save button.
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To delete a Milestone:

L.

S.
6.

Tip:

On the Contract Records panel, double-click the Milestones icon. The Milestone window opens and
a Contract select list is displayed.

In the Contract ID list box, scroll to and double-click the Contract. The Milestones for the selected
Contract are displayed.

In the Milestone list box, scroll to and click the milestone. Data for the selected Milestone is
displayed in the fields below.

Click the Delete button. The system asks the user to confirm the deletion.
Click Yes.
Click the Save button.

A Milestone can not be deleted if it has an associated record, such as a Change Order or an Estimate

Adjustment, or if the Contract is checked out to the field.

5.6 Projects

The Projects window contains descriptions of the Contract Projects. Every Contract must have at least one
Project. The Projects window folder tabs are described in the following table.

Description The Description folder tab displays the Project description. The user
can add, modify, and delete the Project data.

Counties The Counties folder tab displays a list of available counties and a list
of those associated with the selected Project. The user can add and
remove counties to and from the Project.

Adjustment The Adjustment Indices folder tab displays a list of available price
Indices adjustment indices and a list of those associated with the selected
Project. The user can add and remove price adjustment indices to
and from the Project.

Table 5-13 The Projects Window Folder Tab Fields Table
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5 Projects M=l E
Description Counties Adjustment Indices

Contract I1D: |SITEMI3F!_3IJ

Project Nbr= """ Fed St Prj Nbr: | Alt Pri ID:
Descrnption: | Spec Yr: W
Description: | Unit Sys: IEngT
Status: [Spaces [ I Complete Auth Pay Limit: 5000 |
[” Release Retainage Acct Prj Nbr: I—
Pri Type: Work Type: Surface Type:

Route Nbr: | Sect Nbr: | Road System:

Road Name: |

Location: | Engr Pct: IEIAEIEIEID
Location: | Work Site:

Beg Sta: I Beg Telmini:l Latitude: IEI
End Sta: I End Telmini:l Longitude: IEI

Figure 5-12 The Project Description Window
To access the Project Description folder tab:

1. On the Contract Records panel, double-click the Projects icon. The Project window opens with the
Description folder tab selected by default.

5.6.1 Project Description

The Project Description folder tab lets the user add, modify, and delete Projects. New Projects can be added
while the Contract is in pending or active status. To add a Project to an active Contract, an authorized user
may create the Project on the Project Description folder tab of the Project window. Before any items may be
added to a new project, at least one category and one funding source must be associated to that project. A
Project with dependent data, such as Categories or Items, can not be deleted. When a Contract has multiple
Projects, the user must select the primary Project on the Contract Description folder tab.

Field Name Description

PCN Transportation agency-defined Project Control Number. This
field is required.

Fed St Prj Nbr The federal/state number for the Project. Must be unique within
a Contract. Can not be modified after an estimate has been
generated. This field is required.

Alt Prj ID Alternate transportation agency-defined ID for the Project. Can
not be modified after an estimate has been generated.
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Field Name Description

Auth Pay Limit The Authorized Payment Limit is used to determine if a
voucher will be processed. If the total payments exceed this
amount, the voucher will not be processed. Leaving this field
blank indicates that no cap exists for total payments. The
Authorized Payment Limit can not be modified after an
estimate has been generated.

Status Indicates the current status of a Project (e.g., Complete,
Construction, Active Construction, Awaiting Award).

Acct Prj Nbr An accounting department-defined Project number. Can not be
modified if an estimate has been generated.

Engr Pct The engineering construction percentage represents the state or
province’s cost of managing a Project. This percentage of the
total Project Item amounts can be used to compute the total
Project estimated cost as follows: [total Project Item amount X
(100 + Engr Pct)]

Description Text description of the Project. This field is required. Two lines
are provided.

Prj Type Identifies the type of Project (e.g., Federal). This field is
required.
Work Type Transportation agency-defined code that identifies the major

type of work being done in the Project (e.g., Grading,
Widening, Overlay, Construction). This field is required.

Surface Type Type of surface grading used in the Project (e.g., Asphalt).
Road Name Name of the road where the Project work is done.

Route Nbr Route number where the Project work is done.

Road System Type of road system where the Project work is done (e.g.,

interstate, federal highway, state highway, or county highway).
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Field Name Description

Sect Nbr Road section number where the Project work is done.

Location Description of the physical location of the Project. This field is
required. Two lines are provided.

Work Site Identifies the landscape of the Project work site (e.g., Urban).

Beg Sta Precisely defines the station number where the Project work
begins.

Beg Termini Precisely defines the termini where the Project work begins.

Latitude The midpoint latitude of the Project location.

End Sta Precisely defines the station number where the Project work
ends.

End Termini Precisely defines the termini where the Project work ends.

Longitude The midpoint longitude of the Project location.

Complete Indicates that the Project work is complete.

Release Retainage Indicates that the Project Retainage is to be automatically
released when the Project status is changed to complete.

Table 5-14 The Projects Description Folder Tab Fields Table

To add a Project to a Contract:

1.
2.
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On the Contract Records panel, double-click the Projects icon. The Projects window opens.

To select a Contract, click the Services menu and click the Choose Keys choice. The Select Contract
ID window opens.

In the Contract ID list box, scroll to and click the Contract.
Click Ok. The Project window opens with the selected Contract ID displayed in the Contract ID field.

In the PCN field, click the Open button, highlight the desired PCN and click Ok.
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10.
1.

12.
13.
14.
15.

16.
17.

18.

19.

20.
21.
22.
23.
24.

25.

26.
27.

28.

Press the Tab key.

In the Fed St Prj Nbr field, select the current entry and type the federal or state Project number.
Press the Tab key.

In the Alt Prj ID field, select the current entry and type an alternate ID.

Press the Tab key.

In the Description field, type a description of the Project. If necessary, tab to the next line and add to
the description.

In the Status drop-down list, click the expand arrow and click the current status of the Project.
To indicate that the Project is complete, click the Complete check box (ON).
In the Auth Pay Limit field, select the current entry and type a limit value for payment.

To automatically release Retainage when the Project is completed, click the Release Retainage check
box (ON).

In the Acct Prj Nbr field, select the current entry and type an accounting Project number.

In the Prj Type drop-down list, click the expand arrow to the right of the current selection and click
the Project type.

In the Work Type drop-down list, click the expand arrow to the right of the current selection and
click the work type.

In the Surface Type drop-down list, click the expand arrow to the right of the current selection and
click the surface type.

In the Route Nbr field, select the current entry and type the affected route number.
Press the Tab key.

In the Sect Nbr field, select the current entry and type the affected section number.
In the Road System field, select the current entry and type the road system type.

In the Road Name field, select the current entry and type the name of the road affected by the
Project.

In the Location field, type a description of the location. If necessary, tab to the next line and add to
the description.

Press the Tab key.

In the Engr Pct field, select the current entry and type the percentage of the Project cost charged to
the state or province.

In the Urb/Rural drop-down list, click the expand arrow and click Urban or Rural.
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29. In the Beg Sta field, select the current entry and type the station where the work begins.
30. Press the Tab key.
31. In the End Sta field, select the current entry and type the station where the work ends.
32. Press the Tab key.
33. In the Beg Termini field, select the current entry and type the termini where the work begins.
34. Press the Tab key.
35. In the End Termini field, select the current entry and type the termini where the work ends.
36. Press the Tab key.
37. In the Latitude ficld, select the current entry and type the midpoint latitude of the job.
38. Press the Tab key.
39. In the Longitude ficld, select the current entry and type the midpoint longitude of the job.

40.

Click the Save button.

To delete a Project:

1.
2.

Tip:

On the Contract Records panel, double-click the Projects icon. The Projects window opens.
To select both a Contract and a Project, click the Open button. The Select Contract ID window opens.

In the Contract ID list box, scroll to and double-click the Contract. The Project List for the selected
Contract is displayed.

In the Project list box, scroll to and click the Project.
Click Ok. The Projects window displays data for the selected Project.
Click the Delete button. The system asks the user to confirm the deletion.

Click Yes. When the Project is deleted, the corresponding Project counties and adjustment indices are
also deleted.

If the selected Project has dependent data such as Categories or Items associated to it, the Project

cannot be deleted.

5.6.2

Project Counties

The Counties folder tab lets the user add and remove counties to and from the Project. For every county
included in the Project, the user must enter the percentage of the Project work to be done in the county. The
percentages for all counties must add up to 100%.

Tip:  To select the Counties folder tab, the user must open or create a Project record on the Description
folder tab.
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E Projects =] B3

Description Counties Adjustment Indices

Contract ID: |SITEMGR_30

Project Nbr: IF'FIDJ-D‘I Fed State Project Nbr: INDNE
Description: [I0B DESCRIPTION NO. 233-059-508
Location: [FROM: FOUTE 1 TO:ROUT 99

Project County
ALBEMARLE

Available Counties | Proj Len %

j Add > |
Add All ->> I
<- Remove |
<<- Rem All I

of

KN
Figure 5-13 The Project Counties Folder Tab

Field Name Description

Fed State Project The federal or state Project Number for the Contract or Project.

Number

PCN Transportation agency-defined Project Control Number.

Description Description of the Project.

Location Description of the Project location.

Available Counties Counties included in the Contract that have not been associated
with this Project.

Project Counties Counties that have been associated with this Project.

Proj Len % Percentage of the total length of the work to be done in each
county. This field is required for every Project county. The
percentages for all counties must add up to 100%.

Table 5-15 The Project Counties Folder Tab Fields Table
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Button Description
Add The Add button adds a county to the Project. If all available counties

have been associated with the Project, this button is disabled.

Add All The Add All button adds all the counties to the Project. If all available
counties have been associated with the Project, this button is disabled.

Remove The Remove button removes a county from the Project. There will be
no message confirming the removal.

Remove All The Remove All button removes all the counties from the Project.
There will be no message confirming the removal.

Table 5-16 The Project Counties Folder Tab Buttons Table

To add a Project County:
1. On the Contract Records panel, double-click the Projects icon. The Projects window opens.
2. To select both a Contract and a Project, click the Open button. The Select Contract ID window opens.
3. In the Contract ID list box, scroll to and double-click the Contract. The Projects for the selected
Contract are listed.
4. In the Project list box, scroll to and click the Project.
5. Click Ok. The Projects window opens with the Description folder tab displayed and data for the
selected Project displayed in the fields.
6. Click the Project Counties folder tab.
7. In the Available Counties list box, scroll to and click the county or ctrl-click multiple counties. To
deselect a county, click it again.
8. Click the Add button. The selection is added to the Project County list on the right.
9. Ineach Proj Len % field, type the percentage of the Project work to be done in the county.
10. Click the Save button.
5.6.3 Project Price Adjustment Indices

The Adjustment Indices folder tab lets the user add or delete a Price Adjustment Index to or from a Project.
Price Adjustment Indices are used to adjust the cost of Items that are known to have fluctuating prices, such
as gas and oil products. If the user adds an Item’s Price Adjustment Index to a Project, the index will be used
during estimate generation to calculate the cost of the Item.
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Tip:  To select the Adjustment Indices folder tab, the user must open or create a Project record on the
Description folder tab.

5 Projects =] 3
Deszcription Counties Adjustment Indices

Contract ID: ISITEMGF!_SEI

Project Nbr: |PF|DJ-EI1 Fed State Project Nbr: |NDNE
Description: [I0B DESCRIPTION NO. 233-053-508
Location: |FF|E|M: FOUTE 1 TO:ROUT 93

Available Price Indices % Indx Type| Project Pay Adimnt Indices

FUEL 0.23 GALACY Add > | S001 Fuel Adjustment

FOO3 FUEL 0.20 GAL/TON

Fam FUEL 1.44 L/CU M Gl 55

F202 FUEL 0.83 L/MTON
<- Remove
PO —l

powder fill adjustment

POD2 ASPHALT 5.8% <<- Rem All |

Figure 5-14 The Adjustment Indices Folder Tab

Field Name Description

Fed State Project Federal or state Project Number for the Project.

Number

PCN Transportation agency-defined Project Control Number.

Description Description of the Project.

Location Description of the Project location.

Indx Type Identifying code of a Price Adjustment Index.

Available Price Indices | Price Adjustment Indices that can be associated with this
Project.

Project Pay Adjmnt Price Adjustment Indices that have been selected for this

Indices Project.

Table 5-17 The Adjustment Indices Folder Tab Fields Table
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Button Description
Add The Add button adds the selected price adjustment index to the

Project. If all available indices have been associated with the
Project, this button is disabled.

Add All The Add All button adds all the price adjustment indices to the
Project. If all available indices have been associated with the
Project, this button is disabled.

Remove The Remove button removes the price adjustment index from the
Project. There will be no message confirming the removal. If no
indices are associated with the Project, this button is disabled.

Remove All The Remove All button removes all the price adjustment indices
from the Project. There will be no message confirming the
removal. If no indices are associated with the Project, this button is
disabled.

Table 5-18 The Adjustment Indices Folder Tab Buttons Table

To add a Project Price Adjustment Index:

1.
2.
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On the Contract Records panel, double-click the Projects icon. The Projects window opens.
To select both a Contract and a Project, click the Open button. The Select Contract ID window opens.

In the Contract ID list box, scroll to and double-click the Contract. The Projects for the selected
Contract are listed.

In the Project list box, scroll to and click the Project.

Click Ok. The Projects window opens with the Description folder tab displayed and data for the
selected Project displayed in the fields.

On the Projects window, click the Adjustment Indices folder tab.

In the Available Price Indices list box, scroll to and click the index or ctrl-click multiple indices. To
deselect an index, click it again.

Click the Add button. The selection is added to the Project Pay Adjmnt Indices list on the right.

Click the Save button.
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5.7 Categories

The Categories window lets the user add, modify, and delete Categories. Categories are typically used to
group Items within a Project that are to be funded by the same source. To do this, the user can create a
Category, associate Items with the Category, and select a funding source for the Category. Each Category in a
Project can have a different funding source. A Category with Items associated to it can not be deleted.

The Categories window lists the Categories for the selected Contract and Project. The window displays
detailed data for the selected Category below the list. After a Category is saved, the Project Control Number
(PCN) and Category number can not be modified. The Project Number can not be modified after an estimate
has been generated. When a new project is being added to a contract, at least one category must be associated
to the new project.

Etategolies !EE
Contract 1D: [SITEMGR_O1 PCN: [LT18534BD6S-1
Category Humber Description Work Class Type
‘F’.EE ULAR BID ITEMS RECOMDITIONING
-
4 I I 4
Catg Nbr: [0005 Fed St/Pr Prj Nbr: [NH-435-5[031)/0435029F 28
Desc: [REGULAR BID ITEMS Length: |.UE|5‘I
| Width: |50.0000
Catg Wrk Cls Type:l vi Bridg ID:| Engr Pct: |.DEI

Brdg Type: |S paces

Fed Wrk Catg Type: Brdg Span Nbr: I— Rd Sect Hbr: I—
Fed Wik Cls Type: Brdg Length: IW Hwy Nbr: l—

Suppl Wik Cls Type: Brdg Width: IW Hwy Type:

Beg Sta Nbr: I— Beg Termini: I— Unit Nbr: W

End 5ta Nbr: I— End Termini: I— Desc:|

Figure 5-15 The Category Window

Field Name Description

Catg Nbr Category number assigned to Items during Pre-construction.
Items can be grouped in Categories, primarily for funding. This
number must be unique within a Project. The Category Number
can not be modified. Erroneously created Categories must be

deleted.
PCN Transportation agency-defined Project Control Number.
Fed St/Pr Prj Nbr Federal, state, or province Project Number for the Category. If

not entered, defaults to the Fed St/Pr Prj Nbr for the Project.
The user can find, filter, and sort this field.
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Field Name Description
Desc Description of the Category. Two lines are provided. The user

can find, filter, and sort these fields.

Length The length of road represented by this Category. If more than
one Category contains work for the same portion of road, the

length is split between them. The user can find, filter, and sort
this field.

Width The width of road represented by this Category. If more than
one Category contains work for the same portion of road, the
width is split between them. The user can find, filter, and sort
this field.

Catg Wk Cls Type Classification of work for a Category within a Project (e.g.,
Roadway Construction, Bridge Construction, Beautification,
Furnished Materials, Utilities).

Bridge ID Transportation agency-defined value that identifies a bridge or
other structure. This field is empty if the Category does not
represent structure work. The user can find, filter, and sort this
field.

Engr Pct Engineering construction percentage that represents the state or
province’s cost of managing a Category. This percentage of the
total Category Item amounts can be used to compute the total
Category estimated cost as follows: [total Category Item
amount X (100 + Engr Pct)]. The user can find, filter, and sort
this field.

Brdg Type Type of bridge represented by this Category (e.g., Concrete
Bridge, Steel Bridge, First Tier Overpass, Second Tier
Overpass). This value can not be modified if the Bridge ID
field is empty.

Fed Wrk Catg Type Identifies the type of work for the Category (e.g., General,
Roadway, Construction & Engineering, Alternates).

Bridge Span Nbr Number of spans within the bridge structure. Protected if the
Bridge ID field is empty.
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Field Name Description

Rd Sect Nbr Road section number where the Category work is done. The
user can find, filter, and sort this field.

Fed Wrk Cls Type Class of construction used for the Category (e.g., General,
Roadway, Construction & Engineering, Alternates).

Brdg Lth Length of the structure represented by this Category. Protected
if the Bridge ID field is empty.

Hwy Nbr Highway number where the primary Category work is done.
The user can find, filter, and sort this field.

Suppl Wrk Cls Type Federal supplementary work class for a Category (e.g.,
Emergency Evacuation Routing, Rest Areas, Safety
Improvements).

Brdg Wth The width of the structure represented by this Category.
Protected if the Bridge ID field is empty.

Hwy Type Highway type where the primary Category work is done.
Transportation agency-defined values such as interstate, state
route, county route, and rest area.

Beg Sta Nbr Precisely defines the station number where the Category work
begins. The user can find, filter, and sort this field.

Beg Termini Precisely defines the termini where the Category work begins.
The user can find, filter, and sort this field.

End Sta Nbr Precisely defines the station number where the Category work
ends. The user can find, filter, and sort this field.

End Termini Precisely defines the termini where the Category work ends.

Unit Nbr Unit Number under which the Category is grouped. Categories
can be grouped under a Unit Number for reporting purposes.
The user can find, filter, and sort this field.

August 2005 5-61



Trnseport SiteManager®

Contract Administration - New Contracts Categories
Field Name Description
Desc Description of the Unit Number under which the Category is
grouped. Categories can be grouped under a Unit Number for
reporting purposes. The user can find, filter, and sort this field.

Table 5-19 The Category Window Fields Table

To add a Category to a Project:

1.
2.

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
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On the Contract Records panel, double-click the Categories icon. The Categories window opens.

To select both a Contract and a Project, click the Open button. The Select Contract Project window
opens.

In the Contract ID list box, scroll to and double-click the Contract. The Projects for the selected
Contract are listed.

In the Project list box, scroll to and click the Project.

Click Ok. The Categories window opens with data for the first Category on the list displayed in the
fields below the list.

Click the New button.
In the Catg Nbr field, type the Category Number.
Press the Tab key.

To change the default Project Number in the Fed St/Pr Prj Nbr ficld, select the current entry and
type the Project Number for the Category.

Press the Tab key.

In the Desc field, type a description of the Category.

Press the Tab key.

In the Length field, type the length of road represented by this Category for the selected Project.
Press the Tab key.

If necessary, in the second Desc ficld, add a second line to the description of the Category.
Press the Tab key.

In the Width field, type the width of road represented by this Category for the selected Project.
In the Catg WKk Cls Type drop-down list, click the expand arrow click the work class type.

Press the Tab key.
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20.
21.
22.
23.
24.

25.
26.
27.

28.
29.
30.
31.
32.

33.
34.
35.

36.

37.

38.
39.
40.
41.
42.
43.

To identify a structure, in the Bridge ID field, type an agency-defined value to identify the structure.
Press the Tab key.

In the Engr Pct field, type the engineering construction percentage.

Press the Tab key.

If a structure has been entered in the Bridge ID field, in the Brdg Type drop-down list, click the
expand arrow and click the bridge type.

In the Fed Wrk Catg Type drop-down list, click the expand and click the work category type.
Press the Tab key.

If a structure has been entered in the Bridge ID field, in the Bridge Span Nbr field, type the number
of spans.

Press the Tab key.

In the Rd Sect Nbr ficld, type the road section number where construction will take place.

In the Fed Wrk Cls Type drop-down list, click the expand arrow and click the work class type.
Press the Tab key.

If a structure has been entered in the Bridge ID field, in the Brdg Lth field, type the length of the
structure.

Press the Tab key.
In the Hwy Nbr field, type the primary work roadway number.

In the Suppl Wrk Cls Type drop-down list, click the expand arrow and click the federal
supplementary work type for the Category.

If a structure has been entered in the Bridge ID field, in the Brdg Wth field, type the width of the
structure.

In the Hwy Type drop-down list, click the expand arrow and click the type of the primary work
roadway.

Press the Tab key.

In the Beg Sta Nbr field, type the station number where the work begins.
Press the Tab key.

In the Beg Termini ficld, type the termini where the work begins.

Press the Tab key.

To group this Category in a Unit with other Categories, in the Unit Nbr field, type the unit number.
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44. Press the Tab key.
45. In the End Sta Nbr field, type the station number where the work ends.
46. Press the Tab key.
47. In the End Termini field, type the termini where the work ends.
48. Press the Tab key.
49. If a Unit number has been entered in the Unit Nbr field, in the Desc field, type a description of the

50.

Unit.

Click the Save button.

To delete a Category:

1.

On the Contract Records panel, double-click the Categories icon. The Categories window opens.

2. To select both a Contract and a Project, click the Open button. The Select Contract Project window
opens.
3. In the Contract ID list box, scroll to and double-click the Contract. The Projects for the selected
Contract are listed.
4. In the Project list box, scroll to and click the Project.
5. Click Ok. The Categories window opens with data for the first Category on the list displayed in the
fields below the list.
6. In the Category list box, scroll to and click the Category. The fields display data for the selected
Category.
Tip: A Category can only be deleted if there are no Items associated to it.
5.8 Items

The Items window lets the user add, modify, and delete Items on the selected Contract and Project. The
transportation agency defines standard Items and lists them on the Item Master. The user can add an Item to a
Contract by selecting the Item from the Item Master. While the Contract is pending, this can be done on the
Items window. After the Contract is active, Items are added through Change Orders. The Items window
fields have specific display, protection, and calculation requirements depending on whether or not the data
was added through a Change Order. These requirements are included in the field definitions.
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Figure 5-16 The Items Window

Field Name Description

Line Item Nbr The Contract Line Item number that identifies each Item as it
appears on the Contract. The user supplies this value for all
Items added to the Contract after construction begins and all
Contracts entered on-line. When entered, must be unique
within the Contract. Once saved, this value can not be
modified. Items added with wrong line Item numbers must
be deleted and added again.

Project Nbr Transportation agency-defined ID for the Project. There can
be multiple Project Control Numbers per Contract. After a
value is entered and saved, it can not be modified. Items
added to wrong Projects must be deleted and added again.

Category Nbr Category number under which Items are grouped for various
reasons, primarily for funding. After a Category number is
saved, it can not be modified. Items added to wrong
Categories must be deleted and added again.
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Field Name

Description

Status Type

Code indicating the current status of an Item.
Pending. Status defaults to pending when the Item is added.

Active. When a Contract’s status is changed to active, the
status of all of the Contract’s Items is changed to active. An
active Item can not be deleted.

Final. When a Final Item Quantity Change Order is
approved, the status of all of the Change Order’s Items is
changed to Final.

Audited. When an Item has been approved or accepted
through an audit, the user must indicate its status as Audited.

Complete. When a Contract’s status is changed to complete,
the status of all of the Contract’s Items is changed to
complete.

Item Code

Transportation agency-defined code used to identify an Item.
This value is supplied by the Item Master list. The user can
search this field. This value is protected from modification
once the Contract status is changed from pending to active.

Description

Text description of the Item. This value is supplied by the
Item Master list. An Item Description cannot be modified.

Units Type

The unit of measure for this Item. This value is supplied by
the Item Master list. Cannot be modified.

Unit Price

Unit price of the Item; identified on the invoice and Contract
documents. Protected from modification once the Contract
status is changed from pending to active.

Spec Year

Specification year from the Item Master record.
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Field Name

Description

Bid Quantity

This is the original quantity of the line Item, as indicated on
the proposal or Contract. Must be greater than zero. Must be
equal to one, if the Item’s unit of measure is Lump Sum.
Protected from modification once the Contract status is
changed from pending to active. Protected from entry if Item
is being added through a Change Order. If the bid quantity is
zero, the Item was added through a Change Order and its
quantity is obtained through the Change Order Item quantity
amount and not the Item bid amount.

Bid Amount

Total dollar amount of Item at bid. Protected; Bid Qty * Unit
Price

Proposal Line Nbr

The line number that identifies the Item as it appears on the
proposal. Protected; display only; entered by a Pre-
construction system.

Specialty

Indicates if the line Item is a specialty Item. Specialty Items
are excluded from the calculation to determine the amount of
the Contract which can be sublet. Protected from
modification if the Contract has an associated estimate, or if
the Item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Major

Indicates that the Item is considered major rather than minor.
Major Items can have different overrun limits and
parameters for Change Order approvals. Protected from
modification if the Contract has an associated estimate, or if
the Item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through Change Order)

An associated stockpiled material
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Field Name

Description

Critical

Indicates that the Item is considered critical. Used for
tracking the progress of Contracts with the ‘Critical Items
Installed’ progress schedule type. Non-critical Items such as
landscaping are not included in progress tracking.

If the Allow Critical Item Indicator Update’ System
Operational Parameter is set to No., the indicator is protected
from modification if the Contract has an associated estimate,
or if the Item has any of the following:

An associated Change Order

An associated dispute

An associated plan discrepancy (through a Change Order)
An associated stockpiled material

An associated Subcontract

If the ‘Allow Critical Item Indicator Update’ System
Operator Parameter is set to Yes, the indicator is available at
all times until the Item has a Final status.

Pay Plan Qty

Indicates if the line Item is paid to plan quantity. If this
indicator is ON, an in-box message indicating that the item
has exceeded the notified quantity will be issued to the user
who generated the estimate. Protected from modification if
the Contract has an associated estimate, or if the Item has
any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Items
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Field Name Description

Related Item Allows grouping of line Items (e.g., all traffic control Items
or all Items for a structure) for reporting and funding
purposes. To report Items together, the user may create a
related Item code such as RPT1 = Report #1 and then
develop a report which selects and groups these Items
together. Similarly, to fund a group of Items the same but not
within the same Category, the user may create a related Item
code such as FND1 = Funding Source #1 and select those
Items with this code in the funding process, thereby funding
all these Items with the same source and participation
percentages. Protected from modification if the Contract has
an associated estimate, or if the Item has any of the
following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Supplemental User-entered description that is supplemental to the Item's
Description description from the Item Master. Two lines are provided.

Material Discrepancy When an authorized user adds contract items online in
Adjustment SiteManager, the item’s adjustment flag will be set
according to the settings in System Operational Parameters.
This flag’s checkbox will default to ‘On’ if system-wide
discrepancy adjustments flag is checked on, and if the
default calculation for all items flag is turned on. The
default setting for the item may be changed at any time
during the course of a contract. The item’s checkbox will be
disabled if the system setting for the discrepancy adjustments
flag is checked off.

Table 5-20 The Item Window Fields Table
To view or modify a Contract Line Item:
1. On the Contract Records panel, double-click the Items icon. The Items window opens.

2. To select a Contract, Project, and Contract Item, click the Open button. The Select Contract ID
window opens.
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Tip:

Tip:

In the Contract ID list box, scroll to and double-click the Contract. The Projects for the selected
Contract are listed.

In the Project list box, scroll to and click the Project. The Contract Items for the selected Project are
listed.

In the Items list box, scroll to and click the Item.
Click Ok. The Items window opens and displays data for the selected Item.

To change the Item’s status, in the Status Type drop-down list, click the expand arrow to the right of
the current selection and click the status type.

To save modifications, click the Save button.
A Contract Line Item can be deleted only if the Contract status is pending.

A supplemental description is required if the Require Supplemental Description indicator is turned on

in an item’s Master List entry.

To add an Item to a pending Contract:

1.
2.

10.
1.
12.
13.
14.
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On the Contract Records panel, double-click the Items icon. The Items window opens.

To select both a Contract and a Project, click the Services menu and click the Choose Keys choice.
The Select Contract ID window opens.

In the Contract ID list box, scroll to and double-click the Contract. The Projects for the selected
Contract are listed.

In the Project list box, scroll to and click the Project.

Click Ok. The Items window opens and displays data for the selected Item.

In the Line Item Nbr field, type a unique Contract Line Item to identify the Item on the Contract.
Press the Tab key.

To group this Item under a Category, in the Category drop-down list, click the expand arrow and
click the Category.

In the Item Code field, perform a Search. After an Item is selected from the Item Master, the system
fills in some of the data on the Items window.

To indicate that the Item is considered major, click the Major check box (ON).

To indicate that the Item is considered a specialty Item, click the Specialty check box (ON).
Press the Tab key.

In the Unit Price field, type the unit price of the Item.

Press the Tab key.

August 2005



Items

15.
16.

17.
18.
19.
20.
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In the Bid Quantity field, type the original quantity of the Line Item.

To group this Item with other Line Items, in the Related Item drop-down list, click the expand arrow
and click the related Item code.

To indicate that the Item is considered critical, click the Critical check box (ON).

To indicate that the Item is paid to plan quantity, click the Pay Plan Qty check box (ON).
If desired, tab to the Supplemental Description field(s) and type a description.

Click the Save button.

Items that are not on the Item Master can not be added to a Contract through this window. To add an

Item to an active Contract, refer to the Change Order topic.
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5.9 Contract Funding

The Contract Funding window lets the user specify funding for the whole Contract, and for the Contract’s
Projects, Categories, and Line Items. The Contract Funding window lists the current funding specifications in
the top datawindow. Data for the selected funding record is displayed in the bottom datawindow. If the user
adds funding that does not match the funding selection on the Contract Description folder tab (i.e., Federal,
State/Province, or Both), SiteManager automatically updates the Contract Description folder tab.

Active Contracts must be fully funded. For any part of the Contract funded by multiple sources, the combined
funding must equal 100%. If more than one priority level is assigned, the combined funding for each priority
level must equal 100%. In addition, each funding source can be assigned a Cap amount. When the highest
priority funding source reaches its Cap amount, the funding source with the next highest priority continues the
funding. If the lowest priority level fund has a Cap amount, the Cap amount will be ignored until a lower level
fund is added.

When adding a Project to an existing active contract, the Project must have funding associated with it prior to
creating the Change Order that adds Items to the Project. Change Orders cannot be approved without a
funding source for the Project / Category the line items are associated with.

Related Item Codes

Line Items with the same Proposal Line Number or Related Item Code can be funded together. Related Item
Codes can be created specifically to group Line Items (e.g., all traffic control items) for funding purposes. To
do this, the user creates a Related Item Code in the system code tables and associates Line Items with this
code on the Items window. The user can then select a funding source for Related Items on the Contract
Funding window.

Tip:  The funding sources are defined in the Contract Administration reference tables.
E[:onlracl Funding H=] E3
Contract I1D: |SITEMI3H_D1
Contract ID | Project Number  Category | Line Item Funding Source Code Priority | Source Parti 4
MNumber | Humber Order | pation Perce
SITEMGR_OM LT18534BC011 INTERSTATE FUNDS 100.00
SITEMGR_D1 LT18534BC01-1 0005 COMVERSION FEDERAL FUMDIMA 100.00
4 I I »
Project Number: ILT1B5S4BCD1 -1 Funding Source Code: IINTEFESTATE FUNDS
Category Numbel:l Source Participation Pelcent:l 100,007 Priority Order: |_1
Line Item Number: Combine: | (O | je [lem Code
Local Agreement Nbr: 3 (O Proposal Mum
Fed/State Project Nbr: | @ None
State Accounting Code: ISTP-EIEH Related Item: I
State Funding Code:l Proposal Line Nhl:l
Original Cap Amt: I 0.00 Prev Estimates Amt Used: 0.00
Current Cap Amt: | 0.00 Current Estimate Amt Used: 0.00
Figure 5-17 The Contract Funding Window
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Field Name

Description

Funding Source
Code

Identifies a particular source of funding (e.g., Federal grant, Federal
fuel tax, State general fund). This is a required field. After a record
is saved, this field is protected. To change the Funding Source
Code, delete the record and add it again.

Project Number

Transportation agency-defined ID for the Project. Lists Projects
within the Contract.

Fed/State Project The federal or state Project Number for the Project.

Nbr

Category Number | A grouping of Items assigned during Pre-construction. Items can be
grouped within Categories for various reasons, primarily for
funding. Lists Categories within the Contract and Project.

Priority Order Indicates the order in which funds are appropriated to the Contract.

The valid range is between 1 and 9.

Line Item Number

The Contract Line Item Number that identifies each Item as it
appears on the Contract. All bid Line Item Numbers are assigned by
the Pre-construction function. All Line Item Numbers added to the
Contract after construction begins are assigned by the user.

Local Agreement
Nbr

Number used to identify an agreement between a local authority
and the transportation agency. The agreement defines the funding
provided by the local authority with regard to a particular job.

Source The percentage of the total amount in the Project/Category provided
Participation by the Funding Source. (For example, many federal aid Funding
Percent Sources provide 80% of the funding for the Project/Category.). This
is a required field, a valid percentage is between 1 and 100.
Combine This field indicates whether or not Items are combined by Related

Item Code or Proposal Line Number for funding purposes. This is a
required field. To combine no Items, the user selects None. To
combine Items under the same funding source, the user selects
either Like Item Code or Proposal Number. When Like Item Code
is selected, an entry in the Related Item field is required. When
Proposal Number is selected, an entry in the Proposal Line Nbr
field is required.
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Field Name

Description

Proposal Line Nbr

The line number that identifies the Item as it appears on the
proposal. This is a required field when the user selects the Proposal
Number radio button.

Related Item

Related Item codes allow grouping of Items (e.g., all traffic control
Items) for reporting and funding purposes. To group Items for
funding by the same source and percentage, if the Items are not in
the same Category, the user creates a Related Item code and selects
Items with this code in the funding process. To report Items
together, the user creates a Related Item code, such as RPT1 =
Report 1, and then creates a report that selects and groups these
Items together. This is a required field when the user selects the
Like Item Code radio button. The Related Item codes are defined in
the system code tables.

State Funding
Code

Transportation agency-defined code needed by financial system.

State Accounting
Code

Transportation agency-defined code needed by financial system.

Original Cap Amt

Original funding limit.

Current Cap Amt

Current funding limit.

Total Amt Used

Amount used up to the last paid estimate.

Current Amt Used

Amount used in the current estimate.

To add funding to a Contract:

1.
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On the Contract Records panel, double-click the Contract Funding icon. The Contract Select List

opens.

Table 5-21 The Funding Source Window Fields Table

In the Contract ID list box, scroll to and click the Contract.

Click Ok. The Contract Funding window opens.

Click the New button.
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10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.

21.

22.
23.

24.

25.

To select a Project Number, in the Project Number drop-down list, click the expand arrow and click
the Project Number.

To select a Category Number, in the Category Number drop-down list, click the expand arrow and
click the Category Number.

To select a Line Item Number, in the Line Item Number drop-down list, click the expand arrow and
click the Line Item Number.

Press the Tab key.

In the Local Agreement Nbr field, type the number used to identify an agreement between a local
authority and the transportation agency.

Press the Tab key.

In the Fed/State Project Nbr field, type the federal or state Project Number.
Press the Tab key.

In the State Accounting Code field, type the state accounting code.

Press the Tab key.

In the State Funding Code field, type the state funding code.

Press the Tab key.

In the Original Cap Amt field, type the original funding limit.

Press the Tab key.

In the Current Cap Amt field, type the current funding limit.

In the Funding Source Code drop-down list, click the expand arrow and click the source of funding
(e.g., Federal grant, Federal fuel tax, State general fund).

In the Source Participation Percent field, type the percentage of the selected Project/Category/Line
Item provided by the source.

Press the Tab key.

In the Priority field, type a value between one and nine that indicates the order in which the fund is
appropriated to the Contract.

To apply funding to combined Line Items, in the Combine field, click the Like Item Code or
Proposal Number radio button.

If Like Item Code is selected, tab to the Related Item field, click the expand arrow and click the
Related Item Code.
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26. If Proposal Number is selected, tab to the Proposal Line Nbr ficld, click the expand arrow and click
the Proposal Line Number.

27. Press the Tab key.
28. In the Total Amt Used field, type the amount of funding used, up to the last paid estimate.
29. Press the Tab key.
30. In the Current Amt Used field, type the amount of funding used in the current estimate.
31. Click the Save button.

To modify Contract funding:

1. On the Contract Records panel, double-click the Contract Funding icon. The Contract Select List
opens.

2. In the Contract ID list box, scroll to and click the Contract.

3. Click Ok. The Contract Funding window opens.

4. In the Contract Funding list box, scroll to and click the funding record.
5. In the bottom datawindow, tab to the fields to be modified and enter data.
6. Click the Save button.

Tip:  Active Contracts must be fully funded. When the user modifies funding, if any part of the Contract is
not funded 100%, the system prompts the user to fully fund the Contract.

5.10 Contract Group Authority

5.10.1 Contract Group Authority Overview

Contract Group Authority works in conjunction with other security features to give users the authority to
access and modify Contracts. The user’s ability to add, modify, or delete Contract data also depends on the
user group window access rights, the office level assignment, and whether or not the user is assigned to a
group that has Office-wide Contract Access. This section includes a brief summary of Contract Authority and
the following three security features:

e  Window Access Rights
e Office-wide Contract Access
e Contract Authority (Contract-specific)

Window Access Rights

Window security is the highest security level in SiteManager. Window access rights determine the user’s
ability to view and modify SiteManager windows. To view or modify a specific type of window, the user
must belong to a user group that has been assigned inquiry or update access rights for that window. Inquiry
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access rights let the user view the window. Update access rights let the user add and delete data on a window.
The states and provinces assign user groups and window access rights to meet their specific needs. To be
given Contract Authority, a user must first be assigned to a user group with window access rights to the
Contract windows.

Office-Wide Contract Access

Office-Wide Contract Access for a group gives a user the authority to view or modify any Contract delegated
to the office to which the user is assigned when the user is logged on under that group. Most states and
provinces have three office levels. In SiteManager, the office labels are user-defined. The Level 1 office is
always the transportation agency headquarters.

e Level 1 Office (Central office or DOT)
Level 2 Offices

Level 3 Offices

e Level 4 Offices

Each user is assigned to an office level.

For example, a user is assigned to the Level 1 office and the user has office-wide contract access for the
Project Manager group. When the user is logged on under the Project Manager group, the user can view, add,
modify, or delete any Contract delegated to the user’s state or province.

A user who is assigned to the Level 2 office and who has been assigned to the office-wide contract access
Project Manager group can view, add, modify, or delete any Contract within the user’s Level 2 office. A user
must have at least Level 2 Office-Wide Contract Access to add or delete Contracts, Milestones, Projects,
Categories, and Items.

5.10.2 Contract Authority Examples

Window security can give the user window access rights to Contract panels. Contract Authority can only give
the user access to specific Contracts. The assignment of Office-Wide Contract Access groups to a user allows
the user to access all the contracts administered by their respective office when the user is logged on under
those groups. All states and provinces require a Project Manager and Project Engineer for all Contracts. To
give a user the authority to view, modify, or add and delete Contract data, the following assignments are
required:

To view Contract data, the user must

Belong to a user group with inquiry access rights to the Contract panels, and have one of the following:
Contract Authority and group access assignment specific to the Contract OR

e Office-Wide Access with group assignment
To modify Contract data, the user must

Belong to a user group with update access rights to the Contract panels, and have one of the following:
Contract Authority and group access assignment specific to the Contract OR

e Office-Wide Access with group assignment
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To add or delete a Contract, the user must

Belong to a user group with update access rights to the Contract panels
Have at least Level 2 Office-Wide Contract Access
Belong to the office that adminsters the Contract

Contract Authority Example 1

The state or province needs personnel authorized to view and modify all state or province-wide Contracts, add
new Contracts on-line, and delete Contracts that are incorrectly built.

Step 1

Assign specific users to the Level 1 office.

Step 2

Create a user group, e.g. Contract Administrators, with window update access to all Contract windows.
Step 3

Assign Level 1 office users to the Contract Administrators user group with office-wide contract access.

To implement Example 1, the Contract Administrators user group would be assigned window access rights as
stated—update access rights for all Contract windows except Daily Work Reports, which would be inquiry
access only. Additionally, the user’s assigned office would be Level 1. The user would be assibned to the
Contract Administrator group and the office-wide check box would be checked ON. If a Contract
Administrator attempts to open a Contract window, the window will first look at the user’s window access
rights. Since the user has window access rights, the window will next look at the user’s Contract Access, and
permit or deny access accordingly. In the case of the Daily Work Report window, the system would discover
that the user has inquiry rights. The system would permit the user to view the Daily Work Report window but
not to add, update, or delete a Daily Work Report.

Contract Authority Example 2

The state or province needs personnel authorized to view and modify all Level 2 office Contracts. These users
would not be able to view or modify any Contracts not assigned to their office.

Step 1
Assign specific users to the Level 2 office.
Step 2

Create a user group, e.g., District Project Engineers, with window update access to all Contract windows
except:

Windows relevant to an inspector’s Daily Work Reports (inquiry only)

Daily Work Report approval window (inquiry only)
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Step 3
Assign Level 2 office users to the District Project Engineers user group with office-wide contract access.

If a user in Example 2 needs to view or update a Contract out of the office’s jurisdiction, the user will need
Contract Authority for that Contract. Because the user group has window update access, the user would be
able to modify any Contract he is assigned to through Contract Authority. The user would not be limited to
view-only access for this Contract.

Contract Authority Example 3

The state or province needs Level 3 office personnel assigned as Daily Work Report Inspectors who can view
and modify specific Contracts only.

Step 1

Assign users to the Level 3 office.

Step 2

Create a user group, e€.g., Project Inspectors, with the following window access rights:

Inquiry access to specific Contract windows, such as those related to daily work Items and reporting.
Update access to windows relevant to an inspector’s Daily Work Reports.

Step 3

Assign the Level 3 office users to the Project Inspectors user group.

Step 4

Assign Contract Authority for specific Contracts to individual Project Inspector users.

5.10.3 Contract Authority

The Contract Authority window displays the users, office level assignments, and group assignments for each
individual user. When the Project Manager and Project Engineer are added to the Contract, the system adds a
row for each user’s group assignment to the Contract Authority window automatically. An authorized user
can end Contract Authority for personnel no longer needed to work on the Contract.

August 2005 5-79



Trnseport SiteManager®
Contract Administration - New Contracts Contract Group Authority

Figure 5-18 The Contract Authority Window
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Field Name Description
User ID Transportation agency-defined ID of the user.
User Name Name of the user with this ID.
Cen Central Office Assignment. Indicates whether or not the user

is assigned to the central office.

Reg Region. The user’s level 2 region assignment.
Res Residency. The user’s level 3 office assignment.
Group Description Drop-down list containing all the current user’s active group

assignments. The administrator selects from among these
groups to assign the user office-wide or specific contract
authority. Upon selecting a new value, the office-wide access
and contract ID fields will be cleared. Required field.

Office-wide Access This field indicates whether the user has been assigned group
access rights to all contracts within the user’s assigned office.
This field will be protected if the user already has current,
non-end-dated, office-wide contract authority for the specified
group. Once this field is selected, the contract field will be
cleared and protected.

Contract ID This field is required if Office-wide Access is not selected.
Identifies the contract to which the user is assigned group
access rights. The search capability for this field is limited to
contracts on which the user is not currently assigned authority.

Contract Description Protected field. Describes the contract to which the user is
assigned group access rights.

Authority Start Date The date Contract Authority begins for this user. The value
defaults to the current date when a save is performed. This
field will only be populated for contract-specific rows — it is
not used for office-wide contract authority.
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Field Name Description
Authority End Date The date Contract Authority ends for this user. The value

defaults to the current date upon choosing End Contract
Authority from the window’s Services menu. The user has
authority until the following day. This field will only be
populated for contract-specific rows — it is not used for office-
wide contract authority.

Table 5-22 The Contract Authority Window Fields Table
To grant a user Contract Authority:

1. On the Contract Records panel, double-click the Contract Authority icon. The Contract Authority
window opens.

2. Select and click the desired user ID.
3. Click the New button. The New Contract Group Authority window opens.

4. In the Group Description field, click the down arrow to the right of the field, and select the desired
group.

5. Ifdesired, use the Search function to select a specific contract.

6. Click the Save button.

5-82 August 2005



Trnseport SiteManager®
Key Dates and Checklist Events Contract Administration - New Contracts

To end a user’s Contract Authority:

1. On the Contract Records panel, double-click the Contract Authority icon. The Contract Authority
window opens.

2. Select and click the desired user ID.
3. Select and click the desired group in the lower datawindow.

4. If the authority is specific to a contract, click the Services menu and select the End Contract
Authority choice.

5. [If the authority is office-wide access, click the Delete button.

6. Click the Save button.

5.11 Key Dates and Checklist Events

Key Dates and Checklist Events allow the user to establish, monitor, and maintain a series of key dates and
scheduled events specifically related to the administration of the Contract. The messages and discrepancy
tracking associated with Key Dates and Checklist Events enhance the ability of the user to administer the
Contract. For more information, refer to the Key Dates, Checklist Scheduled Events, and Checklist Event
Dates topics.

5.12 Progress Schedule

The Progress Schedule window lets the user add, modify, and view a Contract’s Progress Schedule. The user
selects a schedule type, enters time periods, and enters the percentage of Contract work to be completed in
each time period. The time periods are measured in either days or dates, depending on the Time Charges Type
of the Contract. If the ‘Critical Path Method’ schedule type is selected, only the final day or date can be
tracked. If a schedule type is not selected, SiteManager does not track the Contract’s progress.

A daily batch process calculates the actual percentages of the Contract time and work completed in each time
period. If the work falls behind schedule by an amount that exceeds the Variance Percentage, the batch
process notifies Contract personnel. The user can override the percentages calculated by the batch process and
enter new values. If the user changes the schedule type, any time period with an actual percentage value is
deleted and the user can enter new time periods.

The Progress Schedule window displays a column graph corresponding to the schedule data. The graph
displays the actual percentage completed (amount and time) versus the schedule. The user can maximize the
graph by clicking the maximize box and return it to original size by clicking the original box.
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4 Progress Schedule

Fed/State/Prov Prj Nbr: INH-495-5[DB1] Time Charges Type: IEaIendar Daps =

Description: lJUB DES. 185-34B; JOBS 20761,22505
Location: IBELTWAY - FAIRF&x CO.

Prime Contractor: |SHIHLEY CONTRACTING CORP. Current Days: |1 20
Prog Schedule Type: |Percent Complete for a Time Period [=] Yariance Pct: IE.EID
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Figure 5-19 The Progress Schedule Window

Field Name Description

Fed/State/Prov Prj Nbr Federal, state, or province Project Number for the Contract,
Project, or Category.

Current Days The current number of days required to complete the
Contract. This is the sum of the bid days and the total
adjustment days for the Contract.

Description Text description of the Contract.

Location Text describing the physical location of the Contract work
site.

Prime Contractor Short name for the Prime Contractor for the Contract.

Time Charges Type Indicates how time charges are assessed for the Contract (i.e.,
Available Work Days, Calendar Days, Fixed Completion
Date).
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Field Name Description

Progress Schedule Type | Type of Progress Schedule used for the Contract (i.e., Percent
Complete for a Time Period, Percent of Critical Items
Complete for a Time Period, and Critical Path Method). If the
Progress Schedule type is changed, the data is deleted and the
user can enter a new Progress Schedule. If the selected
schedule type is Critical Path Method, only the final day or
date is tracked.

Sched Days/Date Number of days in which the work is expected to be done or
the date on which the work is expected to be done. Either
Schedule Days or Schedule Date is displayed, depending on
the time charges type of the Contract. If the time charges type
is Available Work Days or Calendar Days, only days are
tracked. If the time charges type is Fixed Completion Date,
only dates are tracked.

Anticp Pct Compl Amt | Anticipated Percentage Completion of the Contract’s
scheduled dollar amount by the end of the scheduled period.
The sum of the percentages for all time periods in the
schedule must equal 100.

Actual Pct Compl Amt | Actual Percentage Completion of the Contract’s dollar
amount by the end of the scheduled period. A daily batch
process calculates this value. The user can override this value.
Actual percentages can not be entered for future days. The
formula for computation of this field is as follows: Earnings
to date / Contract amount * 100

Actual Pct Compl Time | Actual Percentage Completion of the Contract’s scheduled
time by the end of the scheduled period. A daily batch
process calculates this value. The user can override this value.
Actual percentages can not be entered for future days.

Table 5-23 The Progress Schedule Window Fields Table
To create a Progress Schedule:

1. On the Contractor Management panel, double-click the Progress Schedule icon. The Contract
Select List opens.

2. In the Contract ID list box, scroll to and click the Contract.

3. Click Ok. The top datawindow displays information about the selected Contract.
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10.

11.

Tip:

In the Progress Schedule Type drop-down list, click the expand arrow and click the progress
schedule type. (If “Critical Path Method’ is selected, the schedule can be saved at this point because
only the final day or date can be tracked.)

Click the New button. An empty row is added to the schedule.

If the Time Charges Type is Fixed Completion Date, in the Schedule Date field, type the date on
which the scheduled work is expected to be complete.

If the Time Charges Type is Available Work Days or Calendar Days, in the Schedule Days ficld,
type the number of days in which the scheduled work is expected to be complete.

Press the Tab key.

In the Anticp Pct Compl Amount field, type the percentage of the total Contract expected to be
completed in this time period.

To add another time period, repeat Steps 5 through 9.
Click the Save button. The Progress Schedule graph is updated immediately.

A daily batch process calculates the actual percentages of the Contract time and work completed in

each time period.

5.13 Permits

The Permits window lets the user add, modify, and delete Contract permit data. This is a record of the permits
obtained for the Contract, including the permit type, the person who requested the permit, and the date the
request was submitted. The top datawindow lists the permits for the selected Contract. The data for the
selected record is displayed in the bottom datawindow.
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5 Permits !El ﬂ
Contract 1D: |5ITEMGF|_30
Permit Type Date Submitted  Date Obtained Requester ﬂ
EP& 00/00/00 00/00/00

Permit Type -

Date Submitted : | 00/00/00
Date Obtained : | 00/00/00

Requester : |

Permit Number : |

Figure 5-20 The Permits Window

Field Name Description

Permit Type Transportation agency-defined value for the type of permit
(e.g., EPA, Water, Environmental, Hazardous Waste, and
Electrical). This is a required field.

Date Submitted The date the permit was requested. This is a required field.
When entered, the date should not be in the future.

Date Obtained The date the permit was received. When entered the date
should not be in the future.

Requester The person who requested the permit. This is a required field.

Permit Number The number associated with the permit (if available).

Table 5-24 The Permits Window Fields Table
To add a Permit record to a Contract:
1. On the Contract Records panel, double-click the Permits icon. The Contract Select List opens.
2. In the Contract ID list box, scroll to and click the Contract.

3. Click Ok. The Permits window displays the permits for the selected Contract. Data for the selected
permit is shown in the fields below the list.
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4. Click the New button. An empty row is added to the Permit list.

5. In the Permit Type drop-down list, click the expand arrow and click the permit type.
6. Press the Tab key.

7. In the Date Submitted field, type the date the permit was requested.

8. Press the Tab key.

9. In the Date Obtained field, type the date the permit was obtained.

10. Press the Tab key.

11. In the Requester field, type the name of the person who requested the permit.

12. Press the Tab key.

13. In the Permit Number field, type the permit number.

14. Click the Save button.

5.14 Stockpiled Materials

The Stockpiled Materials window allows the user to select materials to stockpile for the Contract, and enter
invoice data for the materials. The window also allows the user to replenish depleted material stockpiles, as
needed. Contract Line Item data is displayed in the top datawindow and stockpiled material data in the
bottom datawindow. This data is used during estimate generation to determine the amount to be paid for the
Items installed. The estimate process enters the installed quantity and the amount paid to date on the
Stockpiled Materials window. When the user closes out a stockpile, the estimate process also generates a line
item adjustment which will retain any of the initial payment amount indicated on the stockpile that has not
been recouped during usage of the stockpile. The system will automatically close a stockpiled material record
when the remaining quantity reaches zero (0), or the user can manually close out the balance of a stockpiled
material and transfer it to another contract.

Tip:  The stockpiled material data is downloaded with the Basic Contract Data for viewing by the inspector
while posting the Daily Work Reports. It can also be viewed in Contractor Payments.
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EStnckpiled Materials

iD.DDDDD

Figure 5-21 The Stockpiled Materials Window

Field Name Description

Contract ID Transportation agency-defined ID for the Contract.
Project Nbr Transportation agency-defined ID for the Project.

Catg Nbr Category number assigned to the Line Item.

Line Item Nbr Contract Line Item number that identifies each Item as it

appears on the Contract.

Units Description of the unit of measurement for the Line Item.

Unit Price Unit price of the Line Item, as indicated on the proposal or
Contract.

Bid Quantity The quantity of the Line Item, as indicated on the proposal or
Contract.

Item Description Short text explanation of the Item.
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Field Name Description
Material Code Transportation agency-defined ID for the material. The search

lens displays the materials for the selected Contract Line
Item. If the user selects a Material Code using the search lens,
the Stockpiled Description is entered by the system. If the
user types a description, the Material Code field is protected.

Stockpiled Description | Description of the material (or Item) being stockpiled. If the
user selects a Material Code using the search lens, the
Stockpiled Description is entered by the system. If the user
types a description, the Material Code field is protected.

Status The status of a stockpiled material is either Open, Active, or
Closed. New materials are given open status. Materials
included in an estimate are given active status. When a
balance is closed out, the material is given closed status.
Open and active materials can be modified unless an estimate
is pending. Only open materials can be deleted.

Invoice Date Date of the invoice.

Invoice Number Identifies the invoice with which the material was received.
This field is required.

Quantity Number of units received. This field is required. When
modified, this value can not be less than Installed Qty To
Date.

Units Description of the unit of measure for the material.

Unit Price Unit price of the material; identified on the invoice. This field

is required.

Conv Factor The Conversion Factor is derived from the Contract Line
Item information. It is the number of units of the material
used in one unit of the Line Item. Defaults to 1.0 when the
Stockpiled Description is typed by the user. The user can
modify the default value.
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Field Name Description
Conv Unit Price Unit price of the material multiplied by the Conversion

Factor. This field is display only.

Invoice Amount System-calculated product of the material Quantity and Unit
Price.
Matl Sn The stockpile material sequence number. Each time the user

creates a stockpiled material record, it will receive a Material
Sequence number. The first stockpile material record will be
assigned the number one (1) for the Material Sequence
number and subsequent Material Sequence numbers (for each
newly created stockpile record) will increase by increments of
one (1).

Replenish Sn The replenishment sequence number. Each time the user
replenishes a stockpile, SiteManager copies the existing
stockpile information to a new stockpile record, which the
user can modify. When the new stockpile record is saved, it
is assigned the same Material Sequence Number as the
original stockpile. The first replenishment stockpile will be
assigned the number zero (0) for the Replenish Sequence
number and subsequent Replenish Sequence numbers will
increase by increments of one (1).

Initial Invoice Payment | The initial payment to be applied to the invoice upon
generation of the first estimate for the stockpiled material.
This value can not be more than the Invoice Amount.

Remaining Qty The quantity of the material that remains. Calculated as the
difference between Quantity and Installed Quantity To Date.
May be zero if the Project is closed or the Contract is ended.

Installed Qty To Date The quantity of the material installed to date. This value is
calculated by the estimate generation process. This is a
protected field.

Paid To Date The amount that has been paid for the stockpiled material to
date. This value is calculated by the estimate generation
process. This is a protected field.
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Field Name Description

This field contains a textual description that is supplemental
to the item's description and may be required by the
transportation agency.

Supp Description 1

This field contains a second textual description that is
supplemental to the item's description and may be required by
the transportation agency.

Supp Description 2

Table 5-25 The Stockpiled Materials Window Fields Table

5.14.1 Before Adding Data

SiteManager calculates payments for stockpiled materials based on the quantity of material used per Contract
Item. SiteManager does not automatically apply portions of the invoiced material quantity and payment
amount to different Contract Items. This means that the user must decide how to allocate the invoiced
amounts for a stockpiled material. Before adding invoice data to SiteManager, the user must determine the
following:

e Which Items include the invoiced material
Which Contracts include these Items
How much of the total invoiced material quantity to allocate to each Item

e Ifan initial payment amount is due, which Contracts or Contract Items pay this amount

From these numbers, the user can calculate the values to enter in the Quantity field of the Stockpiled
Materials window

Example

The user receives an invoice for 100,000 bolts. The total amount due on the bolts is $8,000.00. These bolts are
stockpiled for use on retaining walls and bridges. Contracts A, B, and C are active Contracts that include
either retaining walls or bridges or both as line Items. The user splits the total invoiced quantity as follows:
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Contract A Contract B Contract C

Item Retaining Wall | Bridge | Retaining Wall | Retaining Wall | Bridge

Description

Stockpiled Bolt Bolt Bolt Bolt Bolt

Description

Quantity 5,000 1,000 29,000 15,000 50,000

Invoice $400.00 $80.00 | $2,320.00 $1,200.00 $4,000.00

Amount

To add the invoice data, the user must enter the Quantity values per Contract Item. To do this, the user enters
new invoice data on the Stockpiled Materials window five times, selecting the stockpiled material (i.e., Bolt)
under a different Contract Item each time. The system calculates the Invoice Amount by multiplying the
Quantity by the Unit Price of the material.

Conversion Factor

The conversion factor is derived from the Contract information. It indicates how many units of the stockpiled
material are used in one unit of the Contract Line Item. If the user enters a non-contract material in the
Stockpiled Description field, the conversion factor defaults to one (1.0). This value indicates that one unit of
the material is used in each unit of the Item. The user should verify that the conversion factor is correct and, if
not, enter the correct value. For example, if each linear foot of retaining wall requires three bolts, the user
enters a conversion factor of three (3.0) for the bolts.

To view a stockpiled materials record:

1. On the Contract Records panel, double-click the Stockpiled Materials icon. The Stockpiled
Materials window opens.

2. Click the Open button. The Stockpiled Material Select window opens.
3. In the Contract ID list box, scroll to and double-click the Contract.
4. In the Stockpiled Materials list box, scroll to and click the stockpiled material.

5. Click Ok. The Stockpiled Materials window displays data for the selected material.
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To add stockpiled materials to a Contract:

L.

Or

10.
1.
12.
13.
14.

15.

16.

17.

18.

19.

20.

5-94

Read and understand the Before Adding Data topic. Calculate the invoiced quantity to add to each
Contract.

On the Contract Records panel, double-click the Stockpiled Materials icon. The Stockpiled
Materials window opens.

Click the Services menu and click the Choose Keys choice.

In the Contract ID list box, scroll to and double-click the Contract.

In the Contract Project list box, scroll to and double-click the Project.

In the Contract Item list box, scroll to and click the Contract Line Item that uses the material.
Click Ok. The Stockpiled Materials window displays the Contract Line Item data.

In the Material Code field, perform a Search and select the material.

In the Stockpiled Description field, type a description of the material.
In the Invoice Date field, type the date of the invoice.

Press the Tab key.

In the Invoice Number field, type the number of the invoice.

Press the Tab key.

In the Quantity field, type a previously determined quantity of the stockpiled material to be applied
to this Item and this Contract.

In the Units drop-down list, click the expand arrow and click the unit of measurement in which the
material is sold.

In the Unit Price field, type the price per unit from the invoice.
In the Conv Factor field, select the current value and type the conversion factor.

If the invoice requires only an initial payment, in the Initial Invoice Payment field, type the
previously determined dollar amount of the initial payment to be applied to this Item and this
Contract.

To add another stockpiled material to the selected Item, click the New button and repeat Steps 8
through 18.

Click the Save button.
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To replenish a stockpiled material:

L.

10.
11.
12.
13.

14.

On the Contract Records panel, double-click the Stockpiled Materials icon. The Stockpiled
Materials window opens.

Click the Services menu and click the Choose Keys choice.

In the Contract ID list box, scroll to and double-click the Contract.

In the Contract Project list box, scroll to and double-click the Project.

In the Contract Item list box, scroll to and click the Contract Line Item that uses the material.
Click Ok. The Stockpiled Materials window displays the Contract Line Item data.

Click the Services menu and click the Replenish Material choice. SiteManager copies the existing
stockpile information to a new stockpile record and assigns a new Replenish Sequence number.

In the Invoice Date field, type the date of the invoice.

Press the Tab key.

In the Invoice Number field, type the number of the invoice.

Press the Tab key.

In the Quantity field, type the replenishment quantity of the stockpiled material.

If the invoice requires an initial payment, in the Initial Invoice Payment field, type the previously
determined dollar amount of the initial payment to be applied to the current item and contract.

Click the Save button.

To close out the balance of a stockpiled material:

L.

On the Contract Records panel, double-click the Stockpiled Materials icon. The Stockpiled
Materials window opens.

Click the Open button. The Stockpiled Material Select window opens.

In the Contract ID list box, scroll to and double-click the Contract.

In the Stockpiled Materials list box, scroll to and click the stockpiled material.
Click Ok. The Stockpiled Materials window displays data for the selected material.

Click the File menu and click the Print choice to produce a copy of the data (or copy the data by
hand).

Click the Services menu and click the Close Out Balance choice. Zero is entered in the Remaining
Quantity field. The status changes to closed. All fields are protected.

Click the Save button.
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To delete a stockpiled material from a Contract:

1. On the Contract Records panel, double-click the Stockpiled Materials icon. The Stockpiled
Materials window opens.

2. Click the Open button. The Stockpiled Material Select window opens.

3. In the Contract ID list box, scroll to and double-click the Contract.

4. In the Stockpiled Materials list box, scroll to and click the stockpiled material.

5. Click Ok. The Stockpiled Materials window displays data for the selected material.
6. Click the Delete button. The system asks the user to confirm the deletion.

7. Click Ok.

Tip:  The user can not delete a stockpiled material with active or closed status.

5.15 Construction Conferences

The Construction Conference window lets the user view and add construction conference data. The user
typically adds conference data after the conference occurs. This window is used to record the conference title,
date, attendees, and notes on the directives, issues, and major topics discussed at the conference. The system
assigns a serial number to the conference record. If attendees are listed on the window, the conference record
cannot be deleted.

5 Construction Conference Data [_ (O] x|
Contract: ISITEMGF!_EEI Conference 5. Mo: I
Conference Date: [14/23/33 Conference Tille:l
lssues
Major Details
Attendee Hames I ﬂ
1)
=

Figure 5-22 The Construction Conference Window
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Field Name

Description

Contract

Transportation agency-defined ID of the selected Contract.

Conference S No

Conference Serial Number that the system gives to the
conference when the user adds the conference.

Conference Date

Date that the conference was held. For new conference data,
the value defaults to the system date. This date can not be in
the future. The user can not modify the date after saving the
conference data.

Conference Title

The title of the conference.

Major Topics

The topics of the conference. This is stored as a remark on the
window. If this field has a check mark next to it, click the
field once to see the remark in the box to the right.

Directives

The directives issued to the Contractor. This is stored as a
remark on the window. If this field has a check mark next to
it, click the field once to see the remark in the box to the
right.

Issues

The issues that were discussed in the conference. This is
stored as a remark on the window. If this field has a check
mark next to it, click the field once to see the remark in the
box to the right.

Attendee Names

The names and affiliations of the attendees.

Table 5-26 The Construction Conference Window Fields Table
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To view a Construction Conference record:

L.

On the Contractor Management panel, double-click the Construction Conference icon. The
Construction Conference window opens.

Click the Open button. The Select Construction Conference window opens.
In the Contract ID list box, scroll to and double-click the Contract.

In the Construction Conference list box, scroll to and click the conference.
Click Ok. The Construction Conference window displays data.

To view Major Topics, Directives, or Issues, click the field and read the notes in the box to the right.

To add Construction Conference records:

5-98

a. On the Contractor Management panel, double-click the Construction Conference icon.
The Construction Conference window opens.

b. Click the Services menu and click the Choose Keys choice. The Contract Select window
opens.

c. In the Contract ID list box, scroll to and click the Contract.

d. Click Ok. The Construction Conference window displays the Contract ID.
¢. Inthe Conference Date field, type the date the conference was held.

f. Press the Tab key.

g. Inthe Conference Title field, type the title of the conference.

h. Press the Tab key.

i. To add a remark, click either the Major Topics, Directives, or Issues check box (ON), and
type the remark.

j.  Click the Save button. The system enters the conference serial number.

k. To add an attendee, click the Attendee Names datawindow and click the New button. An
empty row is added to the datawindow.

1. Inthe Attendee Names field, type the attendee’s name.
m. Click the Save button.

n. To add another conference record for the same Contract, click the New button and repeat
Steps 5 through 13.
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5.16 Subcontracts

The Subcontract window lets the user add, modify, and delete Subcontracts and Subcontract data. The
window also displays calculated DBE commitment amounts. The user can define both parent Subcontracts
and lower level Subcontracts. The Subcontract window has two folder tabs as follows:

e Descriptions

e Jtems

5.16.1 Subcontract Descriptions

The user enters the Subcontractor and DBE commitments on the Description folder tab. To be selected as a
Subcontractor, a contractor must first be entered as a vendor in the Vendor reference tables. When a new
Subcontract is saved, the system adds the Subcontract amount to the total amount of uncompleted work for
the Subcontractor. This value is displayed on the Vendors window in Reference Tables (CA). The Contract’s
Prime Contractor can not be selected as a Subcontractor on the Contract.

The percentage of the Subcontract that can be counted towards the Contract’s DBE goal depends on the
Subcontract’s level, the Subcontractor’s DBE status, and whether or not the Subcontract includes Items. A
Parent Subcontract with a DBE Subcontractor and Items is always counted 100% towards the Contract’s DBE
goal. If the Subcontract has no Items (i.e., the Subcontractor is a supplier/hauler), the user enters the
percentage counted towards the DBE goal. For nested Subcontracts, if a higher-level DBE Subcontract is
counted 100% towards the DBE goal, the percentage of the nested Subcontract is always zero.

ESubconlracls =] E3
Description s Contract ID - [GITEMGA_30

SubCont Nbr: Eﬁ Parent Subcont Mbr: | Supp/Hauler Ind [

Subcontractor: | Contract DBE Goal Pct: [10.00
SubCont Type: | =] DBE Type: Verified Payment Amt
Work Type: | =] CentType: [ ’VLast: .00 Total: [00
Approval Date: IW Pct Twrds DBE Goal: |00 Fed Supp/Haul Fund Pct: IEIEI—
Amounts  Pct of Total Sub’d Pct of Total Contract
This SubContract: [ w0 | 0 [ oo
This Original Commitment : | .00 | 0 [ oo
This Current Commitment: | 0.00 | 0 [ o

Total Original Commitment: I—DU

Total Current Commitment: I—DU

Total Allowable Max [non-spclty): I—DD
Total Towards Max [non-spclty): I—UD
Total Spclty Subcontracted: I—UD
Total Subcontracted: I—DD

44444

Figure 5-23 The Subcontract Description Folder Tab
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Field Name Description
Contract ID The transportation agency-defined ID for the Contract.
Subcont Nbr User-entered number associated with each Subcontract. After

saving, it can not be modified. This field is required.

Parent Subcont Nbr Subcontract number for the parent Subcontract. After saving, it
can not be modified. The user can search this field.

Subcontractor Short name for the Subcontractor. The user can search this field.
This field is required.

Subcont Type Transportation agency-defined Subcontract Type. This field is
required.

Work Type Transportation agency-defined code of work class. A warning is

displayed if the work class selected does not match one of the
work classes associated to the Vendor. This field is required.

Approval Date The date the approval was given for this Subcontract. Must be
equal to or later than the Contract award date. If the sum of the
Subcontractor’s uncompleted work amount for all Contracts
(including the total amount of the new Subcontract) exceeds the
sum of the Subcontractor’s work class qualification amounts, a
warning message is displayed. Note: If an Approval Date is not
entered, SiteManager will not display the Subcontractor name in
the Contractor drop down list on the Contractors and Record
Work Items tabs in DWR.

DBE Type Transportation agency-defined code for the Subcontractor’s
DBE Type. Defaults to the DBE Type in the vendor reference
table. A warning is displayed if the DBE Type selected does not
match the DBE Type in the reference table.

Cert Type System-defined code for whether the Subcontractor is certified
as a DBE by the State or Federal government, or Both. This
value is from the DBE Cert Type on the Vendor reference table,
and can not be changed.
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Field Name Description
Supp/Hauler Ind Indicates that the Subcontractor is a supplier or hauler only. If

so, the Subcontract can not have Items. The user must enter the
Total Subcontract Amount manually. This field can not be
modified when there are existing Items on the Subcontract.

Pct Twrds DBE Goal Percentage of the Subcontract amount counted towards the DBE
commitment goal. For nested Subcontracts, if any higher-level
DBE Subcontract has counted the Item towards the DBE goal,
then this field defaults to 0% and can not be modified. For non-
nested DBE Subcontracts with no line Items (i.¢., a supplier or
hauler), the field defaults to 100% and can be modified. For
other non-nested DBE Subcontracts, the field defaults to 100%
and can not be modified.

Fed Supp/Haul Fund Pct | Percentage of the Subcontract DBE commitment goal that is
covered by federal funding for a DBE supplier or hauler.
Defaults to 100 when Contract Funding is Federal. Defaults to
zero when Contract Funding is State. Entered by the user when
Contract Funding is Both.

Last Verified Payment Last verified amount that has been paid to the Subcontractor.
Amt Positive or negative values may be entered.

Total Verified Payment Total verified amount that has been paid to the Subcontractor.
Amt Must be a positive number.

Amounts

This Subcontract Amount | Quantity multiplied by Subcontract line Item unit price for all
Subcontract Items. Must be entered manually if a Subcontract
without any Items is entered (i.e., a supplier or hauler).

This Original Original amount that the Prime Contractor commits to
Commitment Amount subcontract to the DBE. Can not be modified if this data is from
a Pre-construction system, or if the Contract’s status is active.
Must be a positive number.

This Current For Subcontracts where DBE Type is indicated, this is calculated
Commitment Amount by multiplying the Subcontract Amount by the Pct Towards
DBE Goal.
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Field Name

Description

Total Original
Commitment Amount

Sum of the original commitment amounts for all the DBE
Subcontracts for a Contract.

Total Current
commitment Amount

Sum of current commitment amounts for all the DBE
Subcontracts for a Contract.

Total Allowable Max
Amount

(non-spclty)

Maximum allowed amount (excluding specialty Items) for all
Subcontracts in a Contract. This is the Max Allowed Subcontract
Percent in the System Operational Parameter table multiplied by
the difference of the total Contract amount minus the specialty
Items amount.

Total Towards Max
Amount

(non-spclty)

Current amount of all Subcontracts that contribute towards the
Max Allowable Amount (non-spclty). This is the sum of all of
the non-line Item Subcontract amounts plus all of the non-
specialty Subcontract line Item amounts.

Total Spclty
Subcontracted Amount

Sum of all specialty Item amounts for all of the Subcontracts in
the Contract.

Total Subcontracted
Amount

Sum of all parent Subcontract amounts for the Contract.

Pct of Total Subcontracted

Percentage of Total
Subcontracted This
Subcontract

Percentage of the sum of the parent Subcontract amounts
covered by this Subcontract.

Percentage of Total
Subcontracted This
Original Commitment

Percentage of the sum of the Subcontract original commitment
amounts covered by this Subcontract.

Percentage of Total
Subcontracted This
Current Commitment

Percentage of the sum of the Subcontract current commitment
amounts covered by this Subcontract current commitment
amount.

Pct of Total Contract
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Field Name

Description

Percentage of Total
Contract This
Subcontract

Percentage of the Contract’s current amount covered by this
Subcontract’s Total Amount.

Percentage of Total
Contract This Original
Commitment

Percentage of the Contract’s current amount covered by this
Subcontract’s Original Commitment Amount.

Percentage of Total
Contract This Current
Commitment

Percentage of the Contract’s current amount covered by this
Subcontract’s Current Commitment Amount.

Percentage of Total
Contract Total Original
Commitment

Percentage of the Contract’s current amount covered by the
Total Original Commitment Amount.

Percentage of Total
Contract Total Current
Commitment

Percentage of the Contract’s current amount covered by the
Total Current Commitment Amount.

Percentage of Total
Contract Total Allowable
Max (non-spclty)

Percentage of the Contract’s current amount covered by the
Total Allowable Max (non-spclty) Amount.

Percentage of Total
Contract Total Towards
Max (non-spclty)

Percentage of the Contract’s current amount covered by the
Total Towards Max (non-spclty) Amount.

Percentage of Total
Contract Total Spclty
Subcontracted

Percentage of the Contract’s current amount covered by the
Total Spclty Subcontracted Amount.

Percentage of Total
Contract Total
Subcontracted

Percentage of the Contract’s current amount covered by the sum

of all the parent Subcontract amounts.

Table 5-27 The Subcontract Description Folder Tab Fields Table
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To add a Subcontract with a non-DBE Subcontractor:

1. On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

2. Click the Services menu and click the Choose Keys choice. The Select Contract window opens.
3. In the Contract ID list box, scroll to and click the Contract.

4. Click Ok. The window displays the Contract ID.

5. In the Subcontract Nbr ficld, type the ID number of the new Subcontract.

6. Press the Tab key.

7. If this Subcontract is not a parent Subcontract, in the Parent Subcontract Nbr field, type the ID
number of the parent Subcontract or perform a Search.

8. In the Subcontractor field, type the short name of the Subcontractor or perform a Search.
9. In the Subcont Type drop-down list, click the expand arrow and click the Subcontract type.

10. In the Work Type drop-down list, click the expand arrow to the right of the current selection and
click the Work Class type. (If the selected Work Type does not match the reference table data, a
message is displayed. To acknowledge the message, click OK.)

11. In the Last Verified Payment Amt field, type the last verified amount that was paid to the
Subcontractor.

12. Click the Save button.
Tip:  If the Subcontractor is not a supplier or hauler, Items must be added to the Subcontract.
To add a Subcontract with a DBE Subcontractor (non-hauler/supplier):

1. On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

2. Click the Services menu and click the Choose Keys choice. The Select Contract window opens.
3. Inthe Contract ID list box, scroll to and click the Contract.

4. Click Ok. The window displays the Contract ID.

5. Inthe Subcontract Nbr field, type the ID number of the new Subcontract.

6. Press the Tab key.

7. If this Subcontract is not a parent Subcontract, in the Parent Subcontract Nbr field, type the ID
number of the parent Subcontract or perform a Search.

8. In the Subcontractor field, type the short name of the Subcontractor or perform a Search. The DBE
Type is entered on the Subcontracts window.
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9. In the Subcont Type drop-down list, click the expand arrow and click the Subcontract type.

10. In the Work Type drop-down list, click the expand arrow to the right of the current selection and
click the Work Class type. (If the selected Work Type does not match the reference table data, a
message is displayed. To acknowledge the message, click OK.)

11. In the Last Verified Payment Amt field, type the last verified amount that was paid to the
Subcontractor.

12. Click the Save button.

Tip: The DBE Type can be changed on the Subcontracts window. If the selected DBE Type does not

match the reference table data, a message is displayed, but the change can be saved.

To add a Subcontract with a supplier or hauler as Subcontractor:

L.

10.

1.

12.

13.

14.

15.

On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

Click the Services menu and click the Choose Keys choice. The Select Contract window opens.
In the Contract ID list box, scroll to and click the Contract.

Click Ok. The window displays the Contract ID.

In the Subcontract Nbr field, type the ID number of the new Subcontract.

Press the Tab key.

If this Subcontract is not a parent Subcontract, in the Parent Subcontract Nbr ficld, type the ID
number of the parent Subcontract or perform a Search.

Click the Supp/Hauler Ind check box (ON).

In the Subcontractor field, type the short name of the Subcontractor or perform a Search. If the
Subcontractor is a DBE, the DBE Type is entered on the Subcontracts window.

In the Subcont Type drop-down list, click the expand arrow and click the Subcontract type.

In the Work Type drop-down list, click the expand arrow to the right of the current selection and
click the Work Class type. (If the selected Work Type does not match the reference table data, a
message is displayed. To acknowledge the message, click OK.)

In the Last Verified Payment Amt field, type the last verified amount that was paid to the
Subcontractor.

In the Pct Towards DBE Goal field, type the percentage of the Subcontract amount that counts
towards DBE goals.

If the Contract has both Federal and State funding, in the Fed Supp/Haul Fund Pct field, type the
percentage of the Subcontract amount that is paid by Federal funds.

In the This Subcontract Amount field, type the dollar amount of the Subcontract.
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16. Click the Save button.

Tip:

Items can not be entered on a Subcontract with a supplier or hauler.

To approve a Subcontract:

L.

8.

Tip:

On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

Click the Open button. The Select Contract window opens.

In the Contract ID list box, scroll to and click the Contract.

Click Ok. The window displays a list of Subcontracts for the selected Contract.
In the Subcontract list box, scroll to and click the Subcontract.

Click Ok. The window displays data for the selected Subcontract.

In the Approval Date field, type the date approval was given for this Subcontract. (If the
Subcontractor’s total uncompleted work amount exceeds the Subcontractor’s work class qualification
amount, a message is displayed. To acknowledge the message, click OK.)

Click the Save button.

Enter the Subcontract Items (or Subcontract Amount for a supplier/hauler) before approving the

Subcontract. Then the amount of the new Subcontract is included in the Subcontractor’s Uncompleted Work
Amount when the approval is saved. A message is displayed if the Subcontractor’s work class qualification
amount has been exceeded.

To delete a Subcontract:

L.

8.
9.

Tip:

On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

Click the Open button. The Select Contract window opens.

In the Contract ID list box, scroll to and click the Contract.

Click Ok. The window displays a list of Subcontracts for the selected Contract.

In the Subcontract list box, scroll to and click the Subcontract.

Click Ok. The window displays data for the selected Subcontract.

Click the Delete button. The system asks the user to confirm the deletion.

Click Yes. When the Subcontract is deleted, the corresponding Items are also deleted.
Click the Save button.

A Subcontract can not be deleted if there is work recorded against it, or if the Subcontract was part of

the Contract award.
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5.16.2 Subcontract Items

The Subcontract Items folder tab lets the user add, modify, and delete Subcontract Items. If the Subcontractor
is a hauler or supplier only, the Subcontract will not have Items. If the Subcontract has no Items, the user
must enter the Subcontract Amount manually. If the Subcontract has Items, the Subcontract Amount is the
sum of all of the Item amounts and the user cannot modify it.

ESuhcuntracts

Figure 5-24 The Subcontract Items Window

Field Name Description

Contract ID Transportation agency-defined ID for the Contract

Subcontract Nbr user-entered number associated with each Subcontract.

Project Number Transportation agency-defined ID for the Project.

Line Item Contract line Item to be worked on by the Subcontractor. The
user can search this field.
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Field Name Description

Item Code Transportation agency-defined code that identifies a particular
Item.

Unit Type Unit of measure for the Subcontract line Item

Specialty Indicates if the line Item is a specialty Item. Specialty Items
are excluded from the calculation to determine the maximum
amount of the Contract that can be Subcontracted.

Short Description Text description of the line Item.

Line Item Nbr The user can search this field. For a parent Subcontract, the

line Item is selected from the Contract Item list. For lower
level Subcontracts, the line Item is selected from the parent
Subcontract line Item drop-down list.

Supp Description 1

This field contains a textual description that is supplemental to
the item’s description and may be required by the
transportation agency.

Supp Description 2 This field contains a secondary textual description that is
supplemental to the item’s description and may be required by
the transportation agency.

Quantity

Contract Bid Quantity | Contract bid quantity of the Contract line Item.

Current Contract
Quantity

Current quantity of the Contract line Item including any
Change Orders. Current Quantity is calculated by the sum of
Bid Quantity and the net Change Order quantity

Parent Subcontract
Quantity

The quantity of the line Item that is subcontracted to the parent
Subcontract. If this is a parent Subcontract, this field is empty.
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Field Name

Description

This Subcontract
Quantity

The quantity of the line Item subcontracted to this Subcontract.
The Subcontract Quantity must be a positive value. It must be
less than or equal to the parent Subcontract Quantity for a
lower level Subcontract. For a parent Subcontract, it must be
less than or equal to the Current Quantity minus all other
parent Subcontract quantities for this Item. The Quantity edit
will not be performed if the unit on this Subcontract or the
parent Subcontract is changed.

Unit

Contract Bid Unit

Unit of the Item identified on the invoice.

Current Contract Unit

Unit of the Item identified on the invoice.

Parent Subcontract
Unit

Unit of the parent Subcontract line Item.

This Subcontract Unit

Unit of this Subcontract line Item. Defaults to the unit on the
Contract bid Item.

Price

Contract Bid Price

Unit price of the Item identified on the invoice.

Current Contract Price

Unit price of the Item identified on the invoice

Parent Subcontract
Price

Unit price of the Item for parent Subcontract. If this is a parent
Subcontract, it will be blank.

This Subcontract Price

Unit price of the Item for this Subcontract.

Amount
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Field Name Description

Contract Bid Amount Total amount of the bid Item available for Subcontract.
Contract Bid Amount Item amount is calculated by the
Contract bid unit price of the Item multiplied by the Contract

bid quantity.
Current Contract Total amount of the current Item available for Subcontract.
Amount Current Contract amount is calculated by the Contract bid unit

price of the Item multiplied by the current Contract quantity.

Parent Subcontract Total amount of the Item available for lower level Subcontract.
Amount Parent Subcontract Item amount is calculated by multiplying
the parent Subcontract unit price of the Item times the parent
Subcontract quantity.

This Subcontract Total amount of the Subcontract Item. Sub Item amount is
Amount calculated by multiplying the Subcontract unit price of this
Subcontract Item times the Subcontract quantity. If this
amount exceeds the current Contract amount (for level one
Subcontracts), or the parent Subcontract amount (for lower
level Subcontracts), a warning will be displayed.

Subcontract Amount The sum of quantity times unit price for all Subcontract Items,
or the value entered directly if the Subcontract has no line
Items (i.e., a supplier or hauler).

Shared Level 1 Item Indicates whether this Item is included on any other Level 1
Ind Subcontract for this Contract.

Table 5-28 The Subcontract Item Folder Tab Fields Table

To add an Item to a Subcontract:

L.
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On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

Click the Open button. The Select Contract window opens.
In the Contract ID list box, scroll to and click the Contract.
Click Ok. The window displays a list of Subcontracts.

In the Subcontract list box, scroll to and click the Subcontract.
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6. Click Ok. The window displays data for the selected Subcontract.

7. Click the Items folder tab.

8. Click the New button.

9. Inthe Line Item Nbr field, perform a Search.

10. Press the Tab key.

11. In the This Subcontract Quantity field, type the quantity of the line Item subcontracted to this
Subcontract.

12. To change the unit type for the Item, in the This Subcontract Unit drop-down list, click the expand
arrow to the right of the current selection and click the unit type.

13. In the This Subcontract Price field, type the unit price of the line Item.

14. Click the Save button.

To delete an Item from a Subcontract:

L.

8.
9.

10.

11.

On the Contractor Management panel, double-click the Subcontracts icon. The Subcontracts
window opens.

Click the Open button. The Select Contract window opens.

In the Contract ID list box, scroll to and click the Contract.

Click Ok. The window displays a list of Subcontracts.

In the Subcontract list box, scroll to and click the Subcontract.

Click Ok. The window displays data for the selected Subcontract.

Click the Items folder tab.

In the Items list box, scroll to and click the Item.

Click the Delete button. The system asks the user to confirm the deletion.
Click Yes.

Click the Save button.

August 2005 5-111






This page intentionally left blank.

August 2005

5-1






6. Contract Administration - Maintenance

August 2005

August 2005 6-1



Trnseport SiteManager®
Contract Administration - Maintenance Correspondence Log

6.1 Correspondence Log

The Correspondence Log window lets the user add and modify records of correspondence related to a specific
Contract. A correspondence record describes a document that has been either sent or received by a user. The
user can describe the document, identify related records and disputes, attach and view URLs, plug-ins and
OLE documents, and forward the correspondence record to other users.

=43 Correspondence Log

Contract 1D: I Contract Commespondence Senal HNumber: I—
Comrespondence Type: [HNGRGRGSN_—_—_—E _~ |

| On: |00/00/00 Correspondence 1D: |

Sent From: |

Sent To: |

Document Category: | |

Document Location: I

Major Topics:

Helated Correzpondence: |EI |

Hegquired Bezponse Text: |

Dispute: IEI

Figure 6-1 The Correspondence Log Window

Field Name Description

Contract ID Transportation agency-defined ID of the Contract associated
with the correspondence.

Contract System-generated serial number for the correspondence record.

Correspondence Serial

Number

Received/Sent Field in which the user can select ‘Received’ or ‘Sent’ from a
drop-down list to identify the correspondence as received or
sent.
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Field Name Description
On Date on which the correspondence was received or sent. This

date cannot be in the future. Defaults to the system date.

Correspondence Type | Transportation agency-defined type of correspondence.

Correspondence ID user-defined alphanumeric field to identify the correspondence
(e.g., USRTE-47-8).

Sent From Name of the person or agency sending the document.
Sent To Name of the person or agency receiving the document.
Document Category Transportation agency-defined category of correspondence

used for retrieval and analysis.

Document Location Physical location of the correspondence.

Major Topics Major topics associated with the correspondence.

Related Serial number and type of a related correspondence record.
Correspondence The user can search this field.

Required Response Description of the response to the correspondence that is

Text required.

Dispute ID of a dispute associated with this correspondence. This field

can be searched.

Table 6-1 The Correspondence Log Window Fields Table

To add a correspondence record:

1.
2.

On the Contract Records panel, double-click the Correspondence Log icon.
Click the Services menu and click the Choose Keys choice. The Select Contract list opens.
In the Select Contract list box, scroll to and double-click the Contract.

In the Document Type drop-down list, click the expand arrow and click the document type.
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10.
1.
12.

13.
14.
15.

In the Received/Sent drop-down list, click the expand arrow and click either ‘Received’ or ‘Sent’ to
indicate the direction of the correspondence.

In the Date field, type the date the correspondence was received or sent.

In the Correspondence ID ficld, type the ID of the document.

In the Sent From field, type the name of the person or agency who sent the correspondence.

In the Sent To field, type the name of the person or agency to whom the correspondence was sent.
In the Document Category drop-down list, click the expand arrow and click the document category.
In the Major Topics field, type the major topics associated with the correspondence.

To assign related correspondence, in the Related Correspondence field, type the document serial
number or perform a Search.

In the Required Response Text field, type the response required to the correspondence.
To assign a related dispute, in the Dispute field, type the Dispute ID, or perform a Search.

Click the Save button.

To forward a correspondence record:

1.
2.

6-4

On the Contract Records panel, double-click the Correspondence Log icon.
Click the Open button.

In the Select Contract list box, scroll to and double-click the Contract.

In the Select Correspondence list box, scroll to and double-click the document.

Click the Services menu and click the Forward to choice. The Forward to Selected User window
opens.

In the Forward to Selected User list box, scroll to and click or shift-click the user(s).

Click Ok. SiteManager sends In-Box messages to the selected users and the window displays a ‘Mail
sent’ message.

Click Ok.

Click the Save button.
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6.2 Force Accounts

The purpose of a Force Account is to record unexpected and unplanned expenses. A new Force Account
describes the work to be done and lists the equipment, labor, and materials to be used, including rates per hour
and costs per unit. To expedite the work, the equipment, labor, and materials can be listed generically (e.g.,
Equipment 1 and Equipment 2) when the account is created. Force Accounts are created on the Force
Accounts window, which has the following folder tabs:

e Equipment
e Labor
e  Materials

e Summary

After the office creates the account, the inspector can download the Force Account data and begin recording
the actual usage values (hours and quantities) in Daily Work Reports. The Force Account Summary folder tab
calculates and displays the total actual Force Account costs. The user can adjust the actual costs by entering a
lump sum adjustment to the whole account, and by entering adjustment percentages to the labor, equipment,
and materials costs. To determine adjustment amounts, the user can create or view OLE, URL or plug-in
attachments.

The system does not include Force Account data in estimates automatically. To pay for Force Account work,
the user creates a Force Account Change Order for each Item (equipment, labor, and materials) used on the
Force Account. After approval of the Change Order(s), the inspector reports the Item(s) as installed in Daily
Work Reports. The installed Items are then included in estimates and paid for along with other Contract
Items.

ﬂ Force Accounts O] x|
| Equipment Labor © Material " Summary
Contract ID: [Anand Force Account 1D: |1
Description: Equipment: [$.00 Adj: |00 4
Purpose: Labor: |£.00 Adj: .00 b4
Matenals: [$.00 Adj: |00 b4

Subtotal: [$.00
Other Adjustment: [$.00
Total: |$.00

Force Account Equipment Description Uszed Rate | Idle Rate | Owned or Rented Type

Figure 6-2 The Force Account Window
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Field Name Description

Contract ID Transportation agency-defined ID for the Contract that
includes the Force Account.

Force Acct System-generated ID for the Force Account.

Description Work the Force Account is intended to cover. This field is
required.

Purpose Reason for the Force Account. This field is required.

Equipment Total amount of Force Account equipment costs derived from

the usage reported by daily inspectors and the adjustment
percentage. This field is display only.

Equipment Adj %

Percentage of the equipment cost added as an adjustment to the
equipment cost. This is an optional field.

Labor

Total amount of Force Account labor costs derived from the
usage reported by daily inspectors and the adjustment
percentage. This field is display only.

Labor Adj %

Percentage of the labor cost added as an adjustment to the
labor cost. This is an optional field.

Materials

Total amount for Force Account material costs derived from
the daily usage reported by Inspectors and the adjustment
percentage. This field is display only.

Materials Adj %

Percentage of the material cost added as an adjustment to the
material cost. This is an optional field.

Subtotal Sum of the equipment, labor, and material costs after
adjustment. This field is display only.
Other Adjustment Additional lump sum cost incurred by the Force Account. This

is an optional field.
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Field Name Description
Total Sum of the Subtotal and Other Adjustment amounts. This field
is display only.

Table 6-2 The Force Account Window Header Fields Table

To add a Force Account to a Contract:

10.
1.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.

On the Contract Records panel, double-click the Force Account icon.

Click the Services menu and click the Choose Keys choice. The Select Contract list opens.

In the Select Contract list box, scroll to and click the Contract.

Click Ok.

In the Description field, type a description of the work covered by the Force Account.

Press the Tab key.

In the Purpose field, type the reason for the Force Account.

Click the Save button.

Click the bottom datawindow and click the New button.

In the Force Account Equipment Description field, type a description of the piece of equipment.
Press the Tab key.

In the Used Rate field, type the used rate for the equipment.

Press the Tab key.

In the Idle Rate field, type the idle rate for the equipment.

In the Owned or Rented Type drop-down list, click the expand arrow and click the ownership type.
Click the Save button.

Click the Labor folder tab.

Click the New button.

In the Worker Name field, type the worker’s name.

In the Class drop-down list, click the expand arrow and click the job classification of the worker.
Press the Tab key.

In the Regular Rate field, type the regular hourly rate for the worker.
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23. Press the Tab key.
24. In the Fringe Rate field, type the fringe hourly rate for the worker.
25. Press the Tab key.
26. In the Overtime Rate field, type the overtime hourly rate for the worker.
27. Click the Save button.
28. Click the Material folder tab.
29. Click the New button.
30. In the Invoice ID field, type the invoice for the material.
31. In the Invoice Date field, type the date of the invoice.
32. In the Contract FA Material Description field, type a description of the material.
33. Press the Tab key.
34. In the Delivered Qty field, type the invoice quantity of the delivered material.
35. In the Units Type drop-down list, click the expand arrow and click the unit of measure to be used in
installing the material.
36. Press the Tab key.
37. In the Unit Price field, type the unit price of the material.
38. Click the Save button.
Tip: When a new Force Account is created, the equipment, labor, and materials can be listed generically so

that the inspector can begin recording usage data in Daily Work Reports.

To adjust Force Account actual costs:

6-8

1.
2.

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
Force Accounts.

In the Force Account list box, scroll to and click the Force Account.

Click Ok.

In the Equipment Adj% field, type the percentage of the equipment cost added as an adjustment to
the equipment cost.

Press the Tab key.
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10.

11.
12.

13.

In the Labor Adj% field, type the percentage of the labor cost added as an adjustment to the labor
cost.

Press the Tab key.

In the Materials Adj% field, type the percentage of the materials cost added as an adjustment to the
materials cost.

Press the Tab key.

In the Other Adjustment field, type the lump sum amount of other costs to be added to this Force
Account.

Click the Save button.

To delete a Force Account:

1.
2.

Tip:

6.2.1

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
Force Accounts.

In the Force Account list box, scroll to and click the Force Account.
Click OKk.

Click the Delete button. The system asks the user to confirm the deletion.
Click Yes.

Click the Save button.

If any Items are paid for, the Force Account can not be deleted.

Force Account Equipment

The Force Account Equipment folder tab lets the user create and maintain a list of equipment and usage rates
for the selected Force Account.
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o S S S S S - ]
" Equipment Labor © Materal " Summary
Contract ID: |Anand Force Account ID: |1
Description: Equipment: [$.00 Adj: |00 %
Purpose: Labor: |$.00 Ady: .00 %
Materials: [$.00 Adj: (00 b4
Subtotal: [$.00

Other Adjustment: [$.00
Total: [$.00

Force Account Equipment Description Used Rate | Idle Hate | Owned or Rented Type

Figure 6-3 The Force Account Equipment Folder Tab

Field Name Description

Force Account Text description of the piece of equipment or a type of

Equipment Description | equipment. This is a required field. This field scrolls
horizontally.

Used Rate Used rate for the equipment. This is a required field.

Idle Rate Idle rate for the equipment. This is a required field.

Owned or Rented Type | Indicates if the equipment is owned by the Contractor and
kept on the site, owned by the Contractor and brought to the
site, or rented. This is a required field.

Table 6-3 The Force Equipment Fields Table
To add equipment to a Force Account:
1. On the Contract Records panel, double-click the Force Account icon.

2. Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

3. In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
Force Accounts.
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4. In the Force Account list box, scroll to and click the Force Account. The Force Account window
opens with the Equipment folder tab displayed.

5. Click the New button.
6. Inthe Force Account Equipment Description field, type a description of the piece of equipment.
7. Press the Tab key.
8. In the Used Rate field, type the used rate for the equipment.
9. Press the Tab key.
10. In the Idle Rate field, type the idle rate for the equipment.
11. In the Owned or Rented Type drop-down list, click the expand arrow and click the ownership type.
12. Click the Save button.

6.2.2 Force Account Labor

The Force Account Labor folder tab lets the user create and maintain a list of Force Account workers and
their wage rates.

M Farce Accounts O] x|
" Equipment Labor T Material " Summary
Contract ID: |C10785 Force Account ID: |1
Description: |FA 65726 Equipment: |$.00 Adj: |00 b4
Purpose: | Labor: [$.00 Adj: (00 4
Materials: [$.00 Adj: |00 z
Subtotal: |$.EID
Other Adjustment: I$.DD
Total: [$.00
Worker Class Regular Fringe Dvertime
Name Rate Rate Rate
E35.00 $.00 $.00

Figure 6-4 The Force Account Labor Folder Tab
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Field Name Description
Worker Name Name of the worker for the Force Account work. This is a
required field.
Class Job classification of the worker for the Force Account work.

The user can search this field. This is a required field.

Regular Rate Regular hourly rate of the worker for the Force Account
work. This is a required field.

Fringe Rate Fringe hourly rate of the worker for the Force Account work.
This is an optional field.

Overtime Rate Overtime hourly rate of the worker for the Force Account
work. This is a required field.

Table 6-4 The Force Account Labor Fields Table

To add a Force Account labor record:

8.
9.

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
Force Accounts.

In the Force Account list box, scroll to and click the Force Account. The Force Account window
opens with the Equipment folder tab displayed.

Click the Labor folder tab.

Click the New button.

In the Worker Name field, type the worker’s name.

In the Class drop-down list, click the expand arrow and click the job classification of the worker.

Press the Tab key.

10. In the Regular Rate field, type the regular hourly rate for the worker.

11. Press the Tab key.
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12. In the Fringe Rate field, type the fringe hourly rate for the worker.
13. Press the Tab key.
14. In the Overtime Rate field, type the overtime hourly rate for the worker.

15. Click the Save button.

6.2.3 Force Account Materials

The Force Account Material folder tab lets the user create and maintain a list of Force Account materials and
related invoice quantities and costs.

E Force Accounts =]
" Eguipment Labor " Material Summary
Contract ID: [C10785 Force Account ID: |1
Descnption: [FA E5726 Equipment: [$.00 Adj: |00 4
Purpose: | Labor: |$.00 Adj: |00 4
Materials: [$.00 Adj: |00 4
Subtotal: |$. 0o
Other Adjustment: |$. uli]
Total: [$.00
Invoice ID|Invoice Dt Contract FA Material Description Delivered Qty Units Type | Unit Price
w

Figure 6-5 The Force Account Materials Folder Tab

Field Name Description

Invoice ID Invoice received with the material used for the Force
Account. This is an optional field.

Invoice Dt Date of the invoice received with the material used for the
Force Account. This is an optional field.

Contract FA Material Description of the material used for the Force Account. This
Description is a required field.
Delivered Qty Invoiced quantity of the delivered material used for the Force

Account. This is a required field.
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Field Name Description
Units Type Unit of measurement of the material used for the Force

Account. This is a required field.

Unit Price Unit price of the material used for the Force Account. This is
a required field.

Table 6-5 The Force Account Materials Fields Table

To add Force Account materials:

10.
1.
12.

13.
14.
15.

6-14

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
Force Accounts.

In the Force Account list box, scroll to and click the Force Account. The Force Account window
opens with the Equipment folder tab displayed.

Click the Material folder tab.

Click the New button.

In the Invoice ID field, type the invoice for the material.

In the Invoice Date ficld, type the date of the invoice.

In the Contract FA Material Description field, type a description of the material.
Press the Tab key.

In the Delivered Qty field, type the invoice quantity of the delivered material.

In the Units Type drop-down list, click the expand arrow and click the unit of measure to be used in
installing the material.

Press the Tab key.
In the Unit Price field, type the unit price of the material.

Click the Save button.
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6.2.4 Force Account Summary

The Force Account Summary folder tab calculates and displays the total actual cost of the Force Account and
the actual costs per type and per day. This is a view-only window. The total actual costs are derived from the
hours and quantities reported on Daily Work Reports. The user can access the Daily Work Reports from this
window.

1 Force Accounts O] x|
" Equipment Labor " Material [ Summary
Contract 1D: |I31 0785 Force Account 1D: |1
Description: [FA 65726 Equipment: [$.00 Adj: .00 b4
Purpose: | Labor: [$.00 Adj: .00 b4
Materials: [$.00 Adj: (.00 b4
Subtotal: [$.00

Other Adjustment: [$.00

Total: |$,UEI

|»

Costs

Daily ID Labor Fringe Equipment Material Total

0 | $. [II: $.0 I: $.0 I: $ [II: $0.0 [

Daily 1D Totals: I $0.00 | $0.00 | $0.00 | $0.00 | $0.00

Daily ID Adjustments: | $0.00 | $0.00 | $0.00 | $0.00
Force Account Adjustment: | $000 |
Total Cost: I $0.00 LI

The Force Account Summary Folder Tab

Figure 6-6 The Force Account Summary Folder Tab

Field Name Description

Daily ID Date and User ID of the Daily Work Report that includes the
Force Account information.

Labor Costs Accumulated amount of regular and overtime labor costs for
the Force Account.

Fringe Costs Accumulated amount of regular and overtime fringe labor
costs for the Force Account.

Equipment Costs Accumulated amount of used and idle equipment costs for the
Force Account.

Material Costs Accumulated amount of material costs for the Force Account.
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Field Name Description
Total Costs Total labor, fringe, equipment, and material costs on one

Daily ID for the Force Account.

Daily ID Totals Total labor, fringe, equipment, and material costs on all Daily
IDs for the Force Account.

Daily ID Adjustments Adjusted labor, equipment, and material costs computed with
the adjustment percentage entered for each. The Total Daily
ID Adjustment is the total of the adjusted labor, equipment,
and material costs for the Force Account.

Force Account Additional lump sum cost adjustment to the Force Account.
Adjustment
Total Cost Sum of the Daily ID Totals, Total Daily ID Adjustments, and

Force Account Adjustment for the Force Account.

Table 6-6 The Force Account Summary Fields Table

To view a Daily Work Report related to a Force Account:

1.
2.

6-16

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
Force Accounts.

In the Force Account list box, scroll to and click the Force Account.

Click Ok.

Click the Summary folder tab.

In the Daily Work Report list box, scroll to and click the Daily Work Report.
Click the Services menu and click the Daily Work Report choice.

Click the Close button to return to the Force Accounts window.
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6.3 Design Evaluation

The Design Evaluation window lets the user rate Contract designs by design category. The user can add,

Trnseport SiteManager®

Contract Administration - Maintenance

modify, or delete a Design Evaluation. The Contract can be evaluated for any of the design categories in the
system. Only one evaluation can be made for a design category per evaluator. The numeric rating is required.

EDesign Evaluation [_ (O] x|
Contract ID:  [SITEMGR_30 =
Design Category Rating |Evaluation Date Evaluator Position
>0 05/04/93 System Adrministrator 1 System Adrministr]

Figure 6-7 The Design Evaluation Window

August 2005
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Field Name Description

Design Category | user-defined design category description. Only one rating allowed
for a design category. This is a required field.

Rating Numeric rating assigned to an evaluation. This is a required field.
Valid values are on a scale from 1 to 10.

Evaluation Date Date on which the design category was evaluated. Cannot be in the
future. Defaults to the date on which the evaluation is entered in the
system.

Evaluator User ID of the individual entering the evaluation data. Defaults to
the current user name. This value can not be modified after it is
saved.

Position Designation of the evaluator. Defaults to the current user. This
value can not be modified after it is saved.

Table 6-7 The Design Evaluation Window Fields Table

To add a Design Evaluation:

L.

On the Contract Records panel, double-click the Design Evaluation icon. The Contract Select
window opens.

In the Contract ID list box, scroll to and click the Contract.

Click Ok. The Design Evaluation window lists design evaluations.

Click the New button. An empty row is added to the list.

In the Design Category drop-down list, click the expand arrow and click the design category.
Press the Tab key.

In the Rating field, type the numeric rating for the evaluation.

Press the Tab key.

In the Evaluation Date ficld, type the date of the evaluation.

10. Click the Save button.

6-18
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The Plan Discrepancies window lets the user record discrepancies to the Contract plan. The discrepancy types
are defined by the transportation agency.

¥4 Plan Discrepancies

Cont I1D: ISITEMGH_EH Discrepancy Serial No: I

Entry Date: IUB.-"2U!9? Discrepancy Entered By: |Central Office 1

Discovered By: m Discovery Date: IUIJ.-"DD!IJU
Discrepancy Type: | [x] Plan Page Number: I

Discrepancy Description:

Correction D ate: |DD.-"DEI!DIJ

Discrepancy Correction:

Designer Information:

Eence to

Change Order Number: I DWR: | |DDJEID:‘DD Dispute: IU

Figure 6-8 The Plan Discrepancies Window

Field Name Description

Cont ID

Transportation agency-defined ID for the Contract.

Discrepancy Serial No

System-generated serial number for the discrepancy record.

Entry Date Date when the discrepancy record was entered. Defaults to
the current date.

Discovered By The entity discovering the discrepancy, e.g., Consultant,
Contractor, Department, or Other.

Discrepancy Entered By | Name of the person entering the discrepancy. Defaults to the

name of the logged on SiteManager user.

Reference to Change

Change Order number associated with the discrepancy. The
Order Number user can search this field.

Discrepancy Description | Description of the discrepancy. This is a required field.

August 2005
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Field Name Description

Discrepancy Correction | Description of the correction of the discrepancy. This field is
optional.

Discrepancy Type Transportation agency-defined type of the discrepancy. This
is a required field.

Discovery Date Discovery date of the discrepancy. The discovery date can not
be after the current date or before the Daily date. This field is
required.

Correction Date Correction date of the discrepancy. This field is optional and

can not be after the current date.

Plan Page Number Page number of the design plan associated with the
discrepancy. This field is optional.

Reference to Dispute ID of the dispute associated with the discrepancy. The user
can search this field. This field is optional.

Reference to DWR Date and User ID on the Daily Work Report associated with
the discrepancy. The user can search this field. This field is
optional.

Designer Information Information about the designer associated with the

discrepancy. This field is optional.

Table 6-8 The Plan Discrepancies Window Fields Table

To add a plan discrepancy to the Contract:

L.
2.

6-20

On the Contract Records panel, double-click the Plan Discrepancy icon.

Click the Services menu and click the Choose Keys choice. The Select Contract list opens.
In the Select Contract list box, scroll to and click the Contract.

Click Ok.

In the Discovered By drop-down list, click the expand arrow and click the entity that found the
discrepancy.

Press the Tab key.
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10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.

In the Discovery Date field, click in front of the current entry and type the date the discrepancy was
discovered.

In the Discrepancy Type drop-down list, click the expand arrow and click the discrepancy type.
Press the Tab key.

To enter a reference to the design plan, in the Plan Page field, type the page number.

Press the Tab key.

In the Discrepancy Description ficld, type a description of the discrepancy.

Press the Tab key.

In the Correction Date field, type the date the discrepancy was corrected.

Press the Tab key.

In the Discrepancy Correction field, type a description of the discrepancy correction.

In the Designer Information field, type desired data.

Press the Tab key.

To add a reference to a Change Order, in the Change Order Number field, perform a Search.
Press the Tab key.

To add a reference to a Daily Work Report, in the DWR field, perform a Search.

Press the Tab key.

To add a reference to a dispute, in the Dispute field, perform a Search.

Click the Save button.

To modify a plan discrepancy record:

1.
2.

On the Contract Records panel, double-click the Plan Discrepancy icon.
Click the Open button. The Discrepancy Select window opens. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID. The window displays a list
of discrepancies.

In the Plan Discrepancy list box, scroll to and double-click the record. The Plan Discrepancy Select
window closes and the Plan Discrepancy window is displayed.

Modify data on the window.

Click the Save button.
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6.5 Dispute/Claim

The Dispute/Claim window lets the user add, modify, and delete dispute and claim records. The
Dispute/Claim window contains the following folder tabs:

Tab Name Description

Description The Description folder tab displays the basic dispute or claim
description data that can be added, deleted, updated, or viewed.

Recipients The Recipients folder tab displays the dispute or claim recipients data
that can be added, deleted, updated, or viewed. This folder tab
records data on people who have been assigned to respond to the
dispute or claim. In addition, the system notifies each recipient of his
pending assignment with an In-Box message.

Related Records | The Related Records tab displays a list of SiteManager records
related to the selected dispute or claim. This lets the user navigate
automatically to the related record’s window (e.g., Plan
Discrepancies, Change Order, Correspondence Log).

Table 6-9 The Dispute/Claim Folder Tabs Table

6.5.1 Dispute/Claim Descriptions

The Description folder tab lets the user add, modify, or delete the Contract disputes and claims.
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EDisputes [ Claims

Figure 6-9 The Dispute/Claim Description Folder Tab

Field Name Description

Contract ID Transportation agency-defined ID for the Contract.

Dispute ID System-generated ID for the dispute or claim.

Type Ind Identifies whether this is a dispute or a claim. This is a required field.
Status Status of the dispute or claim (e.g., Received, Logged, Open,

Rescinded, Resolved, Denied, Closed). This is a required field.

Subcontr ID Transportation agency-defined ID for the Subcontractor associated
with the dispute or claim.

Category Type | Transportation agency-defined Category of the dispute or claim.
Categories are defined for reporting, inquiry, and analysis purposes.
Normally based on the nature of the dispute or claim (e.g., material,
utility, time). This is a required field.

August 2005 6-23



Trnseport SiteManager®

Contract Administration - Maintenance

6-24

Dispute/Claim

Field Name Description

Requested Amt | Dollar amount requested by the Contractor in the dispute or claim.
Either Requested Amt or Requested Days is required.

Requested Days | Number of days requested by the Contractor in the dispute or claim.
Either Requested Amt or Requested Days is required.

Settled Amt Amount settled for the dispute or claim.

Settled Days Days settled for the dispute or claim.

Estimate Nbr System-generated number assigned to the estimate during the estimate

generation process. The user can search this field.

Received Date

Date the dispute or claim was received by the department. This is a
required field.

Logged Date Date the dispute or claim was entered into SiteManager. Assigned by
the system.

Contractor Date the resolution was accepted by the Contractor. Can not be after

Accepted Date | the current date or equal to the Dept Resolved Date.

FHWA Date the FHWA concurred with the resolution. Can not be after the

Concurrence current date.

Date

Diary Start Date | Start date of a range of diaries that document the dispute or claim.
Can not be after the current date.

Diary End Date | End date of a range of diaries that document the dispute or claim.
Must be greater than or equal to the Diary Start Date.

Release/Paymen | Date the payment was released for the dispute or claim. Can not be

t Date after the current date.

Dept Resolved | Date the dispute or claim was resolved or overridden by the

Date department. Can not be after the current date.
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Field Name Description
Resolution Resolution reason type that identifies how the dispute or claim was

Reason Type resolved (e.g., Change Order issued).

Remark Remarks about the dispute or claim.

Project Number | Transportation agency-defined ID for the Project related to the dispute
or claim.

Line Item Line Item Number of an Item associated with the dispute or claim.
The user can search this field. An Item can be in multiple disputes
(e.g., a paving Item can be disputed one day because of density
controversy and the next day because of an aggregate mix). This field
is protected in update mode.

Seq Nbr System-generated sequence number that identifies the Project and
Line Item associated with the dispute or claim.

Item Code Transportation agency-defined code for the Item associated with the
dispute or claim.

Short Short description of the Item associated with the dispute or claim.
Description

Table 6-10 The Dispute/Claim Description Folder Tab Fields Table
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To add a dispute or claim record to a Contract:

L.
2.

10.
11.
12.

13.
14.
15.
16.

17.
18.

19.
20.

21.
22.
23.

6-26

On the Contract Records panel, double-click the Dispute/Claim icon.

Click the Services menu and click the Choose Keys choice. The Select Contract list opens.

In the Select Contract list box, scroll to and click the Contract.

Click OKk.

In the Type Ind drop-down list, click the expand arrow and click either ‘dispute’ or ‘claim.’

In the Status drop-down list, click the expand arrow and click the status of the dispute or claim.

In the Subcontractor ID drop-down list, click the expand arrow and click the ID of the subcontractor
who started the dispute or claim.

In the Category Type drop-down list, click the expand arrow and click the category of the dispute or
claim.

Press the Tab key.
In the Estimate Nbr field, type an estimate number or perform a Search.
Press the Tab key.

In the Requested Days field, type the number of days requested by the Contractor, or tab to the
Requested Amt field and type the dollar amount requested by the Contractor.

Press the Tab key.
In the Settled Amt field, type the amount for which the dispute or claim was settled.
Press the Tab key.

In the Received Date field, type the date the dispute or claim was received by the transportation
agency.

Press the Tab key.

In the Diary Start Date field, type the start date of a range of diaries that captured information about
the dispute or claim.

Press the Tab key.

In the Diary End Date ficld, type the end date of a range of diaries that captured information about
the dispute or claim.

Press the Tab key.
In the Contractor Accepted Date ficld, type the date the resolution was accepted by the Contractor.

Press the Tab key.
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24.

25.
26.
27.
28.
29.

30.
31.
32.

In the Dept Resolved Date field, type the date that the dispute or claim was resolved by the
transportation agency.

Press the Tab key.

In the FHWA Concurrence field, type the date the FHWA concurred with the resolution.

Press the Tab key.

In the Release/Payment Date field, type the date the payment was released for this dispute or claim.

In the Resolution Reason Type drop-down list, click the expand arrow and click the reason that
identifies how the dispute or claim was resolved.

Press the Tab key.
In the Remarks field, type remarks about the dispute or claim.

Click the Save button.

To add an Item to a dispute or claim record:

1.
2.

On the Contract Records panel, double-click the Dispute/Claim icon.

Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
disputes.

In the Dispute/Claim list box, scroll to and click the dispute.
Click OKk.
Click the bottom datawindow and click the New button.

In the Project Number drop-down list, click the expand arrow and click the number of the Project
that includes the Item.

In the Line Item ficld, type the Line Item number or perform a Search.

Click the Save button.
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To view a Line Item related to a dispute or claim:

L.
2.

7.
8.

On the Contract Records panel, double-click the Dispute/Claim icon.

Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
disputes.

In the Dispute/Claim list box, scroll to and click the dispute.
Click OKk.

In the Line Item list box, scroll to and click the Line Item.
Click the Services menu and click the View Item choice.

Click the Close button to return to the Dispute/Claim window.

To view an estimate related to a dispute or claim:

1.
2.

7.
8.

Tip:

On the Contract Records panel, double-click the Dispute/Claim icon.

Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
disputes.

In the Dispute/Claim list box, scroll to and click the dispute.

Click Ok.

Look at the Estimate Nbr field to make sure the selected dispute or claim has a valid estimate
number.

Click the Services menu and click the View Estimate choice.
Click the Close button to return to the Dispute/Claim window.

If the View Estimate menu option is not available, make sure that focus is on the top datawindow and

there is a valid number in the Estimate Nbr field.

6.5.2

Dispute/Claim Recipients

The Dispute/Claim Recipients folder tab lets the user add, modify, and delete the recipients of the dispute and
claim records. This folder tab lets the user maintain tracking and deposition information on personnel
assigned to respond to the dispute. This includes assigning the personnel, documenting when the dispute or
claim documentation was sent and received, and recording the recipient’s comments or deposition. Each
newly assigned recipient is notified of the assignment by an In-Box message.

6-28
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ﬂDispules FARET H

Description Recipients Related Records
Contract 1D: ISITEMGFI_D1 Dispute I1D: I‘I_
Recipient Due Date Doc Sent| Doc Received Recipient =
Date Date Response Date _
00/00/00  00/00/00 00/00/00 00/00/00

v
o | »

Recipi Due Date: | 00/00/00
Doc Sent Date:| 00/00/00 Doc Received Date:| 00/00/00 Recipient Response Dale:l 0000400
Remarks: |« |
ke
Figure 6-10 The Dispute/Claim Recipient Folder Tab
Field Name Description
Recipient User ID of a person assigned to receive dispute or claim documents

(e.g., Project Engineer). The user can search this field. This is a
required field. Should be unique within the dispute or claim.

Due Date Date the dispute or claim document is due to be received by the
recipient. This is a required field. Can not be before the current date.

Doc Sent Date | Date the dispute or claim document was sent to the recipient. Can not
be after the current date.

Doc Received Date the recipient received the dispute or claim document. Should be
Date greater than or equal to the Doc Sent Date. Can not be after the
current date.

Remark Remarks received from the recipient of dispute or claim documents.

Recipient Date the recipient responded to the dispute or claim document. Should
Response Date | be greater than or equal to the Doc Sent Date. Can not be after the
current date.

Table 6-11 The Dispute/Claim Recipients Folder Tab Fields Table
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To add a recipient:

L.
2.

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.

Tip:

On the Contract Records panel, double-click the Dispute/Claim icon.

Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
disputes.

In the Dispute/Claim list box, scroll to and click the dispute or claim.
Click Ok.

On the Dispute/Claim window, click the Recipients folder tab.
Click the New button.

In the Recipient field, type the title of the person who has been assigned to respond to the dispute or
perform a Search.

Press the Tab key.

In the Due Date field, type the date the document is due to be received by the recipient.
Press the Tab key.

In the Doc Sent Date field, type the date the document was sent to the recipient.

Press the Tab key.

In the Doc Received Date field, type the date the recipient received the document.
Press the Tab key.

In the Recipient Response Date field, type the date the recipient responded to the dispute or claim.
Press the Tab key.

In the Remarks field, type the recipient’s remarks.

Click the Save button.

When a new recipient is added to the list and the record is saved, the system notifies the recipient by

In-Box message.

6.5.3

Dispute/Claim Related Records

The Dispute/Claim Related Records folder tab lets the user view and navigate to the plan discrepancies,
change orders, and correspondence logs related to the dispute or claim.

6-30
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5 Disputes / Claims =I=] E3

Description Recipients Related Records

Contract ID: |SITEMGF!_30 Dispute 1D: |1_

Entered Date Related Records
04/15/93  |Plan Discrepancies
03/29/93  |Plan Discrepancies 1

1§ By

Figure 6-11 The Dispute/Claim Related Records Folder Tab

Field Name Description

Entered Date Date the record related to the dispute or claim was entered.

Related Records | Records that are related to the dispute or claim (i.e., correspondence
log, plan discrepancy, Change Order).

Key System-generated sequence number that identifies the record
associated with the dispute or claim.

Table 6-12 The Dispute/Claim Related Records Folder Tab Fields Table

To navigate to a related record:

1.
2.

On the Contract Records panel, double-click the Dispute/Claim icon.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract. The window displays a list of
disputes.

In the Dispute/Claim list box, scroll to and click the dispute or claim.
Click OKk.

Click the Related Records folder tab.
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Click the Related Record and click an option on the Services menu, depending on the type of record
selected as follows:

e To view a Plan Discrepancy record, click View Plan Discrepancies.
e To view a Change Order record, click View Change Orders.
e To view a Correspondence Log record, click View Correspondence Log.

To return to the Dispute/Claim window, close the open window.

6.6 Contractor Payrolls

The Contractor Payrolls window lets the user add and modify Contractor Payroll data and related employee
information. The user can enter the payroll data manually or upload the payroll data electronically (refer to
the Contractor Payroll Load topic). The employee information is used primarily for civil rights and
government reporting functions. The payroll data can be used to track on-the-job training commitments and
training reimbursements to the Contractor.

Certain factors must be considered for payroll entry:

6-32

SiteManager accepts payroll data only if the Prime Contractor folder tab on the Contract indicates that
payrolls are required.

The Work Begin Date on the Contract’s Critical Dates tab must be populated.

The payroll frequency is determined by the Frequency In Weeks field on the Contract’s Prime
Contractor folder tab. This value determines the ending date for the payrolls.

A payroll for the Prime Contractor must be entered before a Subcontractor payroll may be entered
and saved.

The payroll information for the Prime is present from the beginning of the contract until the end
allowing for no gaps.

The payroll frequency cycle for Subcontractors must be the same as that of the Prime, but it does not
have to be continuous.
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Tab Name Description

Payroll Information The Payroll Information folder tab displays the payroll dates, the
payroll’s certified status, and whether or not the payroll includes
employee hours.

Employee Information | The Employee Information folder tab displays a list of
employees for the selected payroll and details for the employee
selected on the list.

Employee Daily The Employee Daily Information folder tab displays the daily
Information records for each employee during a payroll period.

Table 6-13 The Contractor Payrolls Window Folder Tabs Table
To access the Contractor Payrolls window:
1. On the Contractor Management panel, double-click the Contractor Payrolls icon.

2. Click the Services menu and click the Choose Keys choice. The Select Payroll for Vendor window
opens.

3. In the Select Contract list box, scroll to and double-click the Contract.

4. In the Vendor list box, scroll to and click the Prime Contractor.

5. Click Ok.

6.6.1 Payroll Information

The Payroll Information folder tab lets the user add and modify payroll data. This information is submitted to
the transportation agency by Prime Contractors and Subcontractors who employ at least one non-supervisory
employee. The user may enter payrolls manually on this window or the payrolls may be uploaded
electronically. (See the Contractor Payroll Load topic for details.)

If there is no employee data, the No Employees for Period indicator is checked. If a payroll with employee
hours is selected, the user can access all three folder tabs.

When the payroll has been processed via the Payroll Exceptions batch process, the Payroll Exception Process
indicator is checked automatically by the system. This indicates that the employee wage rates have been
checked against the contract’s wage decision and Trainee hours have been processed for on-the-job training
reimbursement.

Once a payroll has been included in an estimate — meaning its Trainee hours have been processed for on-the-
job training reimbursement — the On Estimate field will display the corresponding estimate number. The
estimate number will be removed if the estimate is deleted.
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Note: Once a payroll has been processed and included on a paid estimate, the payroll can later be decertified
and modified manually or reloaded electronically into the system. However, any employee hour
modifications will not be processed by the next Payroll Exceptions batch job. Therefore, any changes to a
Trainee's work hours will not be reflected on the Trainee record and an on-the-job training reimbursement
adjustment will not be calculated on the next estimate. If the DOT hours accrued for a Trainee must be
modified, then the changes must be manually made on the Trainee window.

ﬂ Contractor Payrolls O] x|

Payroll Information | Employee Infarmation | Employee Daily Information
Contract 1D: |C1 0735 Vendor ID: 0654 |[COMCRETE WORKS OF COLORADO |
Payroll Received: [06/13/01 v Certified:

For Period Ending: |11."'2El.f’DD [~ Mo Employee Hours for period

On Estimate: I v Payroll Exception Processed
4| | »

Figure 6-12 The Payroll Information Folder Tab

Field Name Description

Contract ID Transportation agency-defined ID of the Contract. This field is also
displayed on the Employee Information and the Daily Employee
Information tabs.

Vendor ID Vendor ID of the Prime Contractor or Subcontractor. This field is also
displayed on the Employee Information and the Daily Employee
Information tabs.

Payroll Received This is the payroll received date. Defaults to the current date. Can not
be after the current date.

For Period Ending The end of the payroll period. Defaults to a date based on the payroll
frequency of the Prime Contractor. If a Prime Contractor is selected,
this field can not be modified. This date is also displayed on the
Employee Information and the Daily Employee Information tabs in the
Payroll Ending Date field.

Certified Indicates that the payroll is certified.

No Employee Hours for Indicates that no employees worked in the payroll period.
period

Payroll Exception Indicates that the payroll has been processed via the Payroll Exceptions
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Field Name Description
Processed batch process.
On Estimate Displays the number of the estimate that included the payroll.

Table 6-14 The Payroll Information Folder Tab Fields Table
To manually add the first payroll:

1. On the Payroll Information tab, in the Payroll Received ficld, type the date the payroll was
received.

2. Inthe For Period Ending ficld, type the ending date of the payroll period.
3. Click the Save button.
To manually add a payroll with no employee hours:

1. On the Payroll Information tab, in the Payroll Received ficld, type the date the payroll was
received.

2. In the For Period Ending field, type the ending date of the payroll period.

3. Click the No Employees for Period indicator.

4. Click the Save button.
Note: After the system verifies that the period ending date corresponds to the Prime Contractor’s payroll
period, the record is saved.
6.6.2 Employee Information

The Employee Information folder tab displays a list of employees for the selected payroll and details for the
employee selected on the list. To add payroll employee information, the user can search the Vendor’s
personnel list by name or SSN/SIN and select the employees who worked on the payroll. The user can also
enter employee information manually. If the selected payroll is not certified, the user can modify the data.

If the employee is a Trainee, the data on this record (Class Type, Class Group, Program Type, etc.) should
match the information on the Trainee record exactly.
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Payroll Infarmation Employee Information | Employee D aily Information

ContractlD: 051333

YendorlD: [6.002-3 Payroll Ending D ate: 12/14/93

Name S55N/SIN Employee Employee
Class Type |Class Group

Employee 1

993-33-9333 Powe

Name: [Employee 1 SSN/SIN: [599-93-9339
Ethnicity: [Native American =l Gender Type: lm
Class Type: m Class Group: l— Program Type: lSpaces—;[
Deductions: ISNDT Het Pay: W
TotalHrs: 300 | Gross Amt: 0000
Decﬂn Tupe Deduction Amt

| Federal Withholding

e
M 10.000

Figure 6-13 The Employee Information Folder Tab

Field Name Description

Contract ID Transportation agency-defined ID of the Contract.

Vendor ID Vendor ID of the Prime Contractor or Subcontractor.

Payroll Ending Date | End of the payroll period for the selected payroll.

Name Name of a non-supervisory employee. The user can search this
field.

SSN/SIN Social Security Number or Social Insurance Number of the
employee. The user can search this field.

Ethnicity Transportation agency-defined ethnic background of the
employee.

Gender Gender of the employee.

Class Group Class Group of the employee.

Class Type Class Type of the employee.

6-36

August 2005



Trnseport SiteManager®

Contractor Payrolls Contract Administration - Maintenance
Field Name Description
Program Type Program type in which the employee is enrolled.
Deductions Deductions to the employee’s payroll for the payroll period.
Net Pay Gross Pay minus Deductions for the payroll period.
Deduction Type A drop-down list from which the user can select a deduction
type, such as FICA, State, Federal, Local or other deductions.
Deduction Amount The amount to be withheld from the employees gross pay for
the specified Deduction Type.

Table 6-15 The Employee Information Folder Tab Fields Table
To add an employee payroll record:
1. On the Employee Information folder tab, click the New button.

2. In the Name field, type the name or, using the right mouse button, click the field and perform a
Search . The system will automatically enter existing data for the employee. The user can modify
this data as needed.

3. In the SSN/SIN field, type the number or perform a Search.

4. In the Ethnicity drop-down list, click the expand arrow and select the ethnic group.

5. In the Gender Type drop-down list, click the expand arrow and select the gender.

6. In the Class Type drop-down list, click the expand arrow and select the work class type.
7. In the Class Group field, type a new work class group or perform a Search.

8. In the Program Type drop-down list, click the expand arrow and select the program type.
9. In the Deductions field, type the deduction value.

10. In the Total Hours field, type the total hours worked for the pay period.

11. In the Gross Amount field, type the gross pay amount for the pay period.

12. Click the Save button.

13. In the Total Hours field, type the total hours worked for the pay period.
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14. In the Gross Amount field, type the gross pay amount for the pay period.

15. Click the Save button.

16. Click in the bottom data window.

17. Click the New button.

18. In the Deduction Type drop-down list, click the expand arrow and select the desired deduction type.
19. In the Deduction Amount field, type the amount for the selected deduction type.

20. To enter additional deductions, repeat Steps 11 through 13.

21. Click in the Total Hours ficld and type the total hours worked for the pay period.

22. In the Gross Amount field, type the gross pay amount for the pay period.

23. Click the Save button.

Note: The user should not manually enter a value in the Deductions field if the employee has more than one
type of deduction.

To modify employee payroll information for a selected pay period:
1. On the Contractor Management panel, double-click the Contractor Payrolls icon.
2. Click the Open button. The Select Payroll for Vendor window opens.
3. In the Select Contract list box, scroll to and double-click the Contract ID.
4. In the Vendor list box, scroll to and double-click the Prime Contractor or Subcontractor.
5. In the Payroll list box, scroll to and click the payroll.
6. Click Ok. The Payroll Information folder tab displays data for the selected payroll.
7. Click the Employee Information folder tab.

8. In the Employee list box, scroll to and click the employee name. The window displays data for the
selected employee below the list.

9. In the Name field, type the name or perform a Search.

10. In the SSN/SIN field, type the number or perform a Search.

11. In the Ethnicity drop-down list, click the expand arrow and click the ethnic group.

12. In the Gender drop-down list, click the expand arrow and click the gender.

13. In the Class Type drop-down list, click the expand arrow and click the work class type.
14. In the Class Group field, type a new work class group or perform a Search.

15. In the Deductions field, type the deduction value.
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16.
17.
18.

Or,

19.
20.
21.
22.
23.
24.
25.
26.

Tip:

6.6.3

In the Total Hours field, type the total hours worked for the pay period.
In the Gross Amount field, type the gross pay amount for the pay period.

Click the Save button.

In the Total Hours field, type the total hours worked for the pay period.

In the Gross Amount field, type the gross pay amount for the pay period.

Click the Save button.

Click in the bottom data window.

Click the New button.

In the Deduction Type drop-down list, click the expand arrow and select the desired deduction type.
In the Deduction Amount field, type the amount for the selected deduction type.

To enter additional deductions, repeat Steps 11 through 13.

If the selected payroll is certified, the employee data can not be modified or deleted.

Employee Daily Information

The Employee Daily Information folder tab shows the daily record for each employee during a payroll period.
This includes the dates worked on this payroll, the number of hours worked per day, and the hourly rates paid
to the employee. The work dates entered must fall within the payroll period. Once the user enters and saves
the data on this tab, the application will calculate and display the total hours worked and gross pay on the
Employee Information tab in the Total Hours and Gross Amount fields. The application will then display
these fields in read-only mode.

D2 0s s g d ]

Payroll Information Employee Information [ Employee Daily Information
ContractiD:  |051339 YendorlD: [ADD2-B Payroll Ending D ate: 12/14/93
Name SSN/SIN Employee Employee

Class Type |Class Group
Powc

Work Date 'Wage Rate Fringe Overtime Regular Dvertime
Benefit Rate Hours Hours
Rate

12/14/93  |$10.00 $5.00 $15.00  [8.00 2.00

Figure 6-14 The Employee Daily Information Folder Tab
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Field Name Description

Contract ID Transportation agency-defined ID of the Contract.

Vendor ID Vendor ID of the Prime Contractor or Subcontractor.

Payroll Ending Date End of the payroll period for the selected payroll.

Name Name of a non-supervisory employee on the payroll.

SSN/SIN Social Security Number or Social Insurance Number of the
employee on the payroll.

Employee Class Type Class Type of the employee on the payroll.

Employee Class Group Class Group of the employee on the payroll.

Work Date Date on which the employee worked in the payroll period.

Wage Rate Hourly wage rate for the employee on this date in the payroll
period.

Fringe Benefit Rate Hourly fringe benefit rate for the employee on this date in the

payroll period.

Overtime Rate

Hourly overtime rate for the employee on this date in the payroll
period.

Regular Hours

Regular hours worked by the employee on this date in the payroll
period.

Overtime Hours

Overtime hours worked by the employee on this date in the payroll
period.

Table 6-16 The Employee Daily Information Folder Tab Fields Tab
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To modify employee daily information:
1. Click the Employee Daily Information folder tab.

2. In the Employee list box, scroll to and click the employee name. The window displays data for the
selected employee below the list.

3. Click the New button. An empty row is added.

4. Click in front of the current Work Date and type the date.
5. Press the Tab key.

6. In the Wage Rate field, type the wage rate.

7. Press the Tab key.

8. In the Fringe Benefit Rate field, type the fringe benefit rate.
9. Press the Tab key.

10. In the Overtime Rate field, type the overtime rate.

11. Press the Tab key.

12. In the Regular Hours field, type the number of regular hours.
13. Press the Tab key.

14. In the Overtime Hours field, type the number of overtime hours. To record hours worked by this
employee on another date, repeat Steps 3 through 14. To record hours worked by another employee,
repeat Steps 1 through 15.

15. Click the Save button.
Tip:  The Prime Contractor’s payrolls must be recorded before the Subcontractor’s payrolls.
To delete a payroll:

1. On the Contractor Management panel, double-click the Contractor Payrolls icon.

2. Click the Open button. The Select Payroll for Vendor window opens.

3. In the Select Contract list box, scroll to and double-click the Contract.

4. In the Vendor list box, scroll to and double-click the Prime Contractor or Subcontractor.

5. In the Payroll list box, scroll to and click the payroll.

6. Click Ok. The Payroll Information folder tab displays data for the selected payroll.

7. If the payroll is certified, click the Certified check box (OFF). SiteManager displays the message, “
that uncertifying the payroll permits changes to this payroll and associated data.” Click OK.
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8. Click the Employee Daily Information folder tab.

9. In the Employee list box, click the Employee name. The window displays data for the selected
employee below the list.

10. Select a row of daily data and click the Delete button. SiteManager displays the message, “Do you
want to delete Employee’s Daily Information?”

11. Click Yes.

12. Repeat Steps 10 and 11 until all employee daily information is deleted for every employee payroll
record.

13. Click the Save button.
14. Click the Employee Information folder tab.
15. In the Employee list box, click the Employee name.

16. Click the Delete button. SiteManager displays the message, “Do you want to delete Employee’s
Information?”

17. Click Yes. Delete each employee listed.

18. Click the Payroll Information folder tab.

19. Click the Delete button. A delete confirmation message displays.
20. Click Yes.

21. Click the Save button.

Tip:  If the selected payroll has Employee Information and/or Employee Daily Information, all records
must be deleted before the payroll may be deleted.

6.7 Contractor Payroll Load

Contractor Payroll Load is a two step process which loads payroll data received from the contractor
electronically from the server to the database. (To enter payroll data manually, refer to the Contractor
Payrolls topic.) The first step is accomplished by the user selecting payroll files to be loaded via the
Contractor Payroll Load window. The files must be correctly formatted and contain valid data. When the
user selects payroll files to be loaded, the system performs preprocessing validation of the following:

e Correct file format.

e Valid Contract ID, Vendor ID, and Payroll Ending Date.

e Payroll data for only one payroll period per file.

e  Multiple files must be entered in increasing order by Payroll Ending Date.

TIP: A payroll must be loaded for the Prime Contractor before a Subcontractor payroll can be loaded.
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After the file selection is saved, the system copies the files that passed validation to a specific directory on the
server. The system also generates a Payroll Preprocessing Report and sends the report name to the user who
selected the files. This report gives the preprocessing results.

The second step involves a batch process which loads data from the files queued on the server to the database.
The loaded payroll data can be viewed and modified on the Contractor Payrolls window. If a payroll has no
employee data, the “‘No Employees for Period’ indicator is checked (ON) automatically. If a payroll is
certified, the ‘Certified’ indicator must be checked (ON) manually. If any files fail to load, the batch process
generates a Payroll Batch Report and notifies the Contract’s primary personnel. This report lists the files that
failed and the reasons for failure. Possible load failure reasons include:

e Missing data, e.g., if non-supervisory employees are on the payroll, specific employee data is
required.

e Invalid data, e.g., regular hours not between zero and 24.

e Invalid data format, e.g., numeric vs. non-numeric.

e If one payroll fails, all subsequent payrolls fail because the payroll ending dates are out of sequence.
Contractor Payrolls Text File Format

Payroll files to be uploaded must have the text file format described below with required fields and delimited
by semi-colons (;). An example is provided.

Rec Type Field Ord | Req | Type/Length Notes/Issues

Contract ID: ContractID | 1 Y Char 15 Must be a valid
Contract ID in the
SiteManager database

Vendor ID: Vendor ID 1 Y Char 14 Must be a valid Vendor

ID in the SiteManager
database for the above

listed Contract ID
Payroll Ending Payroll 1 Y Num 8 Must be a date greater
Date: Ending Date than the last Payroll
Ending Date.
EMPLOYEE: SSN 1 Y Char 9
EMPLOYEE: Name 2 Y VarChar 50
EMPLOYEE: Gender 3 Y Char 1 Must be “F” or “M”
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Rec Type

Field

Ord

Req

Type/Length

Notes/Issues

EMPLOYEE:

Ethnicity

Char 4

Must be a valid code in
the SiteManager
Ethnicity code table

EMPLOYEE:

Class Group

Char 2

Spaces or valid code in
the SiteManager Job
Class code table

EMPLOYEE:

Class Type

Char 4

Must be a valid code in
the SiteManager Class
Type code table

EMPLOYEE:

Program
Type

Char 4

Must be EITHER space
OR a valid code in the
SiteManager Program
Type code table

EMPLOYEE:

Deductions

Dec 14.3

Spaces or valid sum if
itemized deductions
exist. Otherwise value
must be >= 0

EMPLOYEE:

Tot Hrs

Dec 7.2

Spaces or valid sum if
employee details exist.
Otherwise value must
be >=0

EMPLOYEE:

Gross
amount

10

Dec 14.3

Spaces or valid sum if
employee details exist.
Otherwise value must
be >=0

REMARK:

Employee

remark

0 to 2,147483,647

PB String length
32 bit.

60,000 for 16 bit

Not required
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Rec Type Field Ord | Req | Type/Length Notes/Issues
ADDRESS: Employee 1 Y Char 40 Spaces or value
address Line
1
ADDRESS: Line 2 2 Y Char 40 Spaces or value
ADDRESS: Line 3 3 Y Char 40 Spaces or value
ADDRESS: City 4 Y Char 40 Spaces or value
ADDRESS: State/prov 5 Y Char 2 Spaces or value
ADDRESS: Zip 6 Y Char 10 Spaces or value
ADDRESS: Country 7 Y Char 14 Spaces or value
ADDRESS: Phone 8 Y Char 13 Spaces or value
ADDRESS: Ext 9 Y Char 6 Spaces or value
ADDRESS: Fax 10 Y Char 13 Spaces or value
DEDUCTION TYPE 1 N Char 4 Must be a valid code in
the SiteManager
Deduction Type code
table
DEDUCTION Deductions | 2 N Dec 14.3 Must be >= 0.00
Amount
EMPLOYEE Date 1 Y Num 8 No duplicates allowed
DAILY: and should lie within
the Payroll Frequency
Cycle
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Rec Type Field Ord | Req | Type/Length Notes/Issues

EMPLOYEE Reg Hours 2 Y Dec 5.2 Valid range of 0.00 to

DAILY: 24.00

EMPLOYEE Overtime 3 Y Dec 5.2 Valid range of 0.00 to

DAILY: Hours 24.00

EMPLOYEE Wage Rate |